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Chapter 2:  Overview
Designed for developers and validators, the Teledyne LeCroy PETracer Summit™ and 
Summit T2-16™ are Gen1/Gen2 PCI Express advanced verification systems. 

By leveraging years of experience in protocol analysis tools for emerging markets, 
PETracer Summit and Summit T2-16 blend sophisticated functionality with practical 
features to speed the development of PCI Express™ IP cores, semiconductors, bridges, 
switches, add-in boards, and systems.

2.1 PETracer Analyzer Hardware and Software
Features and Benefits
PETracer Summit and Summit T2-16 Analyzers have these features and benefits:

Features Benefits

Powerful and Intuitive 
CATC Trace™ Analysis Software

Faster interpretation and debug of PCI Express traffic with 
color-coded, clearly labeled protocol elements in a graphical 
display. Reduces coding and deciphering.

Extensive Decoding Complete, accurate and reliable decoding of TLPs (Transaction 
Layer Packets), DLLPs (Data Link Layer Packets), NVMe, PQI, 
AHCI and ATA command transactions and all PCI Express 
Primitives.

Monitoring and Link Utilization View link utilization and other performance measurements 
changing in real time.

Advanced Triggering Isolate important traffic, specific errors, or data patterns. Trigger 
condition setup is made simple with drag and drop tools to link 
events to trigger or filter actions.

Hardware Filtering Analyze faster and understand transactions more clearly by 
removing non-essential fields from the trace.

Intelligent Reporting Quickly identify and track error rates and abnormal link or timing 
conditions. Display configuration space and protocol specification 
details.

Sophisticated Viewing View Packet, Link, Split, NVMe, PQI, AHCI protocol and ATA 
command transaction levels of the PCI Express protocol. 
Collapsible/expandable headers with Tool tip explanations make it 
easy to navigate and interpret packet contents, headers, and 
commands. View packets, transactions of TLPs and DLLPs in 
classic CATC Trace™ format or in raw bit stream for deeper 
analysis.



Chapter 2: Overview Summit User Manual

4 Teledyne LeCroy

2.2 CATC Trace Software
PETracer Summit and Summit T2-16 utilize the CATC Trace™ to assist users in 
analyzing how PCI Express components work together, diagnose problems, and test for 
interoperability and standards compliance. 

The CATC Trace is a powerful and intuitive expert software system embedding detailed 
knowledge of the protocol hierarchy and intricacies, as defined in the protocol 
specification. The software allows the user to control the Analyzer and set specific 
real-time triggering and filtering conditions. The CATC Trace utilizes a Windows-based 
graphical display that has been optimized for fast and easy navigation through a captured 

8 GB Recording Capacity, 
4 GB in each direction

Capture long recording sessions for analysis and problem solving

Flexible Host Interface Summit T2-16: USB and GigE . 
PETracer Summit: 10/100 MBps.

Downloadable CATC Trace 
Viewer

Share and annotate CATC Trace recordings within a development 
team. Freely distributable PETracer software enables collaborative 
analysis across sites and time zones.

Bidirectional x1-x16,
2.5 GBps to 5.0 GBps
recording support

Accurate and non-intrusive collection of PCI Express CATC Trace 
data

Field-upgradeable firmware and 
recording engine

Upgrades available for download direct from the Teledyne LeCroy 
website

Flexible probing options Active and passive slot interposers
MidBus probe
Flying lead probe
Gen1 AMC interposer
Gen1 XMC interposer
Gen1 SIOM interposer
Gen1 Express card interposer

External interface for probing 
and monitoring auxiliary digital 
signals

Enables cross triggering between other test instruments.

Dword to Transaction Level 
Viewer

View Dwords, Packet, Link and Split Transaction levels of the PCI 
Express protocol.

CRC checking Know that info being displayed is accurate.
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traffic session. Users are alerted as violations are detected at all levels of the protocol 
layering and can easily drill down on areas of interest or collapse and hide fields that are 
not relevant. 
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2.3 Summit T2-16 Analyzer
The Teledyne LeCroy Summit T2-16 is Teledyne LeCroy’s fourth-generation PCI Express 
analyzer for customers in server, workstation, desktop, graphics, storage and network 
card markets. 

With advanced features such as support for PCI Express Spec 2.1, data rates of both 2.5 
and 5 GBps, lane widths from x1 to x16, and a full 8 GB of trace (recording) memory, the 
Summit T2-16 provides unmatched capability and flexibility for developers and users of 
advanced PCI Express products. The Summit T2-16 is the most advanced and 
sophisticated PCI Express Analyzer available in the market today.

As with other Teledyne LeCroy PCI Express analyzers, the Summit T2-16 leverages the 
intuitive and powerful CATC Trace analysis software system, embedding a deep 
understanding of the PCI Express protocol hierarchy and intricacies. The colorful, 
intuitive and easy-to-use graphical display allows you to quickly capture and validate 
PCI Express product designs. All Teledyne LeCroy PCI Express protocol analyzers 
employ high-impedance, non-intrusive probing technology, thereby allowing fully 
unaltered data pass-through.

In addition to a full suite of advanced hardware and software features, the Summit T2-16 
introduces new user-convenience and analysis features, such as support for “lane 
swizzling,” which allows a board developer to lay out a mid-bus probe pad with lanes in 
non-standard order, simplifying the design of the board. Internally, the Summit T2-16 
maps the lanes back into their correct order and accurately displays the embedded bus 
traffic. Other new software features include enhanced error checking for automatic 
identification of additional error types, more compact CATC Trace files that allow for 
faster analysis of data, and the choice of simplified or advanced modes for setting up 
recording options. An optional raw-recording mode allows bytes to be recorded as they 
come across the link, allowing debugging of PHY layer problems and combining the 
features of a logic analyzer format with a protocol analyzer format. The new 
auto-sense-link feature monitors negotiation between devices of different lane widths.

The Summit T2-16 supports USB and GIGE host interfaces. By connecting over GIGE, 
engineers can operate the system remotely (for example, install the client software on 
their desktop systems to control an analyzer operating in a remote lab). Also, multiple 
engineers working collaboratively can time-share use of a single analyzer, reducing the 
need for an additional analyzer for each engineer and increasing the cost effectiveness 
of the product.
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Features

• Powerful and Intuitive CATC Trace Analysis Software System: The CATC Trace 
embeds deep understanding of the PCI Express protocol hierarchy and intricacies. 
This knowledge is presented in a colorful, intuitive and easy-to-use graphical 
display, allowing you to quickly capture and validate PCI Express product designs. 

• Protocol Hierarchical Viewing: Displays Packet, Transaction, and 
Split Transaction levels of the PCI Express protocol, with increased drill-down detail 
for PCI Express primitives, errors, payloads or individual packets. 

• Advanced Triggering: Allows you to trigger on various PCI Express Events such 
as Link Conditions, TLP Headers, DLLP Messages, and Data Payload. 

• Lane-Reversal Compatible: Triggers, records, and displays PCI Express traffic 
logically, regardless of the physical configuration of the lanes. 

• Statistical and Error Reporting: Provides a quick summary of the CATC Trace file 
to identify and track error rates and abnormal link or timing conditions. 

• Raw Recording Mode (optional): Records the bytes exactly as they come across 
the link, allowing debugging of PHY layer problems. 

• Auto Speed detection: Follows link transitions through speed changes.

• Auto Polarity detection: Automatically detects lanes with inverted polarity.

• Auto Sense Lane Width: Analyzes all negotiation traffic between devices with 
different lane widths, eliminating the need to set up lane widths before a trace. 

• Lane Swizzling Support: Allows board developers to lay out lanes in a 
non-standard order, simplifying board design. 

• Powerful Real-time BusEngine Protocol Processor Technology: Sophisticated 
triggering and filtering help you focus on critical protocol data and isolate important 
protocol traffic, specific errors, or data patterns. 

• Field-upgradeable Firmware and Engine: Positions you to receive the latest 
PETracer enhancements and future additional capabilities. Allows field upgrades of 
all system types. 

• 8-GB Data Buffer: Capture long time windows for in-depth analysis and 
identification of erratic problems. 

• GIGE Ethernet Connectivity: Allows connection to an Ethernet network and 
sharing of analyzer resources by multiple engineers. 

• USB connectivity: Allows connection by USB cable.
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2.4 PETracer Gen2 Summit Analyzer
The Teledyne LeCroy PETracer Gen2 Summit is Teledyne LeCroy’s first-generation 
high-performance PCI Express analyzer for customers in server, workstation, desktop, 
graphics, storage and network card markets. 

With advanced features such as support for PCI Express Spec 2.0, data rates of both 2.5 
and 5 GBps, lane widths from x1 to x16, and a full 8 GB of memory, the PETracer Gen2 
Summit provides excellent capability and flexibility for developers and users of advanced 
PCI Express products.

As with other Teledyne LeCroy PCI Express analyzers, the PETracer Gen2 Summit 
leverages the intuitive and powerful CATC Trace analysis software system, embedding a 
deep understanding of the PCI Express protocol hierarchy and intricacies. The colorful, 
intuitive and easy-to-use graphical display allows you to quickly capture and validate 
PCI Express product designs. All Teledyne LeCroy PCI Express protocol analyzers 
employ high-impedance, non-intrusive probing technology, thereby allowing fully 
unaltered data pass-through.

In addition to a full suite of advanced hardware and software features, the 
PETracer Gen2 Summit supports “lane swizzling,” which allows a board developer to lay 
out a mid-bus probe pad with lanes in non-standard order, simplifying the design of the 
board. Internally, the PETracer Gen2 Summit maps the lanes back into their correct order 
and accurately displays the embedded bus traffic. Other new software features include 
enhanced error checking for automatic identification of additional error types, more 
compact CATC Trace files that allow for faster analysis of data, and the choice of 
simplified or advanced modes for setting up recording options. An optional Bit Tracer 
mode allows bytes to be recorded as they come across the link, allowing debugging of 
PHY layer problems and combining the features of a logic analyzer format with a protocol 
analyzer format. The new auto-sense-link feature monitors negotiation between devices 
of different lane widths.

The PETracer Gen2 Summit supports both a USB and a 10/100 MBps Ethernet LAN port 
as standard features. By connecting over a LAN, engineers can operate the system 
remotely (for example, install the client software on their desktop systems to control an 
analyzer operating in a remote lab). Also, multiple engineers working collaboratively can 
time-share use of a single analyzer, reducing the need for an additional analyzer for each 
engineer and increasing the cost effectiveness of the product.



Summit User Manual Chapter 2: Overview

Teledyne LeCroy  9

Features

• Powerful and Intuitive CATC Trace Analysis Software System: The CATC Trace 
embeds deep understanding of the PCI Express protocol hierarchy and intricacies. 
This knowledge is presented in a colorful, intuitive and easy-to-use graphical 
display, allowing you to quickly capture and validate PCI Express product designs. 

• Protocol Hierarchical Viewing: Displays Packet, Transaction, and 
Split Transaction levels of the PCI Express protocol, with increased drill-down detail 
for PCI Express primitives, errors, payloads or individual packets. 

• Advanced Triggering: Allows you to trigger on various PCI Express Events such 
as Link Conditions, TLP Headers, DLLP Messages, and Data Payload. 

• Lane-Reversal Compatible: Triggers, records, and displays PCI Express traffic 
logically, regardless of the physical configuration of the lanes. 

• Statistical and Error Reporting: Provides a quick summary of the CATC Trace file 
to identify and track error rates and abnormal link or timing conditions. 

• Raw Recording Mode (optional): Records the bytes exactly as they come across 
the link, allowing debugging of PHY layer problems. 

• Auto Speed detection: Follows link transitions through speed changes.

• Auto Polarity detection: Automatically detects lanes with inverted polarity.

• Auto Sense Lane Width: Analyzes all negotiation traffic between devices with 
different lane widths, eliminating the need to set up lane widths before a trace. 

• Lane Swizzling Support: Allows board developers to lay out lanes in a 
non-standard order, simplifying board design. 

• Powerful Real-time BusEngine Protocol Processor Technology: Sophisticated 
triggering and filtering help you focus on critical protocol data and isolate important 
protocol traffic, specific errors, or data patterns. 

• Field-upgradeable Firmware and Engine: Positions you to receive the latest 
PETracer enhancements and future additional capabilities. Allows field upgrades of 
all system types. 

• 8-GB Data Buffer: Capture long time windows for in-depth analysis and 
identification of erratic problems. 

• 10/100 MBps Ethernet Connectivity: Allows connection to an Ethernet network 
and sharing of analyzer resources by multiple engineers. 

2.5 Other Documents
For more information, refer to the following documents:

• Teledyne LeCroy Analyzers File-based Decoding Manual

• PETracer/Trainer Automation Manual

• PETracer VSE Manual

• PETracer Gen2 Multi Lead Probe User Manual

• PETrainer Scripting Language Reference Manual

• PETracer Online Help
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Chapter 3:  Hardware Description
The PCI Express™ system features Summit Analyzers.

3.1 System Components
• PETracer Summit system:

• PETracer Gen2 Summit™ analyzer box

• Breakout Board with cable

• PETracer Software program CD-ROM

• Active or Passive interposer (optional)

• Active or Passive interposer card with 12V power supply

• One or two (for x8 or x16 recording) Mid Box assemblies

• Two or four (for x8 or x16 recording) Analyzer-to-Pod cables

• One or two (for x8 or x16 recording) iPass Y probe data cables

• MidBus probe (optional)

• One or two (for x8 or x16 recording) PCI Express Midbus Pods with 
12-volt power supplies

• One or two (for x8 or x16 recording) MidBus probe assemblies

• Two or four (for x8 or x16 recording) Analyzer-to-Pod cables

• Summit T2-16 system:

• Summit T2-16™ analyzer box

• AC Power Cable

• One or two (for x8 or x16 recording) iPass Y probe data cables

• Breakout Board with cable

• PETracer Software program CD-ROM

• Active interposer with Power Supply (optional)

• Passive interposer with Power Supply (optional)

• MidBus probe (optional)

• One or two (for x8 or x16 recording) MidBus probe assemblies

• One or two (for x8 or x16 recording) T2 MidBus Pods

3.2 Host Machine Requirements
PETracer Summit and Summit T2-16 connect to a host machine. Please consult the 
readme file on the installation CD for the latest host machine requirements.
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3.3 Summit T2-16 Front Panel Description
When powered on, the Summit T2-16 activates the user-accessible controls and LEDs 
on the front and rear panels.

Warning!  Do not open the enclosure. There are no operator serviceable parts inside. 
Refer servicing to Teledyne LeCroy.

The controls and LEDs are:

• Power Switch (black): 1 = On and 0 = Off.

• LCD Menus: Allows you to set up the Summit T2-16 and view status. See “LCD 
Menus” on page 13.

• Up Arrow (top blue button): Move up in the LCD menu.

• Select (middle blue button): Select or change an option.

• Down Arrow (bottom blue button): Move down in the LCD menu.

• Record LED: Lights when the Summit T2-16 is recording.

• Trigger LED: Lights when the Summit T2-16 triggers on an event.

• Status LED: Displays Analyzer status: blue = good or red = error.

• Manual Trigger (right blue button): Forces a trigger.

• UPSTREAM [15:8] and UPSTREAM [7:0] connectors: Connection to the probe or 
MidBus module for the capture of upstream direction of the link.

• DOWNSTREAM [15:8] and DOWNSTREAM [7:0] connectors: Connection to the 
probe or MidBus module for the capture of downstream direction of the link.

• REF CLK IN (Reference Clock In): Provides an optional alternative connection 
from an external reference clock source to the Summit T2-16 analyzer.
Note: In standard configuration, the Summit T2-16 analyzer uses the reference 
clock from a probe cable.
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LCD Menus
The Summit T2-16 has a front LCD panel that displays menus with commands for 
configuring the device. 

Boot Sequence
The boot sequence for the analyzer takes a few seconds. As the analyzer boots, it 
initializes itself, beeps, and shows the status on the LCD panel. If the analyzer boots 
successfully, the LCD panel Root menu appears.

During initialization, the LCD panel displays boot status messages.

Booting from Boot-Code
If the analyzer does not boot successfully, or if it becomes non-responsive, you can boot 
from default settings called boot-code. 

Boot-code is a simplified version of Summit firmware. It allows the analyzer to boot to the 
point where it can communicate with the Summit software application. After 
communication is established between the analyzer and software application, you can 
download a different version of firmware and BusEngine files to the analyzer.

To boot from boot-code:

Step 1 Press and hold the Manual Trigger button on the analyzer front panel.

Step 2 While holding the button DOWN, turn the box ON.

After you complete these steps, download the new version of BusEngine and firmware 
files, then reboot the analyzer from the LCD panel menu (Summit Setup > Reboot).

Root Menu
The Root menu appears after successful boot-up. The top line of the Root menu displays 
the device status with the following:

• [PCI]: Indicates the hardware platform.

• Idle: Shows analyzer status.

Submenus
The Root menu has these options:

• Summit Setup menu: Allows setup using submenus.

• Platform Status menu: Shows the results for the power-on self-diagnostics.

Note:  When lists of options are presented in a menu, the current selections are 
indicated with an asterisk. 

To navigate, use the Up Arrow and Down Arrow buttons (top and bottom blue buttons) 
on the front of the unit. 

To select or change an option, use the Select button (middle blue button).
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Summit T2-16 Setup Menu

Menu Submenu Command

IP Mode Static
Dynamic

Static = You assign an IP address.
Dynamic = A DHCP server assigns an IP address.

IP Address If IP Mode = Dynamic, this field is ignored.

Subnet Mask Default is 0.0.0.0 
If IP Mode = Dynamic, this field is ignored.

Default Gateway Default is 0.0.0.0 
If IP Mode = Dynamic, this field is ignored.

Reboot Cancel
Confirm

Selecting Confirm causes Summit to save the 
current configuration and reboot. 

Shutdown Cancel
Confirm

Selecting Confirm causes Summit to save the 
current configuration and shut down. 

About Displays status on the following parameters:
• Subnet Mask

• Default Gateway

• BootCode

• Firmware

• Bus Engine

• IP Mode: Dynamic or Static

Note: To go back to the previous menu, press the 
Select button (middle button).

[Back] Returns to the Root menu.
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3.4 PETracer Summit Front Panel Description
When powered on, the PETracer Summit activates the user-accessible controls and 
LEDs on the front and rear panels.

Warning!  Do not open the enclosure. There are no operator serviceable parts inside. 
Refer servicing to Teledyne LeCroy.

The controls and LEDs are:

• Power Switch (black): 1 = On and 0 = Off.

• LCD Menus: Allows you to set up the PETracer Summit and view status. See “LCD 
Menus” on page 16.

• Up Arrow (top blue button): Move up in the LCD menu.

• Select (middle blue button): Select or change an option.

• Down Arrow (bottom blue button): Move down in the LCD menu.

• Record LED: Lights when the PETracer Summit is recording.

• Trigger LED: Lights when the PETracer Summit triggers on an event.

• Status LED: Displays Analyzer status: blue = good or red = error.

• Manual Trigger (right blue button): Forces a trigger.

• UPSTREAM 1 (lanes [7:0]) and UPSTREAM 2 (lanes [15:8]) connectors: 
Connection to the Pod for the capture of upstream direction of the link.

• DOWNSTREAM 1 (lanes [7:0]) and DOWNSTREAM 2 (lanes [15:8]) connectors: 
Connection to the Pod for the capture of downstream direction of the link.
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LCD Menus
The PETracer Summit has a front LCD panel that displays menus with commands for 
configuring the device. 

Boot Sequence
The boot sequence for the Summit box takes a few seconds. As the box boots, it 
initializes itself, beeps, and shows the status on the LCD panel. If the box boots 
successfully, the LCD panel Root menu appears.

During initialization, the LCD panel displays boot status messages.

Booting from Boot-Code
If the Summit box does not boot successfully, or if it becomes non-responsive, you can 
boot from default settings called boot-code. 

Boot-code is a simplified version of Summit firmware. It allows the box to boot to the point 
where it can communicate with the Summit software application. After communication is 
established between the box and software application, you can download a different 
version of firmware and BusEngine files to the box.

To boot from boot-code:

Step 1 Press and hold the Manual Trigger button on the Summit box front 
panel.

Step 2 While holding the button DOWN, turn the box ON.

After you complete these steps, download the new version of BusEngine and firmware 
files, then reboot the box from the LCD panel menu (Summit Setup > Reboot).

Root Menu
The Root menu appears after successful boot-up. The top line of the Root menu displays 
the device status with the following:

• [PCI]: Indicates the hardware platform.

• Idle: Shows analyzer status.

Submenus
The Root menu has these options:

• Summit Setup menu: Allows setup using submenus.

• Platform Status menu: Shows the results for the power-on self-diagnostics.

Note:  When lists of options are presented in a menu, the current selections are 
indicated with an asterisk. 

To navigate, use the Up Arrow and Down Arrow buttons (top and bottom blue buttons) 
on the front of the unit. 

To select or change an option, use the Select button (middle blue button).
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PETracer Summit Setup Menu

Menu Submenu Command

IP Mode Static
Dynamic

Static = You assign an IP address.
Dynamic = A DHCP server assigns an IP address.

IP Address If IP Mode = Dynamic, this field is ignored.

Subnet Mask Default is 0.0.0.0 
If IP Mode = Dynamic, this field is ignored.

Default Gateway Default is 0.0.0.0 
If IP Mode = Dynamic, this field is ignored.

Reboot Cancel
Confirm

Selecting Confirm causes Summit to save the 
current configuration and reboot. 

Shutdown Cancel
Confirm

Selecting Confirm causes Summit to save the 
current configuration and shut down. 

About Displays status on the following parameters:
• Subnet Mask

• Default Gateway

• BootCode

• Firmware

• Bus Engine

• IP Mode: Dynamic or Static

Note: To go back to the previous menu, press the 
Select button (middle button).

[Back] Returns to the Root menu.
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3.5 Summit T2-16 Rear Panel Description
From left to right, the Summit T2-16 rear panel contains the following components:

Figure 3.1 Summit T2-16 Rear Panel 

Wide-range AC Connector Module
• Power on/off switch

• Enclosed 5x20 mm 2.0A 250 V fast acting glass fuse

• Power socket

Warning!  For continued protection against fire, replace fuse only with the type and 
rating specified above.

Sync In and Sync Out Connectors
(not currently active) These connectors allow multiple Summit T2-16 analyzers to send 
synchronization and control messages to one another. 

USB Type B Host Machine Computer Connector
This connector links an Analyzer to the host machine for the purpose of transmitting 
commands from the host machine to the Analyzer and uploading traces from the 
Analyzer’s recording memory to the PETracer software for viewing and analysis. 
Note: For each Analyzer or Exerciser, use either USB or Ethernet, not both.

Ethernet Port
GIGE Connectivity allows connection to an Ethernet network and sharing of analyzer 
resources by multiple engineers. Note: For each Analyzer or Exerciser, use either USB 
or Ethernet, not both.

BNC Connectors Trigger In and Trigger Out
These BNC connectors allow the Analyzer to transmit or receive trigger event signals.
Triggering: The Ext. In can receive a signal from another device and use that signal to 
trigger the end of the recording. Conversely, the Ext. Out connector can be used to send 
an output signal from the Analyzer to another device. 

The BNC connectors are not used for the PETrainer Exerciser. 
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RS-232 25-pin Data Input/Output Connector
This connector links a 25 pin RS-232 cable to an external Breakout Board. The 
Breakout Board allows signals to be sent from the Exerciser or Analyzer to an external 
device such as an oscilloscope or from an external device to the Exerciser or Analyzer 
for the purpose of triggering on an external input. You configure input/output through the 
Recording Options dialog box. The Breakout Board use is described at the end of this 
chapter.

Teledyne LeCroy Bus Connector
The Teledyne LeCroy Bus Connector is not currently active.
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3.6 PETracer Summit Rear Panel Description
From left to right, the PETracer Summit rear panel contains the following components:

Figure 3.2 PETracer Summit Rear Panel 

Wide-range AC Connector Module
• Power socket

• Enclosed 5x20 mm 2.0A 250 V fast acting glass fuse

• Power on/off switch

Warning!  For continued protection against fire, replace fuse only with the type and 
rating specified above.

RS-232 25-pin Data Input/Output Connector
This connector links a 25 pin RS-232 cable to an external Breakout Board. The 
Breakout Board allows signals to be sent from the Analyzer to an external device such 
as an oscilloscope or from an external device to the Analyzer for the purpose of triggering 
on an external input. You configure input/output signalling through the Recording Options 
dialog box. The Breakout Board use is described at the end of this chapter.

USB Type B Host Machine Connector
This connector links the Analyzer to the host machine for the purpose of transmitting 
commands from the host machine to the Analyzer and uploading traces from the 
Analyzer’s recording memory to the PETracer software for viewing and analysis. Note: 
May not be active on some Summit systems.

Ethernet Port
10/100 Mbps Ethernet Connectivity allows connection to an Ethernet network and 
sharing of analyzer resources by multiple engineers.
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BNC Connectors Ext. In and Ext. Out
These BNC connectors allow the Analyzer to transmit or receive external signals. 
External signaling, in turn, can serve two functions: 

• Linking of Analyzers: On dual Analyzer systems, the BNC connectors are used to 
create a loop for transmitting clocking information and commands between the 
Analyzers. This linking allows the two Analyzers to function as a single, logical 
Analyzer.

• Triggering: The Ext. In can receive a signal from another device and use that 
signal to trigger the end of the recording. Conversely, the Ext. Out connector can be 
used to send an output signal from the Analyzer to another device. 

The Ext. In and Ext. Out connectors have the same function as the 25 pin RS-232 
connector - i.e., they channel input and output signals but do not support the use of a 
Breakout Board. 

VHDCI Sync In and Sync Out Connectors
These connectors allow multiple PETracer Summit or Summit T2-16 analyzers to send 
synchronization and control messages to one another. 
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3.7 External Interface Breakout Board
With each Analyzer, Teledyne LeCroy includes an External Interface Breakout Board for 
accessing several potentially useful standard, LV TTL output and input signals. The 
Breakout Board also offers a simple way to connect logic Analyzers or other tools to the 
Analyzer unit. Six ground pins and one 5-volt pin are provided.

The Breakout Board connects via a cable to the Data In/Out connector located on the 
rear of the Analyzer unit. Each signaling pin is isolated by a 100  series resistor and a 
buffer inside the Analyzer unit. 

Data In/Out Connector (on cable)
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Pin-Outs for the Data In/Out Connector
The following table lists the pin-out and signal descriptions for the Data In/Out connector 
on a cable that connects to the Breakout Board. 

Data In/Out Connector – Pin-Out

Note:  (*) Pins 4 and 17 have the same function: they allow external signals to be 
used to cause triggering or recording. Pins 3 and 16 are used to transmit 
output signals. Pins 6, 7, 8, 9, 18, 19, 21, and 22 (data pins) are used to 
define data patterns for external input signals. 

Note:  All models of PETracer only support Data 0 - Data 3.

Prototype Rework Area
The Breakout Board contains a prototype rework area for making custom circuits for rapid 
development. The area consists of plated-through holes, 20 columns wide by 27 rows 
long. The top row of holes is connected to GND and the bottom row is connected to +5V. 
The remaining holes are not connected. Use the rework area to insert custom 
components and wire-wrap their respective signal, power, and ground pins. 

Pin Signal Name Signal Description

1 RSV Reserved

2 GND Ground

3 GP OUT General Purpose Output

4 TRG IN 1 Trigger In 1

5 GND Ground

6 DATA 6 Data 6

7 DATA 4 Data 4

8 DATA 3 Data 3

9 DATA 1 Data 1

10 GND Ground

11 RSV Reserved

12 RSV Reserved

13 +5V +5 Volts, 250 mA DC Source

14 RSV Reserved

15 GND Ground

16 TRG OUT Trigger Out

17 TRG IN 0 Trigger In 0

18 DATA 7 Data 7

19 DATA 5 Data 5

20 GND Ground

21 DATA 2 Data 2

22 DATA 0 Data 0

23 GND Ground

24 RSV Reserved

25 RSV Reserved
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Breakout Board Input and Output Signals
A Breakout Board can be used to channel input signals into the Analyzer in order to cause 
triggering. A Breakout Board can also be used to channel signals from the Analyzer to an 
external source.

Drive strength for all outputs is about 30 mA high (@2 V) and 60 mA low (@0.5 V). Inputs 
can handle 0 V to 5.5 V. Inputs above 2 V are detected as logic high; inputs below 0.8 V 
are detected as logic low.

The Breakout Board connects via a cable to the Data In/Out connector on the rear of the 
Summit systems.

External Recordable Signals
Breakout Board Data 0-3: These pins let you define a 4-bit Data Pattern that can be 
recorded in a CATC Trace file.

External Input Triggers
You can use either an external input signal or the Trigger button on the front of the UPAS 
to cause triggering. The following descriptions show what pins or buttons to use:

Breakout Board Data 3 - Data 0: Triggers on a 4-bit input pattern.

Breakout Board Trigger In 0: Selectable Edge triggered inputs. Triggers on any edge it 
detects. 

Breakout Board Trigger In 1: Selectable Edge triggered inputs. Triggers on any edge it 
detects.

BNC Trigger (EXT IN): Selectable Edge triggered inputs. Triggers on any edge it detects. 
Located on the back of the chassis.

Push Button Trigger: The Trigger button on the front of the UPAS can be pressed to 
manually cause a trigger. 

External Outputs
The Analyzer can be configured to send an external signal anytime a trigger and/or event 
occurs. The following descriptions show the behavior of these output signals:

Breakout Board Trigger Out: Changes from low to high when Analyzer triggers 
(one time per recording only)

Breakout Board G.P. Output: Programmable waveform (low or high pulse, toggle). Each 
event can be programmed to enable this external signal.

BNC Output (EXT OUT): Same as Breakout Board G.P. Output. Located on the back of 
the chassis.

Setting Recording Options to Support External Input/Output 
Signaling
After a Breakout Board has been connected to a Summit system, the Analyzer must be 
configured for external or internal input signaling. 
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Chapter 4:  Installation and Setup
PETracer Summit™ and Summit T2-16™ are stand-alone systems.

You can begin making PCI Express™ recordings after following the steps in this chapter. 

4.1 Installing the PETracer Software
PETracer software operates all of Teledyne LeCroy’s PCI Express protocol Analyzer and 
Exerciser products:

The PETracer software is installed on a Microsoft® Windows®-based host machine and 
serves as the interface for the Analyzer.

To install the PETracer software on the host machine, before attaching the Analyzer to 
the system: 

Step 1 Insert the CD into the CD ROM drive of the host machine that will control 
the Analyzer. The installation window opens and displays links to the 
PETracer software, user manuals, a readme file, and Acrobat Reader.

Step 2 Select Install Software and follow the on-screen instructions.

The PETracer software installs automatically on the host machine’s hard disk. 
During installation, all necessary USB drivers are loaded automatically. Drivers 
included in the installation are:

• summit.sys: Summit T2-16 driver

Note:  PETracer Summit needs no driver installation.

Step 3 To start the application, launch the PETracer program from the Start 
menu: 
Start > Programs > LeCroy > PETracer > LeCroy PETracer
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The PETracer program opens:

Note:  The software may be used with or without the Analyzer attached to the 
system. When used without an Analyzer attached to the computer, the 
program functions as a CATC Trace Viewer to view, analyze, and print 
captured traffic. 
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4.2 Setting Up the Summit T2-16 Analyzer using an 
Ethernet Connection

Step 1 Remove the Analyzer from its shipping container. 

Step 2 Connect the Analyzer to a 100-volt to 240-volt, 50 Hz to 60 Hz, 
120 W power outlet using the provided power cord. 

Note: The Analyzer is capable of supporting supply voltages between 100 volts 
and 240 volts, 50 Hz or 60 Hz, thus supporting all known supply voltages around 
the world.

Step 3 Connect the Ethernet cable between the Ethernet port on the back of the 
Analyzer and a Ethernet port (hub, switch or wall) in your local network. 
Continue with Step 4 below.

Note on USB: To connect using USB, see “Setting Up the Summit T2-16 
Analyzer using a USB Connection” on page 30.

Step 4 Turn on the rear power switch and the front power switch. 

Note: At power-on, the Analyzer initializes itself in approximately five seconds 
and performs an exhaustive self-diagnostic that lasts about forty seconds. The 
results are reflected by messages on the Summit T2-16 LCD display (see 
“Summit T2-16 Front Panel Description” on page 12). If the LCD display indicates 
failure, call Teledyne LeCroy Customer Support for assistance. 

Connecting to a Summit T2-16 Analyzer in the 
Local Network
After you have installed the PETracer application software, perform the following 
procedure to connect to a Summit T2-16 analyzer in the local network. 

Step 1 Select the Setup > All connected devices… menu in the PETracer 
application to display the Analyzer Devices dialog. 
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The PETracer software fills the list with devices that are connected over USB or 
discovered on the Ethernet network. The discovery mechanism works only within 
one network subnet. If a Summit is connected to the network on a different 
subnet, you can manually add the subnet to the list by clicking the Add Device 
button and specifying the IP address.

The Summit devices in the list are marked:

• Locked: Some other client on the network is already connected to that 
device

• Ready to connect: Available for connection

Step 2 If a Summit device is marked Ready to Connect, you can select that 
device and press the Connect button to execute the connection 
procedure. 

After the connection is established, the application displays the Connection 
Properties dialog:

Step 3 Select an option:

• Automatically connect to the device: When the application is started or 
when the named device is added to the network while the PETracer 
application is running on this computer, the PETracer application will try to 
connect to the named device. 

• Ask if I want to connect to the device: When the application is started or 
when the named device is added to the network while the PETracer 
application is running on this computer, the PETracer application will display a 
message box allowing you to connect to the named device. 

• Take no action: When you start the application or when you add the named 
device to the network while the PETracer application is running on this 
computer, you must connect manually to use the named device. 

Note:  When you close the application on this computer (or you perform manual 
disconnect), the application disconnects from the device. 
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Step 4 Press OK in the Connection Properties dialog.

After you finish the connect procedure, the Summit device to which you have 
connected is marked as Ready and you can use it for recording:

Note:  To disconnect from a device, display this dialog, select the device, and click 
the Disconnect button.

Warning! Do not change from USB to Ethernet, or back, without power cycling 
the analyzer.
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4.3 Setting Up the Summit T2-16 Analyzer using a 
USB Connection

To set up the Analyzer using a USB connection: 

Step 1 Remove the Analyzer from its shipping container. 

Step 2 Insert and install the Installation CD. 

Step 3 Connect the Analyzer to a 100-volt to 240-volt, 50 Hz to 60 Hz, 
120 W power outlet using the provided power cord. 

Note: The Analyzer is capable of supporting supply voltages between 100 volts 
and 240 volts, 50 Hz or 60 Hz, thus supporting all known supply voltages around 
the world.

Step 4 Connect the USB port to a USB port on the host machine using a USB 
cable.

Note on Ethernet: To connect using Ethernet, see “Setting Up the Summit T2-16 
Analyzer using an Ethernet Connection” on page 27.

Step 5 Turn on the rear power switch and the front power switch. 

Note: At power-on, the Analyzer initializes itself in approximately five seconds 
and performs an exhaustive self-diagnostic that lasts about forty seconds. The 
results are reflected by messages on the Summit T2-16 LCD display (see 
“Summit T2-16 Front Panel Description” on page 12). If the LCD display indicates 
failure, call Teledyne LeCroy Customer Support for assistance. 

Step 6 Click Next after you see the Add New Hardware Wizard window. 

Step 7 Follow the Microsoft® Windows® on-screen Plug-and-Play instructions 
for the automatic installation of the Analyzer as a USB device on your 
analyzing host machine. (The required USB files are included on the 
Installation CD and were installed on your system when you installed the 
software CD.)

Step 8 Click Finish when you see the message that says “Windows has 
finished installing the software that your new hardware requires” and the 
file has been installed in your host machine. 

Warning! Do not change from USB to Ethernet, or back, without power cycling 
the analyzer.
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4.4 Setting Up the PETracer Summit Analyzer
Step 1 Remove the Analyzer from its shipping container. 

Step 2 Connect the Analyzer to a 100-volt to 240-volt, 50 Hz to 60 Hz, 
120 W power outlet using the provided power cord. 

Note: The Analyzer is capable of supporting supply voltages between 100 volts 
and 240 volts, 50 Hz or 60 Hz, thus supporting all known supply voltages around 
the world.

Step 3 Connect the Ethernet cable between the Ethernet port on the back of the 
Analyzer and a Ethernet port (hub, switch or wall) in your local network.

Step 4 Turn on the rear power switch and the front power switch. 

Note: At power-on, the Analyzer initializes itself in approximately five seconds 
and performs an exhaustive self-diagnostic that lasts about fifteen seconds. The 
results are reflected by messages on the PETracer Summit LCD display (see 
“PETracer Summit Front Panel Description” on page 15). If the LCD display 
indicates failure, call Teledyne LeCroy Customer Support for assistance. 

Note:  No driver installation is needed for the PETracer Summit device. 

Connecting to a PETracer Summit Analyzer in the 
Local Network
After you have installed the PETracer application software, perform the following 
procedure to connect to a PETracer Summit analyzer in the local network. 

Step 1 Select the Setup > All connected devices… menu in the PETracer 
application to display the Analyzer Devices dialog. 

The PETracer software fills the list with devices that are connected over USB or 
discovered on the Ethernet network. The discovery mechanism works only within 
one network subnet. If a Summit is connected to the network on a different 
subnet, you can manually add the subnet to the list by clicking the Add Device 
button and specifying the IP address.
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The Summit devices in the list are marked:

• Locked: Some other client on the network is already connected to that 
device

• Ready to connect: Available for connection

Step 2 If a Summit device is marked Ready To Connect, you can select that 
device and press the Connect button to execute the connection 
procedure. 

After the connection is established, the application displays the Connection 
Properties dialog:

Step 3 Select an option:

• Automatically connect to the device: When the application is started or 
when the named device is added to the network while the PETracer 
application is running on this computer, the PETracer application will try to 
connect to the named device. 

• Ask if I want to connect to the device: When the application is started or 
when the named device is added to the network while the PETracer 
application is running on this computer, the PETracer application will display a 
message box allowing you to connect to the named device. 

• Take no action: When you start the application or when you want to add the 
named device to the network while the PETracer application is running on this 
computer, you must connect manually to use the named device. 

Note:  When you close the application on this computer (or you perform manual 
disconnect), the application disconnects from the device. 
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Step 4 Press OK in the Connection Properties dialog.

After you finish the connect procedure, the Summit device to which you have 
connected is marked as Ready and you can use it for recording:

Note:  To disconnect from a device, display this dialog, select the device, and click 
the Disconnect button.
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4.5 Interposers and Probes
PETracer Summit and Summit T2-16 work with Interposers and Probes.

• Gen2 MidBus Probe: The Gen2 MidBus Probe is designed for use with the Summit 
T2-16 Analyzer and supports lane widths from x1 to x16 at data rates of 2.5 
GT/s (Gen1) or 5.0 GT/s (Gen2). 

• Gen2 Multi-lead Probe: The Summit Multi-lead Probe is designed for use with the 
Summit T2-16 Protocol Analyzer. The probe consists of 1 to 4 probe pods, which 
are connected to the analyzer using either iPass Y-Cables (for x1 and x4) or straight 
x4-to-x8 iPass cables (for x8 and x16). Each probe pod supports up to 8 Flex Tips, 
with each Flex Tip connected via two coax cables.

• Gen2 Passive Slot Interposer: The Gen2 Passive Slot Interposer is designed for use 
with the Summit T2-16 Analyzer and supports lane widths from x1 to x16 at data 
rates of 2.5 GT/s (Gen1) or 5.0 GT/s (Gen2). A separate interposer is used for each 
lane width that you would like to probe. Lane reducers should NOT be used with the 
Gen2 Passive Slot Interposer. For lane widths up to x8, one iPass Y-cable is 
required. For x16 applications, two iPass Y-cables are required.

• Gen2 Active Slot Interposer: The Gen2 Active Slot Interposer is designed for use 
with the Summit T2-16 Analyzer and supports lane widths from x1 to x16 at data 
rates of 2.5 GT/s (Gen1) or 5.0 GT/s (Gen2). Lane reducers/adapters may be used 
with the Gen2 Active Slot Interposer. For lane widths up to x8, one iPass Y-cable is 
required. For x16 applications, two iPass Y-cables are required.

The following sections describe how to set up probe systems.
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4.6 Using Probes

Example: Connecting the Summit T2-16 Analyzer to the 
Device Under Test Using a Gen2 MidBus Probe
Components

• 1 or 2 iPass Y-cable 

• 1 or 2 MidBus Probe pod 



Chapter 4: Installation and Setup Summit User Manual

36 Teledyne LeCroy

• 1 or 2 MidBus Probe Cable, Attachment Pad, and Header

• 1 or 2 Clock Cable
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Connections Overview for Gen2 MidBus Probe
Use a 1-pod or 2-pod setup depending on the lane width of the recording:

• For x16 recordings, use the 2-pod setup. 

• For all other lane width recordings, use a one-pod setup.

Use the iPass Y-cables to connect the probe data connectors on the Analyzer to the 
MidBus pod(s). 

On the other side of the pod, connect the MidBus probe assembly.

Connect the header on the MidBus probe assembly to the MidBus footprint on the 
System Under Test (host platform/root complex). The following picture shows two midbus 
footprints, with one connected to the MidBus probe assembly:

Connection Procedure
To connect the Summit T2-16 to the System Under Test (host platform/root complex): 

Step 1 Connect the MidBus pods to the Analyzer using the iPass Y-cables.

Step 2 Connect the MidBus probe assemblies to the MidBus pods.

Step 3 Connect the MidBus probe assemblies to the MidBus footprints on the system 
under test. 

Step 4 Connect external reference clock signal to Mid-Bus External Clock In on 
Mid-Bus probe pod, using external reference clock cable. For x16, you 
need to chain the pods.
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Example: Connecting the Summit T2-16 Analyzer to the 
Device Under Test Using a Gen2 Multi-lead Probe for 
x1 and x4
Components

• 1 iPass Y-cable for x1 and x4 (see “1 or 2 iPass Y-cable” on page 35) 

• 1 Multi-lead Probe Pod for x1 and x4

• up to 16 MidBus Probe SSMP Cables, and up to 8 Flexible Leads, per pod 

• 1 Clock Cable (see “1 or 2 Clock Cable” on page 36)
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Connections Overview for Gen2 Multi-lead Probe
Use a 1-pod setup.

For x1 or x4, use the iPass Y-cable to connect the probe data connectors on the Analyzer 
to the pod(s). 

On the other side of the pod, connect the flexible lead tips.

Connection Procedure
To connect Summit T2-16 to the System Under Test (host platform/root complex): 

Step 1 Connect the pods to the Analyzer using the iPass Y-cable cables.

Step 2 Connect the flexible lead tips to the pods using the SSMP cables.

Step 3 Connect the lead tips to the system under test by soldering to the trace. 
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Example: Connecting the Summit T2-16 Analyzer to the 
Device Under Test Using a Gen2 Multi-lead Probe for 
x8 and x16
Components
• 2 iPass Straight cables for x8 and 4 iPass Straight cables for x16 

• 2 Multi-lead Probe pods for x8
4 Multi-lead Probe pods for x16 
(see “1 Multi-lead Probe Pod for x1 and x4” on page 38)

• up to 16 MidBus Probe SSMP Cables, and up to 8 Flexible Leads, per pod
(see “up to 16 MidBus Probe SSMP Cables, and up to 8 Flexible Leads, per pod” on 
page 38)

• 1 Clock Cable (see “1 or 2 Clock Cable” on page 36)
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Connections Overview for Gen2 Multi-lead Probe
Use a 1-pod or 2-pod setup depending on the lane width of the recording:

• For x16 recordings, use the 2-pod setup. 

• For all other lane width recordings, use a one-pod setup.

For x8 and x16, use the straight iPass cables to connect the probe data connectors on 
the Analyzer to the pod(s). 

On the other side of the pod, connect the flexible lead tips.

Connection Procedure
To connect Summit T2-16 to the System Under Test (host platform/root complex): 

Step 1 Connect the pods to the Analyzer using the straight iPass cables.

Step 2 Connect the flexible lead tips to the pods using the SSMP cables.

Step 3 Connect the lead tips to the system under test by soldering to the trace. 
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4.7 Using Interposers

Example: Connecting the Summit T2-16 Analyzer to the 
Device Under Test Using a Gen2 Passive Interposer

Summit T2-16 Components
Summit T2-16 components used in the installation are:

• iPass Y-Cable: The cable supports eight lanes from two directions. Side A of the 
probe cable connects to the Upstream port on the Analyzer (on the left in the photo 
above), and Side B of the probe cable connects to the Downstream port (on the 
right).
Note: x16 recordings require two cables. 

• Summit T2-16 x16 Slot Gen2 Passive Interposer: The slot Interposer provides 
the point of attachment for the Analyzer to the Device Under Test (DUT). The Inter-
poser is designed to fit between a motherboard and one of its device cards - for 
example, a LAN card. The Interposer has three sets of connectors: a gold male con-
nector that fits into a standard x16 PCI Express slot on a motherboard, a black 
female connector that accepts a x16 PCI Express device such as a graphics card, 
and two Interposer cable connectors that connect the Interposer to the Analyzer. 
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Installing the Gen2 Passive Interposer
To install the Interposer, perform the following steps.

Step 1 Insert the gold male connector on the Interposer probe into a 
x16 PCI Express slot in the motherboard. Use edge adapters for x1, x4, 
and x8 slots.

Step 2 Insert the PCI Express DUT into the Interposer’s black female device 
connector. 

Step 3 The slot Interposer is shipped from Teledyne LeCroy with a metal face 
plate for attachment to a PC case. If you are working with a motherboard 
that is not in a PC case, you may prefer to remove the metal face plate 
so the Interposer can sit flat with the motherboard. To remove the face 
plate, unscrew the two screws that hold it onto the Interposer.

Connecting the Probe Data Cable
x8 recordings require one cable. To connect a single Interposer data cable, connect the 
probe data cable to the Interposer card at [7:0]. Connect Side A of the probe cable to the 
Upstream [7:0] port on the Analyzer, and connect Side B of the probe cable to the 
Downstream [7:0] port.

x16 recordings require two cables. Connect the second probe data cable to the 
Interposer card at [15:8]. Connect Side A of the second probe cable to the Upstream 
[15:8] port on the Analyzer, and connect Side B of the second probe cable to the 
Downstream [15:8] port.

Power On Analyzer and then DUT
Important: Power on the Analyzer before you power on the DUT.

Step 1 Power on the Summit T2-16 Analyzer.

Step 2 Power on the DUT.

Step 3 Open the PETracer software on the host machine. The Analyzer is now 
ready for PCI Express traffic recording.
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Example: Connecting the Summit T2-16 Analyzer to the 
Device Under Test Using a Gen2 Active Interposer

Summit T2-16 Components
Summit T2-16 components used in the installation are:

• iPass Y-Cable: The cable supports eight lanes from two directions. Side A of the 
probe cable connects to the Upstream port on the Analyzer (on the left in the photo 
above), and Side B of the probe cable connects to the Downstream port (on the 
right).
Note: x16 recordings require two cables. 

• Summit T2-16 x16 Slot Gen2 Active Interposer: The slot Interposer provides the 
point of attachment for the Analyzer to the Device Under Test (DUT). The Interposer 
is designed to fit between a motherboard and one of its device cards - for example, 
a LAN card. The Interposer has three sets of connectors: a gold male connector that 
fits into a standard x16 PCI Express slot on a motherboard, a black female connec-
tor that accepts a x16 PCI Express device such as a graphics card, and two Inter-
poser cable connectors that connect the Interposer to the Analyzer. 

Note: Edge reducers are required for lane widths less than x16.
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Installing the Gen2 Active Interposer
To install the Interposer, perform the following steps.

Step 1 Insert the gold male connector on the Interposer probe into a 
x16 PCI Express slot in the motherboard. Use edge adapters for x1, x4, 
and x8 slots.

Step 2 Insert the PCI Express DUT into the Interposer’s black female device 
connector. 

Step 3 The slot Interposer is shipped from Teledyne LeCroy with a metal face 
plate for attachment to a PC case. If you are working with a motherboard 
that is not in a PC case, you may prefer to remove the metal face plate 
so the Interposer can sit flat with the motherboard. To remove the face 
plate, unscrew the two screws that hold it onto the Interposer.

Connecting the Probe Data Cable
x8 recordings require one cable. To connect a single Interposer data cable, connect the 
probe data cable to the Interposer card at [7:0]. Connect Side A of the probe cable to the 
Upstream [7:0] port on the Analyzer, and connect Side B of the probe cable to the 
Downstream [7:0] port.

x16 recordings require two cables. Connect the second probe data cable to the 
Interposer card at [15:8]. Connect Side A of the second probe cable to the Upstream 
[15:8] port on the Analyzer, and connect Side B of the second probe cable to the 
Downstream [15:8] port.

Power On Analyzer and then DUT
Important: Power on the Analyzer before you power on the DUT.

Step 1 Power on the Summit T2-16 Analyzer.

Step 2 Power on the DUT.

Step 3 Open the PETracer software on the host machine. The Analyzer is now 
ready for PCI Express traffic recording.
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Chapter 5:  Software Overview

5.1 The PETracer Software
The PETracer™ software administers Analyzer platforms and handles all CATC Trace 
analysis and display. The core software is thus the same for all of Teledyne LeCroy's 
PCI Express products.

The software runs on a Windows®-based host machine that is attached to the Analyzer 
via an Ethernet or USB 2.0 connection (USB 1.0 is also supported). PETracer software 
can be used without the Analyzer as a CATC Trace viewer for viewing, analyzing and 
printing traces.

The PETracer software operates in Microsoft® Windows® XP and Vista environments. 
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5.2 Application Layout
The PETracer application contains the following components:

Title bar: The title bar is at the top of the application window and displays the CATC Trace 
file name or generation script name.

Menu bar: The menu bar is located below the title bar, by default. The menu bar can be 
moved by clicking a blank area of the bar and then dragging the menu to a new position. 
It can be docked in another part of the application window or moved outside of the window 
to become a floating menu.

Toolbar: The toolbar is composed of buttons that represent the commonly used 
commands. The toolbar divides into smaller toolbars that can be moved and docked in a 
new position or made to float outside of the window.

Display area: The display area is the main part of the application window in which 
CATC Traces are displayed.

Status bar: The status bar is located at the bottom of the application window. The left end 
of the status bar displays descriptions of buttons and menu items when the mouse is 
positioned over them. The right end of the bar shows the search direction.

5.3 Using the Toolbar
You can use the PETracer application Toolbar as a shortcut to most of the operations 
supplied by the menus.

Opens a previously recorded 
CATC Trace file.

Edit as text.
Script Editor. Opens a text editor for editing traffic 
generation files (*.peg)

Save As
Allows the open file to be saved 
with a new name.
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Setup Recording Options
Opens the Recording Options 
dialog box.

Setup Display Options
Opens the Display Options dialog box.

Setup Generation Options
Opens the Generation Options 
dialog box.

Start Recording. Real Time Statistics monitor
Opens a window that displays real-time 
information.

Stop Recording. Disconnect/Connect Link. 
Click once to break and momentarily later restore 
link. Open menu to select either Connect or 
Disconnect.

Repeat Upload.
Opens a dialog box that allows you 
to select a portion of memory to 
upload from memory, then causes 
the Analyzer to re-send the 
CATC Trace from the Analyzer 
buffer to the host machine

Zoom in display. Wraps display information.

Zoom out display.
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Hide Training Sequence. Hide Downstream traffic/recording.

Hide SKIP and Update FC 
packets.

Advanced Hiding Options
Opens a dialog box that allows you to select 
items to hide from view.

 Hide Upstream recording/traffic. Compact View
Toggles compacting of training sequences to 
analyze CATC Trace data faster, or no 
compacting to display more data.

Find
Opens a dialog box that allows you 
to select one or more items to find 
in the recording, then searches to 
that point.

Find Next. Repeats last Find or Search action.

View Packet Level data. View PQI Transaction Level data.

View Link Transaction Level data. View AHCI Transaction Level data.

View Split Transaction Level data View ATA Transaction Level data.

View NVM Transaction Level data.
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5.4 Multi-Segment Toolbar

File Information
Lists the conditions under which 
the recording was made.

Bus Utilization
Opens a window that graphically represents 
various information about the recording.

Error Report
Opens a window that lists all errors 
identified in the recording.

Link Tracker
Opens a window that displays symbol information 
per lane.

Traffic Summary
Opens a window that lists all 
events that occurred during the 
recording

Opens the Data Flow window.
Shows recorded data in a compressed tabular 
format.

Navigator. Shows/hides the 
Navigator bar - a utility that lets you 
easily navigate the CATC Trace.

LTSSM Flow Graph
Shows a state diagram of the LinkTraining 
and Status State machine.

Displays the Data/Payload 
window for the current packet.

Displays the Packet Header bar.
Opens a window that displays the header 
information in the current packet, as it would be 
viewed in the specification.

Opens the Timing and Bus Usage 
Calculations window.

Running Verification Scripts
Opens a dialog that allows you to select and run 
verification scripts.

First Segment. Open first segment in 
the multisegment CATC Trace.

Index file. This button becomes 
active if a multisegment CATC Trace 
file is open and displays the index file 
for the recording.

Previous segment. Open previous 
segment in the multisegment CATC 
Trace.

Next Segment. Open next segment in 
multisegment CATC Trace.

Last segment. Open last segment in 
multisegment CATC Trace.
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Toolbar Hide Buttons
The PETracer application toolbar has five buttons related to show/hide of CATC Trace file 
contents. The buttons allow you to quickly adjust the display to your needs.

 

Hide Training: Brings up a drop-down menu that lets you to hide all or a portion of the 
packets in the training portion of the CATC Trace.

Hide SKIP and Update FC: Brings up a drop-down menu that lets you hide SKIP or 
Update FC packets in a CATC Trace.

Hide Upstream: Hide all traffic from endpoint devices to the root complex. 

{

Hide Downstream: Hide all traffic from the root complex to endpoint devices.
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Advanced Hiding Options: Brings up the Level Hiding pane of the Display Options 
window. Use this pane to tune the show/hide options within the CATC Trace display. 
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5.5 Using the Menus
The PETracer application main display includes the following set of pull-down menus:

File Menu 

New Generator Script Creates a new Traffic Generation file.

Open Opens a file.

Close Closes the current file.

Save as Saves all or a specified range of packets to a uniquely named file.

Convert Old Files Convert CATC Trace files made in previous versions of PETracer to the new format for 
PETracer version 6.5x and higher.

Print Prints part or all of the current traffic data file.

Print Preview Produces an on-screen preview before printing.

Print Setup Setup your current or new printer.

Edit Comment Create or edit the comment field in a CATC Trace file.

Export
>> to Text 
>> Packets to CSV Text
>> to Generator 
      File Format

Saves all or part of a CATC Trace to a text file or traffic generation file. This text file 
summarizes the traffic in the CATC Trace.
Saves the CATC Trace to a text file in Comma Separated Value (CSV) format.
Saves the CATC Trace to a generation file.

Exit Exit the PETracer application.
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Setup Menu

Record Menu

Display Options Allows you to customize display options such as field colors, field formats and level 
hiding.

Recording Options Allows you to customize control and setup features associated with recording, 
triggering, and filtering recorded events.

Generation Options The Generation Options dialog box is used to set configuration settings in a traffic 
generation script (*.peg). This dialog provides a convenient alternative means of 
editing a traffic generation file.

Generation Macros Opens a dialog for creating buttons on the status bar that can be used to run traffic 
generation macros.

Update Device Opens a dialog box that lets you update the BusEngine™ and Firmware.

Calibrate Device Opens a dialog box that lets you calibrate the BusEngine™ and Firmware.

Analyzer Network Opens a dialog box for browsing to local and networked analyzers. Within the dialog, 
click Add to browse. The dialog lists PCs that are on the LAN. If a PC has an analyzer 
attached to it, and if DCOM permissions have been set on the selected PC, clicking 
Select establishes a connection.

All Connected Devices Opens a dialog box with a list of locally or remotely connected devices. Allows you to 
update the BusEngine, Firmware, and your licensing information.

Start Causes the Analyzer to begin recording traffic.

Stop Causes the Analyzer to stop recording traffic.

Reupload Causes the Analyzer to re-send all, or selected portions, of the CATC Trace from the 
Analyzer buffer to the host machine.

Disconnect/Connect Causes the Analyzer to momentarily break, and then establish the PCI Express link 
connection in both link directions.

Manual Trigger Trigger command for Analyzer is generated upon clicking this button.

Reset Link Configuration Causes the Analyzer to reset the Serdes and thereby reset the Analyzers current link 
configuration. This command is needed when lane width or other lane settings are 
changed. Otherwise, the old link configuration is used and errors are generated in the 
CATC Trace.
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Report Menu
Report Menu operations are only available when you are working with a CATC Trace file.

File Information Displays information about the file contents and describes the conditions of the file’s 
recording (Recording Options, hardware information,  and so on).

Error Summary Displays an error summary of the current CATC Trace file and allows you to go to a 
specific packet, and save the error file to a uniquely named file.

Traffic Summary Details the number and types of packets that were transferred during the recording. 
You can hide, save, send, text, print, and view.

Bus Utilization Opens a window with graphs of bus usage for the open CATC Trace.

Link Tracker Opens a window for displaying a detailed chronological view of traffic. The window 
provides view and navigation options.

Data Flow Opens the Data Flow Window, providing a tabular view of transactions and their 
payload.

Trace Navigator Shows the Navigator bar for navigating a CATC Trace. Shows a snapshot of the 
recording and allows you to adjust the memory area for the view.

LTSSM Flow Graph Shows a state diagram of bus activity. Also allows you to navigate through 
the LTSSM, based on the current recording.

Packet Header Opens the Packet Header bar, showing the Packet Header information as it would be 
veiwed in the specification.

Packet Data/View Data Opens the Data Window for the current packet, with the options: Hide, Save, 
Hexadecimal, ASCII, Decimal, Binary, MSB Format, LSB Format, Big Endian, and 
Little Endian. Format Line allows you to enter the number of bytes, words, or dwords 
per line. 

Configuration Space Presents a list of Configuration Spaces. Clicking an item displays the selected 
Configuration Space in a Configuration Table format.
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Search Menu
Search Menu operations are only available when you are working with a CATC Trace file.

Go to Trigger Repositions the display to show the first packet following the trigger event.

Go to Packet Repositions the display to a specific packet, Link Transaction, or Split Transaction 
number.

Go to Time Repositions the display to specific timestamp.

Go to Marker Repositions the display to a previously marked packet, Link Transaction, or 
Split Transaction.

Go to Allows searching for specific link events: TLP Type, DLLP Type, .Ordered Set, 
Link Event, Traffic Class, DLLP Virtual Channel, TLP Virtual Channel, Direction, 
Speed, Link Width, Requester ID, Completer ID, Data Lengths, Errors.

Find Displays the Find dialog to allow searching for various events within a CATC Trace. 
You can search by Display Level: Packets, Link Transactions, Split Transactions. 
You can search packets by Event Group: TLP Type, TLP Header, TLP Requester ID, 
TLP Completer ID, TLP Data Pattern, TLP Data Lengths, TLP Tag, 
TLP Sequence Number,  DLLP Type, DLLP Header, DLLP Virtual Channel, 
ACK/NAK Seq Number, Ordered Sets, Link Event, Direction, Errors. 
You can search link transactions by Event Group: TLP Type, Traffic Class, 
Virtual Channel,   Direction, Requester ID, Completer ID, Status, Tag. 
You can search split transactions by Event Group: TLP Type, Traffic Class, 
Virtual Channel,   Direction, Requester ID, Completer ID, Status, Tag. 
Find allows you to create complex searches based on numerous criteria.

Find Next Repeats the previous Find or Search operation.

Search Direction Allows you to specify a forward or backward search of a CATC Trace file.
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View Menu

Toolbars>> Displays available toolbars: Standard, Frequently Used, Analysis, and Transaction 
Level. Use Customize to  display the Windows Customize window.

Script Editor Displays the Script Editor (only appears if a .peg file is open).

Analyzer Network 
Chat Bar 

Opens a chat window for communicating with persons working with networked 
Analyzers. This command requires that your host machine be attached to a LAN. The 
Chat window broadcasts messages to whatever hosts have been connected to via the 
Analyzer Network command (under Setup in the menu).

Status Bar Switches display of the Status Bar on or off.

Real Time Statistics Opens the Real Time Statistics monitor dialog and displays a real-time graph of link 
activity.

Zoom In Zoom in increases the size of the displayed elements.

Zoom Out Zoom out decreases the size of the displayed elements.

Wrap Allows the display to wrap.

FC Credits Toggles a display for tracking Flow Control Credit update and consumption on a PCI 
Express link.

FC Credits Setup Allows you to customize the display for tracking Flow Control Credits.

Compact View Toggles compacting of the Link Training sequence to analyze CATC Trace 
data faster or no compacting to display more data.

Packet Level View the current recording at the Packet Level.

Link Transaction Level View the current recording at the Link Transaction Level.

Split Transaction Level View the current recording at the Split Transaction Level.

NVM Transaction Level View the current recording at the NVM Transaction Level.

PQI Transaction Level View the current recording at the PQI Transaction Level.

ACHI Transaction Level View the current recording at the ACHI Transaction Level.

ATA Transaction Level View the current recording at the ATA Transaction Level.
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Tools Menu

Window Menu

Help Menu

TC to VC Mapping Allows Traffic Classes to be mapped to Virtual Channels for purposes of simplifying 
navigation (for example, Search > Go to > TLP Virtual Channel) and changing the way 
the CATC Trace is displayed (for example, in Split Transactions).

Timing Calculations Starts the mode-less calculator dialog for calculating various timing and bandwidth 
parameters in the recording file.

Run Verification Scripts Presents a list of verification scripts, from which you can run a verification script.

New Window Opens a copy of the current CATC Trace window.

Cascade Displays all open CATC Trace windows in an overlapping arrangement.

Tile Displays all open CATC Trace windows as a series of strips across the display.

Arrange Icons Arranges minimized CATC Trace windows at the bottom of the display.

Synchronize Traces Synchronizes the CATC Trace View windows so that a move in one window 
repositions the other window of the same recording.

Help Topics Accesses the PETracer application's Online Help.

Register Product Online Register at the Teledyne LeCroy website registration page.

Check for Updates Check whether a new software version is available. If so, you can download 
from the Teledyne LeCroy web site. 
You can select to Check for updates at application startup

Update License Displays a dialog box for entering updated license information. 

Display License Information Opens an information box describing the current license information.

About Displays version information about the attached Analyzer and its Firmware and 
BusEngine™.
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5.6 Tool Tips
Tool tips provide details about fields within the CATC Trace. To see a tool tip, position your 
mouse pointer over a field within the CATC Trace.

You can turn off this capability in the Display Options menu.

5.7 Keyboard Shortcuts

Keystrokes Operation

Ctrl + N New PETracer script

Ctrl+O Open file

Ctrl+P Print

Ctrl+S Save file

Ctrl + R Start Analyzer recording

Ctrl + T Stop Analyzer recording

Ctrl+Home Jump to first packet

Ctrl+End Jump to last packet

Ctrl + G Go to packet ...

Ctrl+F Search forward

F3 Find next

F6 Next pane

Shift+F6 Previous pane

Ctrl+B Search backward
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5.8 Status Bar
The Status Bar is a gray bar that runs along the bottom of the application window.

From left to right:

PETracer SN:309: Analyzer Serial Number

Ready: Analyzer Status

Recording Progress Bar: The colored bar to the right of the serial number represents 
how much traffic has been recorded. The trigger point is indicated by the black line at the 
left side of the bar. In this example, the trigger occurred at the very beginning of the 
CATC Trace. If the trigger is set in the middle of the CATC Trace, the line is positioned in 
the middle of the bar. Additionally, the color of the bar is different on each side of the 
trigger point. For examples, see “Recording Progress Bar” on page 63. The white strip 
along the top edge of the color bar indicates how much traffic has been uploaded from 
the Analyzer buffer to the host machine. 

Uploading and 20%: Indicates the Analyzer's recording status, what part of the 
recording process the Analyzer is now in. In this example, the Analyzer is in the upload 
stage and has completed 20% of the upload from the Analyzer to the host machine. See 
“Recording Status” on page 63 for details on other status messages.

Activity: The colored bar moves to indicate that the Analyzer is currently recording.

Search: Fwd: Indicates search direction. The direction can be toggled to Search: Bwd 
by double-clicking the search direction or by selecting Search Direction from the Search 
menu.

Recording Progress Bar
This indicator bar changes color to reflect the recording progress.

• Black vertical line is at the location of Trigger position.
• Black vertical line wiggles when Trigger Position is nearly reached.
• Field to right of Trigger Position changes color to indicate post-trigger activity.
• Upper half of progress indicator turns white when recording is complete.

Recording Status
The second segment from the left in the Status Bar indicates recording status.

During recording, this status flashes one of the following messages:

• Trigger?
• Triggered!
• Uploading
After recording stops, the message changes to 

• Uploading data - x% done (where x equals the percent that has been uploaded.)
As uploading progresses, the percent increases to 100. You can abort this upload if you 
wish by pressing the <escape> button on your keyboard or 

clicking  in the Tool Bar.
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Recording Activity
The third segment displays recorded activity. Activity is indicated in blue: 

Search Direction Indicator
The fourth segment in the status bar indicates search direction. The direction can be 
changed by selecting Search Direction from the Search menu.
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5.9 Making a PCI Express Recording
After connecting the Analyzer to the device(s), you must configure the 
Recording Options. Then you can test the Analyzer by creating a 16-MB snapshot 
recording.

To make this recording, follow these steps:

Step 1 From the Setup menu, select Recording Options.

Step 2 Select the General tab. 

The following window displays the factory default settings in Simple Mode, such 
as Snapshot and 16-MB buffer size. For your first recording, you can leave these 
settings unchanged.

Step 3 In the Link section, specify the lane width of the PCI Express link to be 
analyzed. The rest of the settings in this section can be left at the factory 
defaults for most PCI Express systems. 
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Step 4 For multi-lane PCI Express links, the Analyzer needs to observe 
link training in order to record link traffic correctly. 

Note: For PETracer Summit, If link training (or re-training) is not easily 
controllable for the devices under test, the Analyzer includes the capability to 
force link training by disconnecting and reconnecting the PCI Express link.

Clicking the Connect/Disconnect  button disconnects the PCI Express 
link for one second in both directions, then re-establishes the link.
Note: For x1 PCI Express links, it is not necessary for the Analyzer to observe 
link training in order to record link traffic; this step may be skipped.

Step 5 Click OK at the bottom of the Recording Options dialog box to apply the 
Analyzer recording settings specified.

Step 6 Click the Record  button. 

Stopping a Recording
You can stop the recording process at any time by pressing the Stop button  on the 
toolbar. This causes the Analyzer to stop the recording and upload the CATC Trace to the 
host machine. 

You can interupt a session by pressing the Escape key. If Recording is finished and 
Upload has started but has not finished, a message box appears: 

You can:

• Stop: Aborts further CATC Trace upload and displays whatever data that has 
already been uploaded.

• Continue: Resumes the upload. This command tells the Analyzer to finish 
uploading whatever CATC Trace data is still in its buffer.

• Flush: Flushes the CATC Trace without saving or displaying it.
If you allow the traffic data to be uploaded, it is automatically saved on the host machine’s 
hard drive as a file named data.pex or the name you assign as the default filename in the 
recording options. 

Saving a Recording
Step 1 To save a current recording for future reference, select Save As from the 

File menu.

Step 2 Give the recording a unique name, then save it to the appropriate 
directory.
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5.10 PETracer Files
The PETracer software creates and uses different kinds of files:

• CATC Trace Files: Recorded traffic
• Recording Options Files: Configuration file that contains the various options 

selected in the Recording Options dialog box to configure the recording
• Display Options Files: Configuration file that contains the options selected in the 

Display Options dialog box to configure how traffic is displayed

CATC Trace Files
PETracer records PCI Express traffic into a CATC Trace file with the default name 
data.pex or any other that you specified in the Recording Options. This file is overwritten 
with new data each time PCI Express traffic is recorded. 

If you want to save a CATC Trace, use the File > Save As function. This option allows 
you to save the current CATC Trace to a unique file name, thereby ensuring that it is not 
overwritten. This option also allows you to save a range of packets in a CATC Trace file.

You can pre-define the name of the recorded CATC Trace file using the Trace Filename 
and Path option in Recording Options. 

Recording Options Files
Recording Options files are created when you set recording options. These files use the 
.rec extension and contain recording option information. 

Display Options Files
Display Options files are created when you set display options. These files use the .opt 
extension and contain the display options information.
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5.11 Opening CATC Trace Files
To open an existing CATC Trace file, click File > Open or .

If the file was made in a previous version of PETracer, the application presents the 
Convert dialog box: 

You must convert CATC Trace files made in previous versions of PETracer for them to 
open in PETracer version 6.5x or higher. The converted file has all the information that 
was in the original file.

You can:

• Convert & Backup old file: Convert the file, open it in PETracer version 6.5x 
or higher, and save it with the original name. Save the original file with the 
same name plus the extension .bak.

• Convert: Convert the file, open it in PETracer version 6.5x or higher, and save 
it with the original name. 

Note:  After you convert a CATC Trace file, you cannot open the converted file in a 
previous PETracer version. 
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5.12 Saving CATC Trace Files

Using the Save As Function
When you record a CATC Trace file, the Analyzer software provides a pre-defined name 
to the CATC Trace file (data.pex or any other that you specified in the Recording 
Options). If you do consecutive recordings, each time the previous recording is 
overwritten. If you see a recording you want to analyze later, you need to give a unique 
name to the CATC Trace file, so it is not overwritten with the next recording.

Also, when you analyze a recorded CATC Trace file, you might be interested in 
preserving just a part of the PCI Express traffic that was recorded. If you save a portion 
of a CATC Trace file, it can get significantly smaller, allowing you to attach it to an e-mail.

To save a portion of a CATC Trace file or the whole file to a unique name, select Save As 
from the File menu.

If you want to give a unique name to the CATC Trace file, select the All option and keep 
Rename original file checked. This is the default setting for the dialog.

Saving a Portion of a CATC Trace
If you want to save a portion of a CATC Trace file, select Save packet range. Enter 
starting and ending packet numbers in the From Packet and To Packet fields. By default, 
it has the numbers of the first and the last packets in the file. The software is going to save 
all the packets in specified range to the new file, unless you have Do not save hidden 
packets checked. In this case it is going to save all packets in the range, EXCLUDING 
the currently hidden packets.
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5.13 Exporting a CATC Trace File
By default, PETracer saves CATC Trace files in the .pex format. However, you can export 
a CATC Trace to a file in any of the following other formats: 

• Text

• Comma Separated Value (CSV)

• Generator file format

Exporting to Generator file format is a simple way to create a script file from your 
CATC Trace.

To export a CATC Trace file, select File > Export: 
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5.14 Printing Data Files
To print all or part of the open CATC Trace:

Step 1 Select File > Print from the menu or 

click the Printer  button on the toolbar. 

The Print Packets dialog opens:

Step 2 To select a range of packets, enter values in the From packet # and To 
packet # fields and click Print. 

Step 3 To print an entire file, leave the From and To fields empty and click Print.

The specified traffic information is printed as currently displayed, in color or gray scale as 
supported by your printer. Any CATC Trace File comments you entered are printed 
following the current document name at the top of each page. 

Note: CATC Trace File comments can be created by using Edit Comment on the File 
menu.
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5.15 Analyzer Chat Window
PETracer has a Chat window that allows you to communicate with users on remote host 
machines. For Chat to work, two conditions must be met:

1. The host machine must have PETracer software installed and running.

2. The host machines must be listed in each other's Network Browse list. This means that 
your host machine must have the remote host machine listed in its Network Browse 
window and the remote host machine must have your host machine listed in its Network 
Browse window. 

If the above conditions are met, a Chat session is initiated by running the command: 
View > Analyzer Network Chat Bar. The following dialog opens.

Enter some text, then press Send. The message is then broadcast to all host machines 
listed in your network browse window. If a target host machine also lists your host 
machine in its Network Browse window, then it can receive your message. When the 
message arrives, the Chat window automatically opens.
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Chapter 6:  Reading CATC Traces

6.1 Viewing PCI Express CATC Traces
PETracer™ displays traffic as labeled, color-coded, and time-stamped rows. 

Tool tips provide details about fields within the CATC Trace. Hold the mouse cursor over 
a field to see a tool tip. 

Additional information is available from pop-up menus. For example, if you click the left 
mouse button on the first cell in a packet a menu appears with an option to view 
Raw 10b Codes.

6.2 Expand and Collapse Data Fields
Packet data fields are displayed in a short format by default. 

You can view a data field’s long format by performing one of the following three actions:

• Click the small triangle in the left corner.

• Double-click anywhere in the data field.

• Click once in the Data Field with the left mouse button, then choose 
Expand Data from the pop-up menu. 

A repeat of any above methods causes the display to return to a Short Data format.

6.3 Resizing Cells
Data cells can be resized by pointing the mouse pointer on the edge of a data cell, 
depressing and holding the left mouse button, and then repositioning the mouse pointer 
while keeping the mouse button depressed.
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6.4 Pop-up Menus
The Analyzer software makes extensive use of pop-up menus. In some instances, 
pop-up menus provide the only means of accessing dialog boxes that contain detailed 
information about cells within the CATC Trace, for example, the Show Configuration 
Space dialog box. 

To see a pop-up menu, left-click or right-click a cell within the CATC Trace. Right-click or 
left-click behavior depends on the Display Options setting. For default left-click, the 
right-click menu is not cell-dependent. For other left-click behavior, the type of menu that 
opens varies depending on the type of cell that is selected. Take some time to explore 
CATC Traces and the various pop-up menus.

6.5 View Data Block
To view the raw bits that make up the data in a data field, left-click a data field, then click


 or select View Data Block from the pop-up menu to display the Data Block window.

You can display data in Hexidecimal, ASCII, Decimal, or Binary formats.

Bit Order is Most Significant Bit or Least Significant Bit.

You can display data in Big Endian or Little Endian.

Format lets you display data as BYTEs, WORDs, or DWORDs.

Columns lets you select the number of columns.

You can enter hexidecimal offset values.

You can go to or search Previous or Next.



Summit User Manual Chapter 6: Reading CATC Traces

Teledyne LeCroy  75

6.6 Show Raw 10b Codes
You can view the raw bits that make up the data field by left-clicking the field and selecting 
View Data Block from the pop-up menu.

To view Raw 10b Codes:

Step 1 Left-click the first cell in a packet.

Step 2 Select Show Raw 10b Codes from the pop-up menu to display the 
Raw 10b Codes window. 

Step 3 To change the format of the data, use the options along the right side of 
the dialog. 

Step 4 To navigate the CATC Trace, use the Prev and Next buttons.

6.7 Show Header Fields
You can view details about header fields by opening the Show Header Fields dialog box.
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Step 1 Click a header. A pop-up menu appears.

Step 2 Select Show Header Fields. The following dialog box opens.

Step 3 Use the Prev and Next buttons to navigate to other headers.
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6.8 Packet Cell Popup Menus
The Packet cell has a left-click pop-up menu that includes the Show Raw 10b Codes 
command: 

Set Start Quick Timing Marker

Sets the start packet for the Quick Timing marker. An S symbol is displayed at the packet. 

Quick Timing provides immediate time deltas and bandwidth calculations. If the Start is 
placed on a packet that contains an Address and Endpoint, the bandwidth for that 
combination is displayed in the Status Bar below the trace data.

Quick Timing Markers are special ""Start"" and ""End"" markers used to mark the 
boundaries of the calculations. The results are shown in a special Quick Timing Bar at 
the bottom of the TraceView. The markers are set from a context sensitive menu.

Set End Quick Timing Marker

Sets the end packet for the Quick Timing marker. An E symbol is displayed at the packet.

 .

Delete All Quick Timing Marker

Deletes all Quick Timing markers.
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The right-click pop-up menu from Packet cell is: 

Packet Header R-> Cell Popup Menu
The Packet Header R-> cell has a pop-up menu with the Swap Upstream/Downstream 
command, which changes the directionality of the packets in the CATC Trace.

Packet Header G1 Cell Popup Menu
The Packet Header G1 cell has a pop-up menu with the Show Header Fields command 
(see “Show Header Fields” on page 75), which exposes a detailed view of the selected 
Header field.
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6.9 Set Marker
A marker is a unique label for a packet that allows you to go to that packet and also serves 
as a comment string for a specific packet. When you select a marker, the identified 
packet appears at the top of the screen. Packets that have been marked have a red bar 
on the left edge.

To set a marker, perform the following steps:

Step 1 Right-click the Packet field of the packet you want to mark (see figure on 
next page) or hover over the packet and click Ctrl+K, or select the packet 
and click Ctrl+L.

Step 2 Click Set Marker.

Step 3 When the Create Marker for Packet # pop-up appears, enter a unique 
identifier for the packet in the Comment field (see figure on next page). 
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Later, you can go directly to this packet using the Go To Marker operation in the Search 
Menu. 
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6.10 Edit or Clear Marker
To change a markers identifier, or clear (delete) the marker:

Step 1 Right-click the Packet field of the desired packet to display a pop-up 
menu: 

Step 2 Choose Edit Marker and enter a new identifier into the 
Edit Marker for Packer # pop-up, or 
Choose Clear Marker. When you choose Clear Marker, the marker is 
removed and the red line disappears.
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6.11 Compressed CATC Trace View
The Compressed CATC Trace view shows fields in the format “Attribute: Value”, whereas 
the normal CATC View shows the attribute name on top and the value below.

The Compressed CATC Trace view has almost all the information of the normal CATC 
View and behaves mostly the same way, while displaying more information on each 
window (see Figure 6.6 on page 114).

To compress the CATC Trace:

• Click  on the toolbar.

Click  on the toolbar to return to the normal CATC Trace View, or
Select View > Trace Views > CATC Trace. 

6.12 Spreadsheet View
You can view the CATC Trace as a spreadsheet in color or black and white.

Click   on the toolbar to display the Spreadsheet View (see figure on next 
page).
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Click  on the toolbar to display the Spreadsheet View B/W.

Columns
To add a column, right-click a column header, select Add Column, and then select the 
column name. 

To delete a column, right-click a column header and then select Remove Column.

To reposition a column, drag the column header to the new position.

To resize columns, select the column divider and drag the divider to the right or left.

Each of the SSD options (NVMe, AHCI, ATA) can be viewed and has its own 
customizable column configuration. The figure below shows the NVMe transaction 
level. See figure on the following page



Chapter 6: Reading CATC Traces Summit User Manual

84 Teledyne LeCroy

Restore Factory Default Settings
You can use one of the following three methods to restore the columns to the factory 
default settings:

• Right-click the column header and select Restore default columns to 
display a confirmation dialog. Click Yes to restore for selected transaction 
level.

• Right-click in the empty space and select Restore views to default 
positions to display a confirmation dialog. Click Yes to restore for specific 
transaction level.
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• Select Setup > Display Options to display the Display Options dialog. Click 
Restore Factory Settings.

6.12.1 Detail View and Spreadsheet View

In the Spreadsheet View, double‐click a packet, transaction, or 
transfer, or 

select a field and then click   on the toolbar, to display the Detail 
View (see figure on next page).

To put a Detail View header as a column in the Spreadsheet View, 
drag the header to a column divider in the Spreadsheet View. 
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6.13 Decoding Traffic
The PETracer software has three decode levels: 

Packet
Packet level decode  includes all TLP packets, DLLP packets, and all ordered sets.

Link
Link level decode  is composed of TLP packets matched with a corresponding ACK 
or NAK coming from the opposite direction.
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Split
Split level decode  is composed of two Link transactions, the Request TLP and the 
Completion TLP from the other direction.

NVM

NVM level decode  displays NVMe transactions. PETracer decodes the storage 
commands starting from lower Transaction Layer decodes. In the case of NVMe, it will 
decode first the Packet Level, then the Link Transaction level, then the Split Transaction 
Level and finally the NVME decode level.
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PQI

PQI level decode  displays PQI transactions. PETracer decodes the storage 
commands starting from lower Transaction Layer decodes. In the case of PQI, it will 
decode first the Packet Level, then the Link Transaction level, then the Split Transaction 
Level and finally the PQI decode level.

AHCI

AHCI level decode  displays AHCI transactions. PETracer decodes the storage 
commands starting from lower Transaction Layer decodes. In the case of AHCI, it will 
decode first the Packet Level, then the Link Transaction level, then the Split Transaction 
Level and finally the AHCI decode level.

Note:  The trace must contain the device enumeration sequence so the decoding 
picks up the associated base addresses and AHCI transactions can be 
properly decoded. If the enumeration sequence is not available the base 
addresses must be manually entered in the PCIe SSD Configuration dialog 
from the Tools menu.

ATA

ATA level decode  displays ATA transactions. PETracer decodes the storage 
commands starting from lower Transaction Layer decodes. In the case of ATA, it will 
decode first the Packet Level, then the Link Transaction level, then the Split Transaction 
Level, then AHCI level and finally the ATA decode level.

Note:  The trace must contain the device enumeration sequence so the 
decoding picks up the associated base addresses and ATA transactions 
can be properly decoded. If the enumeration sequence is not available 
the base addresses must be manually entered in the PCIe SSD 
Configuration dialog from the Tools menu.
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Chapter 7:  Searching CATC Traces
This chapter describes how to search for CATC Trace events.

7.1 CATC Trace Search Overview
Several search commands let you navigate a CATC Trace view to search for key events, 
such as errors and triggers. 

To view the search options, click Search in the Menu bar. 

7.2 Go to Trigger
To position a trigger packet at the top of the screen:

• Select Search > Go to Trigger.

7.3 Go to Segment/Packet
To position a packet at the top of the screen:

Step 1 Select Go to Segment/Packet from the Search menu. A pop-up menu 
prompts you for the packet number, marker, or time.

Step 2 Enter the packet number, marker, or time.

Step 3 Click OK.
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7.4 Go to Packet
To position a transaction at the top of the screen:

Step 1 Select Go to Packet from the Search menu. A pop-up menu prompts 
you for the packet number, marker, or time. 

Step 2 Choose the needed transaction level from the Packet drop-down list and 
enter the transaction number. Please note that transaction levels is 
added to list if corresponding level is decoded for current trace file.

Step 3 Click OK. 

7.5 Go to Time
To position a specific time at the top of the screen:

Step 1 Select Go to Time from the Search menu. A pop-up menu prompts you 
for the time in Seconds or Clocks.

Step 2 Enter the time and format (seconds or clocks).

Step 3 Click Go.

7.6 Go to Marker

Use this operation to go directly to a specific packet that has 
been marked with a unique marker by the Set Marker 
operation. 

To go to a marker: 

1. Select Go To Marker from the Search Menu.

2. Select the marker you want from the fly‐out menu.
Alternatively, select All Markers to display the All 
Markers window, then select a marker and click Goto.



Summit User Manual Chapter 7: Searching CATC Traces

Teledyne LeCroy  91

The packet you want appears at the top of the screen. 
Marked packets have a red bar on the left edge.

Markers

This section explains the features of Markers. A marker is an 
entity that flags a physical or logical item of interest within a 
trace file. A marker contains one or more attachments. You 
can add a marker to a trace file or unmark a trace file by 
removing the marker.

Markers are represented graphically in a different way in the 
application.You can not only add markers to the packets but it 
is granular enabling you to also add markers to individual 
cells.

Markers Overview

This functionality provides the user an easy way to navigate 
through attachments which is a discrete piece of information 
or data added to a marker, for example, a text description or 
file, an attachment of a trace file by a predefined order, video 
or audio files, URL links or any other files. 
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Functionality of Markers

The markers functionality allows you to add markers to: 

• Whole packets or frames

• Specific Cells 

• Specific values within a cell: Bytes, words, etc.

You can add attachments to markers.

Right‐click on any cell of a packet and select Set Marker from 
the menu as shown below.

select an option. 

The Create Marker dialog displays (see Figure  on page 93).
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Create Marker for Packet Dialog

As shown above you can:

Add icon. Click on this 
icon to add any file. See 
“Adding an Attachment” 
on page 94.

Export icon. Click on this icon to 
export an attachment.

Record icon. Click on this 
icon to record audio. See 
“Recording an Audio 
File” on page 95.

Delete icon. Click on this icon to 
delete an attachment

New URL icon. Click on 
this icon to add any URL.
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Attaching Markers

You can attach a discrete piece of information/data to a 
marker, for example, a text description or file, an attachment 
of a trace file by a predefined order, video or audio files, URL 
links or any other files. You can also remove an attachment 
from a Marker.

Adding an Attachment

Perform the following steps to add an attachment to a 
marker:

1. Right‐click on any cell in the trace and select Set 
Marker.

The Create Marker window displays.

2. Click on the Add icon.

The Add File to the Marker dialog displays.

3. Go to the file and select it to add it to the marker as an 
attachment.

4. Click Open.

The file will appear in the Create Marker for Transfer... 
dialog as shown below. The Marker # appears in the top 
panel, the icons are displayed in the second panel and 
you can click on the icon on the third panel to view the 
file you are about to attach.

5. Click OK to add the attachments.
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Create Marker for Transfer Dialog

Recording an Audio File 

The audio quality supports voice attachment and is not 
designed for high‐quality audio Playback of audio content is 
not limited and depends on the formats supported by the 
installed playback engine.

Click the record icon and speak into the microphone to 
record an audio file.

Note: This functionality is disabled if a microphone is not installed.

Video Files supported

The user can attach video clips to the trace file (“add to the 
marker”). The playback of the Video clips is limited to the 
formats that are supported by the video codecs installed in 
the system. 
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Attachment Types and Visualization

The markers are represented graphically by a yellow triangle 
at the top right of the marked item and a red vertical bar at 
the left‐most cell of a packet as shown below. 

A marker may comprise any number of attachments of any 
types.

Embedded Attachments to a Marker

Embedded files are attached to the item marked and 
transported with the trace. You can embed the following 
types of files to a marker:

• Audio Files

• Video Files

• Image Files

• YouTube Files

• Web Pages

• Text Attachments

• Other Attachments

Attachments are embedded in the marker and saved in the 
trace file. Once attachments are placed in a marker, the 
marker can then be presented to a user in a story 
structured form. On opening the marker the window 
resembles the marker editing dialog.

Note: The use of Audio and Video markers is limited to the file types 
supported on a user’s system. CATC Walk has been tested with 
.mp3 and .wmv files, which are supported by Windows as 
installed. If additional codecs are installed, they should also work, 
but it is the user’s responsibility to choose formats that will work 
for whomever they intend to exchange CATC trace files (no 
different than email attachments in this regard). Because of this 
dependency on installed codecs, there are situations where bugs 
in the codecs supplied by Microsoft or third‐party applications can 
prevent proper operation of the Teledyne LeCroy PETracer 
application. See the Teledyne LeCroy PETracer Application 

Marked Cell
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Read‐Me file for more information if you have problems with 
application crashes, etc.

Viewing Attachments of a Marker

If you hover over the marked cell (yellow triangle at the top 
right of the marked item), refer to “Attachment Types and 
Visualization” on page 96, a window pops up displaying the 
contents of the marked cell as shown below. 

To view an attachment you can click on any of the icons in the 
attachment bar and or you can double‐click on the icon itself 
to open the attachment.

Pop-up Displaying Marker Contents

Text

The text attachment is displayed in the icon bar and in the 
main pop‐up window. Text attachments are always shown at 
the top. The attachment file name is displayed in the field as 
shown below.
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Text Attachment Pop-up Window

If there is no attachment, No Attachments displays in the 
status bar at the bottom.

No Attachments Pop-up Window

If there are attachments, the status bar is hidden. You can 
move the cursor to an attachment icon in the list view and a 
preview of the attachment starts.

Preview Attachments Pop-up Window



Summit User Manual Chapter 7: Searching CATC Traces

Teledyne LeCroy  99

Audio

Audio snippets that are recorded and attached to certain 
point of interest in a trace can be played. The basic Play, Start, 
Stop, Pause buttons are displayed to listen to the audio file.

Video

Video clips that are recorded and attached to certain point of 
interest in a trace can be played. The video is embedded in 
the tooltip with simple playback controls.

File Attachment

You can attach any kind of file, including images, PDFs, 
documents, media files, etc. 



Chapter 7: Searching CATC Traces Summit User Manual

100 Teledyne LeCroy

URL Link

You can specify a URL that links to a web page (i.e., YouTube), 
a network location, or a local file‐system location.

Web Link

Due to the small size, the web page is not embedded in the 
callout. You can use the Open button to open the web link in 
the default web browser.

YouTube Video

YouTube’s video player is embedded for YouTube Video 
playback.
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Images

The image is embedded in the trace.

Other Attachments

Click the Open button to open the attachment file with the 
system’s default application for that file type. 

Edit Marker

To edit a marker, right‐click on the marked item and select 
Edit marker from the menu. The Edit Marker dialog displays. 
This Edit Marker window can be used to edit one marker at a 
time.

You can do the following in the Edit Marker dialog:

• Edit text attachment.

• Record audio attachment.

• Add URL link attachment
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• Add a file attachment. Click on File and click the Open button 
or drag and drop the file.

• Preview audio/video/image/URL/YouTube attachment or open 
other files with system default application.

• Save an attachment to a file. 

• Remove attachment.

EDIT Marker for Packet Dialog

All Markers Window

Select Search > Go to Marker > All Markers or press Ctrl + M 
to display a list of all the markers in the file. The window uses 
a tree structure to show packets, fields and markers. The 
features of the Markers window are:

• All Markers are displayed

• All attachments within the marker are displayed

• You can collapse or expand the item marked to view the 
attachments

• The Time and size of audio and video files are displayed

• You can edit Playlists from this window
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• You can edit or remove a marker from this location

• You can filter attachments within the marker

Edit Marker Dialog
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You can filter to show or hide text, image, audio, video, URL, 
YouTube videos and other files.

Filter Dialog

7.7 CATC Walk Playlist
This feature allows users to configure sequences of 
attachments into playlists. Any arbitrary order of 
attachments are allowed, and there are no limits on the 
number of playlists supported. This feature can be used for 
collaborating among developers as well for training, support 
and marketing purposes.

To access a playlist click on the View menu in the top toolbar 
of application, select CATC Walk and then select Manage 
Playlists as shown below.
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Edit CATC Walk Playlists Dialog

Playlist Functionality

You can do the following to manage playlists:

• Remove or edit current playlists 

• Edit the playlist name

• Edit the playlist description

• List the sequence of attachments in current playlist

• List of all available attachments and drag/drop to a playlist.

As shown in the previous figure the Playlist window lists the 
markers with their attachments on the left and the playlist on 
the right.
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Edit CATC Walk Playlists Dialog

You can drag and drop and item or attachment from the 
Marker panel into the Playlist panel and build a story. Give a 
description of the playlist in the Description field and you can 
give a name to the playlist in the Name field.

You can add a new playlist by clicking on the green plus sign 

(+) on the right top corner of the Playlist panel, or delete a 
playlist by clicking the red (x) button.

If you have more than one playlist saved click on the Name 
drop‐down arrow to select it. The drop‐down menu lists all 
the available playlists
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Playback Window

To playback a playlist, click on the View menu in the top 
toolbar of application, select CATC Walk and then select Play 
> Playlist 1 as shown below.

View Dialog

The attachment item starts to play in the playback window as 
shown below.

Playback Window

The playback window is resizable. The close button at the top 
right corner and the size grip for resizing at the bottom right 
corner will hide automatically when moving the cursor out of 
the window.

Users can provide commentary to a captured trace, 
converting it into a script or a story and can transfer this 
meta‐information to others. Playlist Playback Controls.
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Playlist Playback Controls

The playlist playback control buttons are:

• Play/Pause

• Stop

• Jump to Next attachment

• Jump to Previous attachment 

• Seek slider for seeking to positions in media streams

• Volume slider

• Playback speed slider (for text attachments)

As a playlist is played back, the playback window is displayed 
in close proximity to the marked area, just like a regular 
tooltip window.

As the playback progresses, the view jumps to the element 
corresponding to the current attachment being played and 
the marked element is highlighted. During playback the user 
is prevented from interacting with the trace. To reinforce this 
restriction, the trace view is grayed‐out visually, and only the 
packet with the item corresponding to the current 
attachment is colorized.

Playback Window
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7.8 Go To Menu
The Go To menu in the Search menu provides a quick way to search for a packet based 
on a simple condition. You can search for the following types of events:

• TLP Type

• DLLP Type

• Ordered Set

• Link Event

• Traffic Class

• DLLP Virtual Channel

• TLP Virtual Channel

• Direction

• Speed

• Link Width

• Requester ID

• Completer ID

• Data Lengths

• Errors

7.9 Search Direction
Search direction can be toggled back and forth by using the command under the Search 
menu. Search Direction controls the direction of the search. Each time Search Direction 
is selected, the search order is reversed. For example, if the previous search was 
forward, choosing Search Direction toggles the current search to backward.

To verify the direction of a search look at the lower right corner of the screen. 
Search: Bwd or Search: Fwd should appear. If a direction is not indicated, it means that 
the status bar is turned off. 

To turn on the Status bar, select from the menu View > Status Bar. 

Keyboard shortcuts can also be used to control search direction: 

• Alt-f means Search Forward.

• Alt-b means Search Backward.

7.10 Find
Find allows you to conduct complex searches in a CATC Trace. You can search by 
protocol level (Packets, Link Transactions, Split Transactions).

You can search packets by Event Group: TLP Type, TLP Header, TLP Prefix, TLP 
Requester ID, TLP Completer ID, TLP Data Pattern, TLP Data Lengths, TLP Tag, TLP 
Sequence Number, DLLP Type, DLLP Header, DLLP Virtual Channel, ACK/NAK Seq 
Number, Ordered Sets, Link Event, OBFF Code, Direction, Errors, TS1 Data, TS2 Data. 
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You can search link transactions by Event Group: TLP Type, Traffic Class, 
Virtual Channel, Direction, Requester ID, Completer ID, Status, Tag. 

You can search split transactions by Event Group: TLP Type, Traffic Class, 
Virtual Channel, Direction, Requester ID, Completer ID, Status, Tag. 

You can seach NVM transactions by the following Event Groups: Controller Registers, 
Queue IDs, Command IDs, Doorbell Registers, Admin Submission Command Set, NVM 
Submission Command Set, Completion Queue Entry, and PRP.

You can search PQI transactions by Event Group: TLP Type, Traffic Class, Virtual 
Channel, Direction, Requester ID, Completer ID, Status, Tag, Address. 

You can search AHCI transactions by Event Group: AHCI Register ID, AHCI Port 
Number, AHCI Slot Number, AHCI Port Multiplier Port, AHCI Raw Address AHCI 
Direction and, AHCI Errors.

You can search ATA transactions by Event Group: ATA Register Type, ATA Port Number, 
ATA Slot Number, ATA Raw Address, ATA port Multiplier Port, ATA Interruption Reason, 
ATA Error Type ATA Input/Output, ATA Payload Portion, ATA CFIS Fields, ATA RFIS 
Device to Host Fields, ATA DSFIS Fields, ATA PSFIS Fields, ATA SDBFIS Fields.

The options Union, Intersection, and Exclusion allow you to create complex searches 
such as "Find x OR y" or "Exclude all x or y." To find a item:

Step 1 Open a CATC Trace.

Step 2 Open Find by selecting Search > Find from the menu or clicking  .

Step 3 From the Search For menu, select a display level such as Packets. 
To search multiple levels, finish steps 3 to 9, and then repeat 3 to 9 for 
each additional display level.
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Step 4 From the Event Groups menu, select an Event Group. The menu in the 
far right of the dialog box is context sensitive and changes to reflect the 
options for that group.

Step 5 In the menu in the far right, select one or more items.

Step 6 Repeat Step 5 for each Event Group of interest for the selected display 
level.

Step 7 Under Direction, select Forward or Backward to select a search 
direction.

Step 8 Under Origin, select a starting point for the search.

Step 9 Under Combining Specified Event Groups, select 

The options Union, Intersection, and Exclusion let you set conditions on your 
searches:

• Union: To search for any of the selected criteria. 
Example: "Find packets with ANY of the following characteristics …"

• Intersection: To search for all of the selected criteria. 
Example: "Find packets with ALL of the following characteristics …"

• Exclude: To exclude items from a search. This option works in conjunction 
with Union and Intersection. You select Union and Exclude to exclude any of 
the specified traffic. You select Intersection and Exclude to exclude all of the 
specified traffic. 
Example: "Exclude packets with ANY of the following …" or 
"Exclude packets with ALL of the following …" 

Step 10 Repeat Steps 3 through 9 for additional display levels.

Step 11 Find All displays all matching packets or transactions in a separate 
view.

Step 12 Search in Hidden includes hidden packets or transactions in the 
search.

Step 13 Click OK.
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Event Groups
The Event Groups for Packets are:

• TLP Type

• TLP Header

• TLP Prefix (Summit T2-16 only)

• TLP Requester ID

• TLP Completer ID

• TLP Data Pattern

• TLP Data Lengths

• TLP Traffic Class

• TLP Tag

• TLP Sequence Number

• DLLP Type

• DLLP Header

• DLLP Virtual Channel

• ACK/NAK Seq Number

• Ordered Sets

• Link Event

• Direction

• Errors

• TS1 Data (see ““TS1 and TS2 Event Groups” on page 113)

• TS2 Data (see ““TS1 and TS2 Event Groups” on page 113)

The Event Groups for Link Transactions, Split and PQI Transactions are:

• TLP Type

• Traffic Class

• Virtual Channel

• Direction

• RequesterID

• CompleterID

• Status

• Tag

The Event Groups for NVM transactions are: 

• Controller Registers

• Queue IDs

• Command IDs

• Doorbell Registers

• Admin Submission Command Set

• NVM Submission Command Set

• Completion Queue Entry

• PRP
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The Event Groups for AHCI Transactions are:

• AHCI Register ID

• AHCI Port Number

• AHCI Slot Number

• AHCI Port Multiplier Port

• AHCI Raw Address

• AHCI Direction

• AHCI Errors

The Event Groups for ATA transactions are: 

• ATA Register Type

• ATA Port Number

• ATA Slot Number

• ATA Raw Address

• ATA port Multiplier Port

• ATA Interruption Reason

• ATA Error Type ATA Input/Output

• ATA Payload Portion

• ATA CFIS Fields

• ATA RFIS Device to Host Fields

• ATA DSFIS Fields

• ATA PSFIS Fields

• ATA SDBFIS Fields.

TS1 and TS2 Event Groups

Selecting TS1 Data or TS2 Data options allows further definition of the exact field 
contents to match via the three dialogs show below. The search algorithm will find the 
specified TS ordered set on any lane. 



Chapter 7: Searching CATC Traces Summit User Manual

114 Teledyne LeCroy

Select parameters from the drop-down lists to use.

Select parameters from the links to use and enter the mask and match values.

7.11 Search for the Next Packet Type

Use Find Next or click  to search for the next packet meeting the search criteria. 
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Chapter 8:  Display Options

8.1 Setting Display Options
Display Options allow you to customize the colors and formats of displayed traffic. 

To open the Display Options dialog at the General tab, Select Setup > Display Options 
from the menu or

click the Display Options button  on the toolbar.
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8.2 Specifying General Display Options
The Display Options General tab allows you to specify:

Zoom Level: Defines the size of packet fields in the packet view. Zoom level is adjustable 
as 10, 20, 40, 60, 80, 100, 120, 140, 160, 180 and 200 percent.

Enable Tool tips: Allows information to be displayed on a packet by resting your mouse 
pointer over it.

Wrap: Allows packets, Link Transactions, and Split Transactions to wrap within the 
display.

Right click cell context menu: Swaps mouse functions.

Hierarchy Lines: Adds lines to the trace view indicating relations between packets, 
Link Transactions, and Split Transactions.

Timestamp position: Moves timestamp location from end of packet to beginning of 
packet, or merges it with the packet number.

Protocol Level to View: Allows the CATC Trace to be displayed in different hierarchical 
levels: Packets, Link Transactions, Split Transactions, NVM Transactions, PQI, AHCI and 
ATA command transactions.

Time Stamp: Gives you options for setting the timestamp to zero for either the first 
CATC Trace packet or the trigger packet or for leaving the stamp unchanged as it was 
originally recorded.

Trace View Mode: Displays Normal CATC Trace View, Compressed CATC View, 
Spreadsheet View (Color), and Spreadsheet View (B/W).

Fonts
Fonts: Allows the appearance of field text and/or data text to be defined.

Configuration Name
Display Configuration Name: This field is used to enter a text string to be associated 
with the current set of Display Options. This name is saved with the Display Options file, 
and appears as part of the title of the packet view window that uses this set of Display 
Options.
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8.3 Color, Format, and Hiding Options
The Color/Format/Hiding tab allows you to customize the colors and formats associated 
with each field in the CATC Trace and to selectively hide fields or packets. You access 
these display options by selecting Setup > Display Options > Color/Format/Hiding 
tab. 

The Color/Format/Hiding property page lets you set how fields display in a CATC Trace. 
This property page lets you set field color and data format (binary, hex, decimal, ASCII), 
and lets you hide selected fields from the display.

Setting Field Colors
The Field Colors tab allows you to customize the colors associated with each field used 
in the packet view. 

You may experiment with this option to achieve a color combination that suits you. 

Select or change the trigger color using the color buttons labeled - Packet # and 
+ Packet # (before and after trigger) found under the Packet# section of the Field Colors 
window. 

You select or change a color by clicking the appropriate color button. This action causes 
a color palette to pop up. Select the desired color and press OK.

Step 1 Click View > Set Display Options to open the Display Options dialog 
box.

Step 2 Select the Color/Format/Hiding property page.
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Step 3 Under the Group and Colors column, click the plus symbol (+) next to 
the group you want to reformat. The group expands to show the 
individual fields within the group. Each field has a color, as shown below:

Step 4 Click the colored cell that you want to change. A color palette appears.

Step 5 Click a color in the palette, then click Apply or OK. 

Note: The colors of the following Frame types cannot be changed: 

• Invalid Data (frame error) field (red)

• Softbit Errors (yellow)

You can also change color by left-clicking a field in the CATC Trace and selecting Color 
from the pop-up menu.
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Changing Field Formats
The Field Formats tab allows you to define the way various numeric fields are shown in 
the packet display. You can select Hexadecimal, Decimal, Binary, or ASCII for certain 
fields or groups of fields. 

To change a field's format, click the plus sign (+) next to a field in the list. This causes the 
selected item to expand so you can see its constituent sub-fields. Select a sub-field, and 
then choose the format from the formatting choices that appear at the bottom of the 
window. 

To change the format of alphanumeric characters in a field: 

Step 1 Under the Group and Colors column, click the plus symbol (+) next to 
the group you want to reformat. The group expands to show the 
individual fields within the group (as shown above).

Step 2 Click the row representing the field that you want to reformat. If the field 
can be reformatted, the format options at the top of the dialog box 
become active, as shown below:

Step 3 Select a format.

Step 4 Specify the bit order in the displayed fields by checking/unchecking the 
MSB > LSB checkboxes.

Step 5 Click Apply or OK. 
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Hiding Fields
To hide a field:

Step 1 Under the Group and Colors column, click the plus symbol (+) next to 
the group that has the field(s) you want to hide. The group expands to 
show the individual fields within the group (as shown above).

Step 2 Click the checkbox in the row representing the field that you want to 
hide.

Step 3 Click Apply or OK.

Hiding Levels
The Level Hiding page lets you hide traffic by Event Group. If you select one or more 
event types from the Event Group list, the selected types are hidden from the 
CATC Trace.

To hide a level:

Step 1 Select an Event Group.

Step 2 Select whether to Hide or Show selected items.

Step 3 Select Upstream, Downstream, or Any Direction.

Step 4 (optional) Select Compact EIEOS packets.

Step 5 Click OK.
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The Event Groups for Packets are:

• TLP Type

• TLP Header

• TLP Requester ID

• TLP Completer ID

• TLP Data Pattern

• TLP Data Lengths

• TLP Traffic Class

• TLP Tag

• TLP Sequence Number

• DLLP Type

• DLLP Header

• DLLP Virtual Channel

• ACK/NAK Seq Number

• Ordered Sets

• Link Event

• Direction

• Errors

The Event Groups for Link Transactions and Split Transactions are:

• TLP Type

• Traffic Class

• Virtual Channel

• Direction

• RequesterID

• CompleterID

• Status

• Tag

The Event Groups for AHCI Transactions are:

• AHCI Register ID

• AHCI Port Number

• AHCI Slot Number

• AHCI Port Multiplier Port

• AHCI Raw Address

• AHCI Direction

• AHCI Errors
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8.4 Load a Previously Saved Display Options File
If you have previously saved Display Options, you can load them by opening the Display 
Options dialog and clicking the Load button. A dialog box opens to let you load a 
previously saved display options file.

Step 1 Click Load to use a previously defined display options file.

Step 2 When you see the Open File pop-up window, enter the name of the file 
you want to load and click Open. 

Step 3 When the PETracer™ software returns you to the Recording Options 
menu, click OK to activate the display options you selected.

8.5 Saving Display Options
If you have customized the Display Options and wish to save them, you can do so by 
clicking the Save button, then entering a unique file name. The .opt extension is added 
by default.

Setting the Defaults: Save the currently specified Display Options to the file name: 
default.opt by clicking Save As Default. When the Analyzer software begins execution, 
it automatically loads the default.opt file, if one exists.
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Chapter 9:  Recording Options

9.1 Setting Recording Options
The Recording Options dialog is used to configure a recording. 

To open the Recording Options window, click  or select the command 
Setup > Recording Options.

Note:  There are separate sets of Recording Options for each Analyzer type. To set 
the Analyzer type, select the appropriate platform from the Target Analyzer 
menu in the General page of the Recording Options. 

9.2 General Tab
The General Page presents options that affect all recordings:

Figure 1: PETracer Summit or Summit T2-16 in Simple Mode:
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PETracer Summit or Summit T2-16 in Advanced Mode:

Recording Type: Sets the trigger mechanism for the recording: Snapshot, Manual 
Trigger, Event Trigger, or Bit Tracer Recording (PETracer Summit and Summit T2-16 
only).
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Target Analyzer: Presents a menu with options for selecting an Analyzer platform:

• Eclipse X34

• Summit T3-16

• Summit T3-8 (2 units)

• Summit T3-8

• Summit T34

• Summit (T2-16)

• Summit T28

• Summit T24

Buffer Size: Causes the Analyzer to record traffic to its buffer and then upload the 
CATC Trace to the host machine. Recordings are limited in size to the size of the 
Analyzer's buffer (4 GB per directory).

Trigger Position: Controls the percentage of buffer allocated for pre- and post-buffer 
recording.

Trigger On (Simple Mode): Error, Link Up/Link Down. TS1, TS2, FTS, Any TLP, Config 
Rd, Config Wr, IO Rd, IO Wr, Mem Rd, Mem Wr, Message, Completion, InitFC1, InitFC2, 
ACK, NAK, and/or PM.

Trigger On (Bit Tracer Recording in PETracer Summit or Summit T2-16): Allows you 
to select the Upstream and Downstream Symbol on which to trigger from a drop-down 
list of bits or by typing a symbol code into the window. Note: Leaving a window blank 
results in no trigger in that direction.

Filter Out (Simple Mode): SKIP Ordered Sets and/or UpdateFC DLLP are provided.

Trace Filename & Path: Sets the path and CATC Trace name for the recording.

Options Name: Sets a descriptive label for the Recording Options so you can more 
easily recall what settings are in the Recording Options file. 

Link: Settings: For link width, inhibiting recording, polarity, external reference clock, 
swapping recording channels, inverting link polarity, and descrambling. 

Upload Size (Advanced Mode): Causes the Analyzer to upload a portion of the 
Analyzer's buffer. This option lets you look at part of the CATC Trace. Half of the uploaded 
CATC Trace is pre-buffer and half post-trigger.

The PETracer application forces this option when the user selects a large buffer size for 
recording. This is done to limit the size of individual trace files to a level that the PETracer 
application can efficiently work with. The maximum size of the recording buffer that can 
still be used for single trace recordings depends on other options selected, like link width.

Misc (Advanced Mode): Turns on trigger beep, sets external clocking (EML only), allows 
external interface signals to be saved into the CATC Trace, and tells the Analyzer to use 
whatever TC to VC mapping was used in the last recording (to re-use previously 
discovered Configuration Space data) in all future recordings. Also presents a button for 
manually mapping the Traffic Classes to Virtual Channels.
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Recording Type
Recording Type lets you to specify the type of recording you want to make:

• Snapshot: A recording of a pre-determined length. You set the recording length in 
the Buffer Size box. Recording begins when you click the Rec button on the toolbar 
and ends when the selected buffer size is filled or when you press the Stop button.

• Manual Trigger: A recording that switches between the pre-trigger buffer and the 
post-trigger buffer when you push the Trigger button on the front of the Analyzer. 
Recording begins when you select Start in the application. Pressing the Trigger 
button causes the Analyzer to begin to finish recording. Recording continues until 
the post-trigger buffer has been filled. You can also end the recording by pressing 
the Stop button in the application.

• Event Trigger: A recording that switches between the pre-trigger buffer and the 
post-trigger buffer when it is triggered by an event in the CATC Trace. An Event 
Trigger begins when you select Start in the application and ends when the specified 
triggering event occurs in the CATC Trace or you press Stop. If an event triggers the 
end of the recording, the Analyzer records a predefined amount of post-trigger data 
(specified by Trigger Position and Buffer Size.)

Note: You can also terminate an Event Trigger recording by pressing the Manual 
Trigger button on the front of the Analyzer. When the Manual Trigger button is 
pressed, the Analyzer continues to record until the specified post-trigger buffer has 
been filled.

• Bit Tracer Recording (PETracer Summit and Summit T2-16 only): Allows you to 
trigger on an Upstream or Downstream Symbol. Note: This option does not have 
Simple Mode and Advanced Mode. Therefore, Upload Size, the Miscellaneous 
options, Auto-Configure Lane Polarity, Auto Speed, and Auto Link are not available. 
Note: For more information, see the 
next chapter, “BitTracer Recording” on page 157.

Buffer Size
The Buffer Size slide-bar allows you to set the size of the recording buffer. 

Note:  Size selection is per direction. For example, selecting 32 MB creates two 
memory areas of that size.

After you have set the Buffer Size, you must set the Recording type and Trigger position 
options. These options determine how the buffer is used.

Note:  The Buffer Size slide-bar does not precisely portray the buffer size because 
of the way the packets are stored in the Analyzer’s memory.
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Target Analyzer
Target Analyzer presents a menu with these choices: 

• Eclipse X34: Displays the options for the Eclipse X34 Analyzer.

• Summit T3-16: Displays the options for the Summit T3-16 Analyzer.

• Summit T3-8 (2 units): Displays the same options as the Summit T3-8 
Analyzer but lists Unit 1 and Unit 2 in the Link Section on the right. In a 
two-unit setup, Unit 1 and Unit 2 are two separate Analyzers linked together 
by BNC on the back of the units to form a single, logical Analyzer.

• Summit T3-8: Displays the options for the Summit T3-8 Analyzer.

• Summit T34: Displays the options for the Summit T34 Analyzer.

• Summit (T2-16): Displays the options for the Summit T2-16 Analyzer. 

• Summit T28: Displays the options for the Summit T28 Analyzer.

• Summit T24: Displays the options for the Summit T24 Analyzer.

Selecting an Analyzer platform changes the options presented in the Link and Events 
pages within the Recording Options dialog.

Trigger Position
This Trigger Position slide-bar lets you to adjust the amount of recording buffer allocated 
to recording pre-trigger and post-trigger traffic. 

For example, if you set the Trigger Position to 90% Post-Triggering Traffic, the Analyzer 
records 10% pre-trigger traffic and 90% post-trigger traffic. 

Trigger Position is only available when Manual Trigger or Event Trigger is selected.

Trigger On
For Bit Tracer Recording in PETracer Summit or Summit T2-16, the Trigger On section 
allows you to select the Upstream and Downstream Symbol on which to trigger from a 
drop-down list of bits. 

In Simple Mode (see Figure 1), Trigger On allows you to select: Error, Link Up/Link Down. 
TS1, TS2, FTS, Any TLP, Config Rd, Config Wr, IO Rd, IO Wr, Mem Rd, Mem Wr, 
Message, Completion, InitFC1, InitFC2, ACK, NAK, and/or PM.
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Trace Filename and Path
The Trace Filename and Path button on the Recording Options General panel allows you 
to change the default file name and path for the recorded CATC Trace file. The 
pre-defined name is data.pem.

Step 1 Select the Recording File Name button.

Step 2 When you see the Save As menu, navigate to the directory you want.

Step 3 Enter the new file name in the File name field.

Step 4 Click the Save button.

This action does not do any immediate save operation. It just changes the default name 
and uses it in subsequent recordings.

Options Name
The Options Name is a descriptive, supplemental label that you can assign to a 
Recording Options file. 

For example, if your Recording Options file were named StandardSettings.rec, your 
Options Name could be a long descriptive label such as Standard Record Options used 
for all normal Recordings.

Viewing Legacy Multisegmented CATC Traces
Current PETracer software handles traces as large as the maximum buffer size selected. 
It does not need to generate segmented traces but is able to open segmented traces 
generated with older software versions. Simply open the *.pem extension file and the 
trace will be converted to a new format single trace. If you are opening a *.pex file part of 
a segmented trace make sure not to update the file, in order for the original segmented 
index to work properly.

Misc
Allows you to specify the following parameters for recording and uploading traffic:

• Beep When Trigger Occurs: Causes the Analyzer to beep when a trigger event is 
detected.

• Save External Interface Signals: If selected, causes the Analyzer to save signals 
from a Breakout Board as fields in the CATC Trace.

• Preserve TC to VC mapping across the channels: Causes the Analyzer to use 
whatever TC to VC mapping it established in the last recording. 
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• Default TC to VC mapping button: Lets users manually configure the default 
mapping.

Link for Summit and Summit T2-16
The Link section allows you to manage links:

PETracer Summit and Summit T2-16
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PETracer Summit or Summit T2-16 Bit Tracer Recording

Note: For more information, see BitTracer Recording “Link Configuration” on page 169.

Link Width: Sets the physical width of the link. (The Auto option is not available for 
Bit Tracer Recording.)

Upstream and Downstream: Gives you low-level control over each link direction. The 
heading for these boxes indicates the port and/or unit to which the following options are 
applied based on the current Analyzer configuration:

• Inhibit Channel: See above.

• Reverse Lanes: See above.

• Invert Polarity: See above.

Use External Reference Clock: If the PCI Express link under analysis uses 
spread-spectrum clocking, then the Analyzer must use the external reference clock from 
the host machine. If the host machine does not supply a reference clock, the internal 
reference clock in the Analyzer module is used instead for link analysis
(Not available for Bit Tracer Recording.) Only the standard PCIe reference clock is 
supported.
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Disable Descrambling: If checked, causes the Analyzer to assume that none of the 
PCI Express traffic is scrambled. By default, the Analyzer determines the scrambling 
state of the devices under test.

Auto-Configure Lane Polarity: Lets the Analyzer determine lane polarity. 
(Not available for Bit Tracer Recording)

Base Spec 1.0 Rev Compatibility Mode (Advanced Mode): This option causes the 
Analyzer to conform to the PCI Express 1.0 Specification. 

Speed: Speed can be Auto, 5.0 GT/s, or 2.5 GT/s for the Snapshot, Manual Trigger, and 
Event Trigger recording types, and 5.0 GT/s or 2.5 GT/s for the Bit Tracer Recording 
recording type.

Saving and Loading Previously Saved Recording Options
The options are:

Save: Saves the current options to whatever file name you provide.

Save As Default: Saves the current options into the default options file. This file is called 
default.rec or whatever other name you have assigned to the default options file. 
Whenever the Teledyne LeCroy PETracer software begins execution, it automatically 
loads the default file, if one exists.

Load: Loads a previously saved set of recording options.

OK: Applies changes and closes the Recording Options dialog box.

Cancel: Cancels changes and closes the Recording Options dialog box.

Loading Recording Options
In the Recording Options menu, you can load a previously saved recording options file.

To load Recording Options:

Step 1 Select Setup > Recording Options from the menu.

Step 2 Click the Load button from the Recording Options dialog box. The Load 
dialog opens and lists previously saved options files (*.rec). 

Step 3 Select a file and click OK. The options file loads.

Saving Recording Options
Recording Options settings can be saved and later reused. Recording options settings 
are stored in *.rec files. 

Step 1 Open the Recording Options dialog by selecting 
Setup > Recording Options.

Step 2 Set your options, then click Save. 

Step 3 Enter a unique file name. The .rec extension is added by default.

Step 4 (optional) To add a descriptive label to this file to help you remember 
what options were set, use the Options Name box.
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Setting Default Recording Options
To save the current recording options into the default Recording Options file:

• Click Save As Default. 
The default file for the options is default.rec. 

When the PETracer software begins execution, it automatically loads the 
default.rec file, if one exists.
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9.3 Recording Rules Overview
The Recording Rules page lets you to set triggers and filters. 

The page divides into three areas: 

Toolbar: Contains buttons such as the New Events button for issuing commands. 

Available Events area: A part of the screen where you can park buttons that you intend 
to use in the Main display area.

Main display area: The part of the screen where you create trigger and filter conditions. 
You create conditions by dragging buttons onto the Main display area from the Available 
Events area. You then create additional conditions by right-clicking a button and selecting 
options from a pop-up menu. See Creating Recording Rules.
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Global State vs. Sequences
The Main Display area in the center of the Recording Rules page has two cells that affect 
events differently. 

Global State: Events dragged into the Global State cell are searched for throughout the 
recording. For example, if you place an Error in the Global State cell and assign a Trigger 
to it, the Analyzer searches for errors from the start of the recording until the end.

Sequence State: The cell marked Drag an event here to create a new sequence is a 
Sequence Cell. Sequence cells are used to event sequences, which are chains of events 
culminating in a trigger or other action. One sequence (i.e., a separate chains of events) 
can be created with up to 32 states. A state is an event condition plus some action within 
a sequence.
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9.4 Recording Rules Buttons
 The Recording Rules toolbar allows you to create and edit recording rules: 

9.5 Creating Recording Rules
The Recording Rules page is used to set triggers and filters. To access this page, select 
Setup > Recording Options > Recording Rules.

There are three steps to creating a recording rule: 

1) Select events.

2) Place the events in the Global State or Sequence cells.

3) Assign actions to the events.

Note:  There are limits to the types of rules that can be created. 

New Event. Opens a 
drop-down menu with a list of 
events.

Zoom in

Delete. Delete selected 
event.

Zoom out

Undo. Undoes last action. Show/Hide Channels. 
Shows/hides the channel 
buttons.

Redo. Undoes last Undo 
command.

Show properties. 
Opens the Properties dialog 
box for the selected item.
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Step 1 Click  and select one or more events from the menu. 
Selecting an event automatically places it in the Available Events area. 
This area serves as a parking lot where you can place event buttons 
without them having any effect on the Analyzer. 

Step 2 Drag the selected events from the Available Events area into one of 
either the Global State cell or the Sequence cell (see “Global State vs. 
Sequences” on page 134): 

Global State Cell: If you want the Analyzer to always search for the event, place 
it in the cell marked Global State.

Sequence Cell: To create an event sequence, place two or more events in the 
faintly marked cell that reads Drag an event here to create a sequence. At this 
point, the selected events have no effect because an action has not been 
assigned.

Step 3 To select a sub-set of your selected event, right-click it and choose 
Properties. A Properties dialog box opens that presents additional 
options. For example, if you open the Properties dialog for Errors, you 
can set the specific types of errors the Analyzer should look for. 
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Step 4 Assign an action to the selected events by right-clicking each of the 
events, selecting Specify Action from the pop-up menu, and assigning 
an action such as Trigger, Filter, or Count. Be sure to click the event 
itself and not the State cell that it is sitting in (which produces a different 
pop-up menu.)

Note:  You can also assign actions to events by double-clicking the event and 
selecting the Actions page when the Properties dialog box opens.

Step 5 Click OK to close the dialog box. At this point, assuming that the other 
options in the Recording Options dialog box have been set (such as the 
General page), you can begin the recording by pressing the 

Start Recording  button.
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9.6 Recording Rules Logic: How Contradictory Rules 
are Resolved

When creating rules in the Recording Rules page, it is possible to create contradictory 
instructions such Filter Anything Out and Filter Anything In. To resolve such conflicts, 
the Recording Rules page implements three internal rules that are described here:

• Rules created in Sequence cells have a higher priority than rules created in the 
Global State cell: If a rule is placed in a Sequence cell, and a contradictory rule is 
placed in Global State cell, the rule in the Sequence cell applies.

• Filter-In has a higher priority than Filter-Out, so when a Filter-In rule is placed inside 
the same state as Filter-Out rules, only the Filter-In rule applies.

• Filter-In Anything and Filter-Out Anything have the highest priority and override any 
other filtering rules, so when Filter-In Anything or Filter-Out Anything are placed in 
the same state cell as other Filter rules, only the Filter-In Anything or Filter-Out 
Anything rules apply.

Recording Rules Examples
Read through the following examples to better understand how the three rules apply.

Note:  In addition to these three rules, the Recording Rule Limitations define the 
upper limits of rule creation. These limitations should not affect you, but you 
should be aware of them. 

Example 1

Result: Only TLP:Mem,Read is in the CATC Trace.

Reason: The Sequence rule Filter out TLP:Completion is not contradicting the global 
state rule to filter in TLP:Memory. Both rules are applied.
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Example 2

Result: Only TLP:Completion is in the CATC Trace.

Reason: The sequence rule to filter in TLP:Completion is not contradicting the global 
state rule to filter out TLP:Memory. Both rules are applied.

Example 3

Result: TLP:Completion and TLP:Memory are filtered out.

Reason: The Sequence rule to filter out TLP:Completion is not contradicting the global 
state rule to filter out TLP:Memory. Both rules are applied.

Example 4

Result: Only TLP:Completion and TLP:Memory are in the CATC Trace.

Reason: The sequence rule to filter in TLP:Completion is not contradicting the global 
state rule to filter in TLP:Memory. Both rules are applied.
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Example 5

Result: Only TLP (any type) is in the CATC Trace.

Reason: The sequence rule to filter in TLP:Completion is not contradicting the global 
state rule to filter in Any TLP. Both rules are applied.

Example 6

Result: Only TLP (any type) is in the CATC Trace.

Reason: The sequence rule to filter in Any TLP is not contradicting the global state rule 
to filter in TLP:Completion. Both rules are applied.

Example 7

Result: All TLP are filtered out.

Reason: The sequence rule to filter out Any TLP is not contradicting the global state rule 
to filter out TLP:Completion. Both rules are applied.
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Example 8

Result: All TLP are filtered out.

Reason: The sequence rule to filter out TLP:Completion is not contradicting the global 
state rule to filter out Any TLP. Both rules are applied.

Example 9

Result: Only TLP:Completion is in the CATC Trace.

Reason: The sequence rule to filter in TLP:Completion is overwriting the global state rule 
to filter out Any TLP. 

Example 10

Result: Only TLP (any type) is in the CATC Trace.

Reason: The sequence rule to filter in Any TLP is overwriting the global state rule to filter 
out TLP:Completion. 
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Example 11

Result: Only TLP (any type) is in the CATC Trace.

Reason: The sequence rule to filter in Any TLP is overwriting the global state rule to filter 
out Any TLP.

Example 12

Result: Empty CATC Trace.

Reason: The sequence rule to filter out Any TLP is not contradicting the global state rule 
to filter in Any TLP. Both rules are applied. (The global rule filters out DLLPs and Ordered 
Sets, and the sequence rule filters out TLPs.)

Example 13

Result: Only TLP (any type) is in the CATC Trace.
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Reason: Filter out rules in the global state cell and in the sequence state cell are ignored. 
The Filter-In Any TLP rule is used.

Example 14

Result: Only DLLP:UpdateFC is in the CATC Trace.

Reason: The Filter out rules are ignored. Filter in DLLP:updateFC rule is used.

Example 15

While in state 1: Only DLLP:UpdateFC is in the CATC Trace.

Reason: The Filter out rules are ignored. Filter in DLLP:updateFC rule is used.

While in state 2: Only Ordered Sets are in the CATC Trace.
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Reason: Both the sequence state and the global state rules are used, and all TLPs and 
DLLPs are filtered out.

While in state 3: Nothing is recorded.

While in state 4: Everything is recorded.

Reason: The sequence state rule to filter in anything overwrites global state rule.

Example 16

Result: Only TLP (any type) is in the CATC Trace.

Reason: In both states, the rule is to keep only TLP.

Example 17

Result: Only TLP (any type) is in the CATC Trace.

Reason: The Filter-out rule is ignored because there is a filter-in rule with a higher 
priority.
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Example 18

Result: Empty CATC Trace.

Reason: Filter Anything has the highest priority and overwrites filter-in rule.

9.7 Properties Dialog Boxes
Properties dialog boxes provide additional settings for Events, States, Actions, and other 
objects in the Recording Rules page. You can access a Properties dialog by 
double-clicking an Event, State, Action or other object.
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9.8 Event Properties Dialog
The Event Properties dialog presents options for refining triggers and filters. For 
example, to set a trigger on a specific type of error, you open the Properties dialog

Accessing the Properties Dialog
To see the Properties dialog, first create an event button by clicking the New Events 
button and choosing an event from the menu. Afterwards, open the Event Properties 
dialog by doing one of the following: 

• Double-click an event.
• Right-click an event and select Properties from the pop-up menu.
• Click the Properties button on the toolbar.

Dialog Settings and Features
Event Icon Preview: This icon shows you which event properties you are editing. The 
Icon Preview looks exactly like the icon in the Main Display area.

Icon Label: A text box for labeling the button. Whatever you type here appears on the 
button.

Channels: These controls allow you to select the channel(s) that the Analyzer should 
search when it is looking for the event. 

Count: A counter tells the Analyzer to search for x instances of the selected event. For 
example, if you enter 10, the Analyzer counts 10 instances of the selected event before 
it performs whatever action you assign. There are only two counts available in the 
hardware so if you try to assign more than two, you get a warning. Counters cannot be 
applied to events with Filter Actions. The maximum counter value is 65,535. 

Pin Button: Allows you to pin the Properties dialog box to the application so that it does 
not go away when another object appears such as an event, state or action.

Description String: This area contains a textual description of the event.
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Event-specific Settings: The largest part of the Event Properties dialog box. The 
settings in this area vary for different events. Some events do not have any additional 
settings (for example, Basic Link Services, Extended Link Services). The Events that do 
have settings are: Error Event, Data Frame Event, Primitive Event, Advanced Primitive 
Event, SCSI Command Event, Breakout Board Event, and Timer Event.

Error Properties Dialog
The Error Properties dialog box lets you select specific error types for performing an 
action. There are two sets of Error types: Packet Errors and Idle Errors.

Actions Properties Dialog
The Actions Properties dialog box.
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TLP Header Properties Dialog
The TLP Header Properties dialog box. 

Note: TLP Prefix is available only on Summit T2-16.

TLP Prefix Properties Dialog
The TLP Prefix Properties dialog box.

Note: TLP Prefix is available only on Summit T2-16.
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Payload Properties Dialog
The Payload Properties dialog box.

Note: TLP Prefix is available only on Summit T2-16.

DLLP Packet Properties Dialog
The DLLP Packet Properties dialog box.
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Ordered Set Properties Dialog
The Ordered Set Properties dialog box.

9.9 Counting Events
Triggers can be set on multiple instances of an event. For example, you can set a trigger 
to occur following five instances of any DLP. To configure the Analyzer to look for multiple 
events, you enable Counters. Counters tell the Analyzer how many occurrences of an 
event it should wait for before triggering. 
For example, Trigger following the 16th occurrence of an error.

Counters enable triggers to be set that are based on a count of events. For example, you 
could use a counter to Trigger following the 16th occurrence of a DLLP message

To use a counter, follow these steps:

Step 1 Click an event. This causes an arrow to appear.

Step 2 Click one of the two counters (it does not matter which you use). This 
causes the counter to attach itself to the bottom of the event (shown 
above). An arrow automatically connects the counter to the Trigger 
button.

To change the counter value:

Step 1 Click the small blue dot in the upper-left corner of the counter button. A 
menu appears.

Step 2 Select Change Counter Value. 

Step 3 Enter a new value in the pop-up dialog box. This causes the new value 
to appear in the counter button.
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How to Set a Counter
To set a counter:

Step 1 Open the Recording Rules page, select an event, and drag it to the 
Global State or Sequence cells. For details on these steps, see 
“Creating Recording Rules” on page 135.

Step 2 Counts can only be set on a per channel basis, so press the Up or Down 
channel buttons to select the channel on which the count is performed. 

Step 3 Right-click the selected event and select Add Counter from the menu to 
open the Properties dialog.

Step 4 In the text box to the right of the label Count enter a value. Make sure 
the checkbox to the left of the word Count is checked.

Step 5 Click the X in the top right corner of the dialog box to close the dialog. A 
counter button should appear just below your selected event.
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9.10 Creating a Payload Match
You can configure PETracer to trigger, count, and restart on a specific payload pattern 
within a Transaction Layer Packet (TLP). In Recording Rules, create a New event of the 
desired TLP type. An icon appears that represents that event type in the Available Events 
area. Right-click the icon and select Properties to bring up the Properties dialog box for 
the event.

Select the Payload tab to bring up the pane that lets you configure payload pattern. You 
can match up to four patterns, labeled 0 through 3. 

For each pattern, you specify the following:

Offset dword: Indicates the DWORD you want to match within the payload (range is 0 
through 1024). For example, if you want the Analyzer match a pattern in the first DWORD 
of the payload, enter 0. If you want the Analyzer to match a pattern in the thirty-fifth 
DWORD, enter 35. 

Bitmask: Indicates which bits you want to match for the DWORD indicated. You can 
enter any of the following in the bitmask area: 

• X (bit not relevant)

• 1 (present)

• 0 (bit not present)
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Note: The Mask (hex) and Match (hex) entries represent bitmask in hex format. As you 
type entries in the bitmask, corresponding values appear in fields in the hex Mask and 
Match. Alternately, you can type values in the hex Mask and Match, and corresponding 
values appear in the bitmask.

Example 1
To tell the Analyzer to trigger on any payload with the binary pattern 1111111 in the third 
DWORD:

Step 1 Create an Any TLP event in the Available Events area of Recording 
Rules. Drag the event to the Global State cell.

Step 2 Open the Properties dialog box for the event and bring up the Payload pane.

Step 3 Enter 3 in the Offset dword area of any of the four patterns (0 to 3). For 
purposes of this example, we choose pattern 2.

Step 4 Enter the following in pattern 2: 1111111. 
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Example 2
To tell the Analyzer to trigger on any payload with the binary pattern 1111111 in the third 
DWORD, OR to trigger on any occurrence of Memory Write: 

Step 1 To set up the first condition, do steps 1 through 4 in Example 1.

Step 2 Create a Memory Write event in the Available Events area of Recording 
Rules. Drag the Memory Write icon to the same cell as the Any Event 
icon from Example 1. The Analyzer now is set to trigger on either of the 
two conditions.

9.11 Trigger
A trigger is one of five actions that can be assigned to an event. (The other four actions 
are Filter In, Filter Out, Advance the Sequence, and Restart the Sequence.)

To enable a trigger, place an event button into either the Global State cell or the 
Sequence cell, then right-click the button and choose an Action. 

From the sub-menu, select Trigger. 
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The exact end of the recording depends on how you have set the Trigger Position slider 
in the General page of the Recording Options dialog. This setting determines whether the 
recording terminates immediately following a trigger, or some time afterwards. See 
“General Tab” on page 123 for further explanation.

9.12 Filter In and Filter Out
A filter causes the Analyzer to filter in or out specified events from the recording. If events 
are filtered out of the recording, they are excluded from the Analyzer's buffer and not 
simply hidden from the CATC Trace. The purpose of filtering is to preserve recording 
memory so you conduct longer recording sessions and exclude events that do not 
interest you.

A filter causes the Analyzer to filter in or out specified events from the recording so you 
can preserve recording memory and thereby increase the duration of your recording. 
Filtering also lets you exclude unwanted data so your CATC Trace displays only the traffic 
that interests you.

To enable or disable filtering, place an event button into either the Global State cell or 
the Sequence cell, then right-click the button and choose an Action (see previous topic). 

From the sub-menu, select Filter In or Filter Out. 
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Chapter 10:  BitTracer Recording

10.1 Overview
Note: BitTracer Recording is an optional feature.

The PETracer Summit or Summit T2-16 analyzer has an optional BitTracer data capture 
mode, which captures bi-directional link traffic in raw format. The BitTracer recording 
mode captures and displays traffic before lane-to-lane de-skew operations and before 
descrambling of 10b bytes. The BitTracer mode includes support for multiple logical links 
(bifurcations) on a single physical link.

The BitTracer recording mode has its own user interface, which provides 
characterizations of link traffic that are not available in the standard protocol analyzer 
mode.

You can export BitTracer recordings for viewing in CATC Trace format.

PETracer Summit and Summit T2-16 Only
Note: BitTracer Mode recording is only available in the Teledyne LeCroy PETracer 
Summit or Summit T2-16 PCI Express Gen2 Protocol Analyzer and is an optional 
feature. This feature can be included at initial purchase or added in the field with a 
software upgrade license. To obtain a software license key to add this feature, contact 
Teledyne LeCroy.

10.2 Enabling BitTracer Recording
To enable the BitTracer recording mode, open the Recording Options dialog box. 

In the Target Analyzer section of the General tab, select PETracer Summit or 
Summit T2-16.

In the Recording Type section, select Bit Tracer Recording.



Chapter 10: BitTracer Recording Summit User Manual

158 Teledyne LeCroy

In Bit Tracer Recording, you can use the Snapshot, Manual Trigger, and Event Trigger 
recording types.

Note: You can also use other standard Recording Options, such as Link Width, 
Buffer Size, and Lane Polarity Settings, to characterize the link.

10.3 Trigger Modes
If you select Event Trigger, you may select basic trigger settings in the Trigger On box. 

By default, these selections include standard K (command) characters for each direction 
(upstream and downstream). You may also manually enter a D (data) character in the 
upstream or downstream boxes.

To disable a K or D character in either box (and so remove a trigger condition), place the 
cursor in the box and delete the displayed K or D character.
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10.4 Views Available for Captured Data
BitTracer mode displays captured data lane-by-lane and byte-by-byte in each direction 
(upstream and downstream), with the time scale progressing left to right. 

Other views are provided for timing measurements, marker placement, physical layer 
errors, captured symbol types, packets, events, and decoding of ordered sets and 
packets. You can view any or all displays simultaneously, using the Windows selection 
in the View menu. 
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10.5 De-Skewing Data
By default, BitTracer recordings display captured data in a raw, time-skewed format, 
across all lanes in both directions. Individual bytes are as they were captured on the 
recorded link, before the receiver device on the link (or the receiver logic on the PETracer 
analyzer) has performed lane-to-lane de-skew operations.

You can manually skew the captured data, left or right, in increments of one symbol time, 
using the associated toolbar buttons.

You can automatically de-skew an entire lane direction. First, left-click on the direction in 
the data window. Then right-click to display a popup menu. Then select Auto De-Skew.

You can de-skew only one direction for each right-click operation. To automatically 
de-skew the opposite direction, first left-click on that direction in the data window.

Note:  The skew observed in the bit tracer is the actual skew of the lanes in the link 
plus the skew introduced by the analyzer interface. The De-skew Bypass 
option is not intended for skew measurements or estimations.

10.6 Data Display Formats
To display traffic in K/D symbol (with Running Disparity indicated), scrambled, 
descrambled, 10-bit, and Binary code formats:

• Use the toolbar.

• Right-click to display a menu.
• Place the cursor over any given byte to display all byte formats (including an LFSR 

value) in pop-up list. 

Note: Descrambled values can only be displayed after the first recorded skip ordered set. 
Data prior to the skip is displayed in scrambled values, due to the unknown LFSR.

Note: For Binary Data Display Format, bits are shown in order of transmission on the bus.



Summit User Manual Chapter 10: BitTracer Recording

Teledyne LeCroy Corporation  161

10.7 Color-Coding of BitTracer Contents
To increase visual understanding of BitTracer displays, different symbol types have 
color-coding:

• Presence or non-presence of a lane’s byte-lock
• Idle data characters (D0.0)
• K codes
• Invalid 10b symbols
• Signal presence
• Background of the Markers Bar (see “Markers Bar” on page 163) 

(color coded according to traffic speed).
• All symbols of a TS1/TS2 ordered set

By default, these color selections match the standard color selections used in the 
CATC Trace format. You can modify them in the Display Options menu, accessible from 
the Main toolbar or the Setup menu.

10.8 Report and Analysis Windows
In the report windows, BitTracer mode provides several functions to analyze traffic:

• Statistical information
• Timing measurements
• Packet decoding

To activate/deactivate a report window, use Views > Windows. 

You can rearrange the report windows.

All report windows are dockable. 
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10.9 Timing Measurements Bar
BitTracer mode provides timing measurements on captured data:

• Measurements from the Trigger position relative to user-selected X and Y markers
• X-Y measurements
• Measurements between user-defined markers
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Markers Bar
The Trigger marker  is at the point where BitTracer recognized the user-defined 
trigger condition. 

To set an X marker , left-click anywhere in the data display, except for the light gray 
bar located above the data and below the directional label. 

To set a Y marker .right-click anywhere in the data display, except for the light gray 
bar located above the data and below the directional label. 

To define a marker, select the Set Marker command in the Markers menu or use the 
Toggle Marker icons in the toolbar. You can also use the Jump to Next or Previous 
marker icons in the toolbar. 

User-defined markers are numbered in order they were placed:

• U1 , U2, and so on in the upstream direction

• D1, D2 , and so on in downstream direction.
You can set a marker with text using the Set Marker with Text… command in the 
Markers menu. After setting the marker, when the mouse pointer is on the marker symbol, 
the marker text displays as a tooltip. 

You can also display the Markers window, which lists all markers and their locations, 
including a hyperlink for each. 
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Timing measurements between all combinations of X, Y, U, and Trigger cursors are in the 
Timing window. 

10.10 Errors Bar
BitTracer mode provides a summary of 10b errors (invalid symbols) and disparity errors 
in the Errors window. The window shows the total error count and errors per-lane for each 
error type. Hyperlinks allow jumps to selected errors.

BitTracer mode also highlights errors:

• Invalid symbols have a black background.
• Bytes with incorrect running disparity have red borders.
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10.11 Symbols Bar
The Symbol window provides a summary of the different symbol types captured, by 
quantity and direction, and includes hyperlinks for jumps to selected symbols.
Expanding the + sign at the left of each symbol provides a summary of symbols by lane.

10.12 Events Bar
The Events report window summarizes Link Up, Link Down, and Speed Switch events for 
Upstream and Downstream.

Note: The table entries are hyperlinks.
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10.13 Packets Bar
The Packets report window summarizes packet types detected in the file.

To obtain packet types, you must perform a post-capture "Analyze" step. After capture, 
when you open the Packets Bar for the first time, items can display the command 
"Analyze". To start the analysis, click the word Analyze. After analysis finishes, the 
results are saved with the file. Therefore, you do not need to click Analyze the next time.
Note: The table entries are hyperlinks.

Note: If you edit anything, the results are no longer valid, and the system requires you to 
click Analyze again. 

After analysis, the Packets Bar looks like the following: 
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10.14 Decoding Bar
If you select them in the data view, or search or jump locates a feature, BitTracer mode 
displays ordered sets and packets in the Decoding window:

• Logical view is identical to CATC Trace format.
• Specification view provides a more elementary display. The Specification view 

includes an option to display data in hex or binary format.

Note: Packets and ordered sets translate directly to this view from data capture and use 
any post-capture skew manipulations you add, or use natural lane-to-lane skew present 
on the link if you have not added post-capture skew manipulations. Typically, you would 
perform an Auto De-Skew before viewing ordered sets and packets in this view.

Use the left and right arrows to search for the next or previous symbol type.
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10.15 Search
To search, use the Search toolbar. 

Clicking the Search icon displays the Search window.

You can copy data shown in the BitTracer display across a lane (horizontally) or across 
multiple lanes (vertically), and then paste it into the Search Pattern window. 

The Search Pattern window stores previous search values, which you can recall by 
selecting the Search Pattern drop-down button.

In the Pattern Format section, select to search in 10-bit Codes, Scrambled Bytes, or 
Descrambled Bytes format.

In the Search Order section, select to search Across Lanes (multiple lanes, vertically) or 
Along Lanes (individual lanes, horizontally).

To define the direction (upstream or downstream) and the lanes on which to search, use 
the Search On section.
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10.16 Link Configuration
Use the toolbar icon or right-click in the data views to display the Link Configuration 
dialog. This dialog allows you to associate logical lanes with physical lanes, thereby 
providing support for lane bifurcation (multiple logical links on the same physical link).

After logical lanes map to physical lanes, BitTracer mode reconfigures the display to 
show the selected logical link (and the logical link width, as the link width selected in the 
dialog). 

Use the arrows to force symbol time skew on any lane.

Use the polarity checkbox to invert lane polarity on the selected lane or use the +/- toolbar 
icon. 

Use the scrambling option to select a scrambling algorithm, as per specification 1.0a or 
legacy specification 1.0. 
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Note: This dialog applies to one direction at a time (upstream or downstream). Left-click 
in the direction in the data display to edit the configuration for that direction.

As you perform operations that affect display configurations, the application records 
them. To undo or redo operations, use the Undo and Re-do icons on the toolbar.
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10.17 Export of BitTracer Capture to CATC Trace For-
mat

You can export BitTracer captures to standard CATC Trace file formats, selecting the 
Export option from the File menu. Note: You should use the Auto De-skew feature before 
using the export feature. 

The exported CATC Trace keeps association information with the original BitTracer file. 
Such traces scroll synchronously when you select the Synchronize Traces option in the 
Windows menu. 

You can navigate between BitTrace and CATC Trace using the 
Show in Trace View/Show Packet in Raw Trace context menu.

Exports Involving Multiple Logical Links on One 
Physical Link
If a single BitTrace capture contains more than one logical link, you can export each 
logical link to CATC Trace format. You may then cascade or tile the various BitTracer 
exports, which then scroll together in linked fashion, along with the original BitTracer file. 
The Export dialog provides options to export a limited range within the BitTrace capture 
and to automatically open the exported capture in CATC Trace format. 

10.18 Compressing and Expanding the Data View
You can compress (zoom out) the horizontal timing of the displayed data to view 
higher-order link behaviors. You can expand (zoom in) to examine higher-resolution 
views. 

To zoom in or zoom out, right-click the data view, then select a command or select a zoom 
icon on the toolbar.

Alternatively, to zoom in, left-click and drag across a desired range of data.

10.19 Opening and Saving BitTracer Captures
You can save BitTracer captures in various file types.

You can collate and archive these files for transport, using the 
Export to Compressed Archive feature in the File menu. 

The main BitTracer files have a *.peraw extension. 

You can open these files in the PETracer application using the File > Open command.
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Chapter 11:  Reports and Tools
Reports assist you in analyzing traffic recorded by the Analyzer. The available reports 
are: 

• File Information: To view general information about the CATC Trace file.

• Error Summary: To view a count of errors in a CATC Trace file.

• Traffic Summary: To view a summary of protocol-related information in the 
CATC Trace file summary information about a selected group of items in the 
CATC Trace file (such as a count of particular frame or packet types).

• Bus Utilization: To display information on bandwidth usage for the transmit and 
receive channels.

• Link Tracker: Displays a detailed chronological view of events.

• Data Flow: Shows marker, packet, direction, type, length, address, payload, hand-
shake, and timestamp information.

• Trace Navigator: Navigates within the CATC Trace to view the location of errors 
and triggers, narrow the range of traffic on display, and jump to any point in the 
CATC Trace.

• LTSSM Flow Graph: Shows a state diagram of bus activity.

• Packet Header: Shows packet header information

• Packet Data: Shows packet information.

• Configuration Space: Displays a Configuration Space.

• Metrics: Measures key operating parameters.

• Real Time Statistics: To display statistical information for the channels.

• TC to VC Mapping: To display how Traffic Classes are mapped to Virtual Channels (to 
simplify navigation) and how the CATC Trace display was changed (for example, in Split 
Transactions).

• Timing Calculations: To view timing measured between two events set within the 
CATC Trace file.

• PCIe SSD base Mapping: Displays the PCIe SSD Base Address dialog.Run 
Verification Scripts: Allows you to check errors, link transactions, split transac-
tions, metrics, ordered sets,replays, DLLPs, and TLPs.

Reports are available from the Report menu and buttons on the Tool bar. Tools are 
available from the Tools menu. 
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11.1 File Information
The File Information window provides a summary on the currently displayed file.

Select Reports > File Information  to obtain the File Information window. 
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11.2 Error Summary
The Error Summary dialog box displays the number of errors for each event and the 
packet containing the errors.

Select Reports > Error Summary to obtain the Error Summary dialog box.

AHCI Error Summary
The AHCI Error Summary dialog is a sub-entry for the main Error Summary dialog. It 
displays the number of errors for each AHCI transaction containing the errors.

Select Reports > Error Summary to open the Error Summary dialog.

The five types of AHCI errors are describe below:
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Reserved Field not Zeroes
One or more fields inside the AHCI transaction are not filled with all 0s. The AHCI 
specification states that all reserved fields and registers must be filled with 0s.

Note:  Reserved fields for AHCI level are not displayed when filled with all 0s.

Incomplete
The AHCI transaction does not contain enough data or lower-level transactions (Link or 
Split) are marked as incomplete.

Logical Error 
One or more fields are in an inconsistent state relative to the other fields in the same or 
other registers.

Read-only Field Changed 
The value of the read-only field differs from the previous one.
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Unknown 
The AHCI decoder is unable to decode a particular transaction correctly. This can be 
caused by a distorted trace file.

Checks for Logical error and Read-only field depending on the values obtained from 
previous registers. It can result in false-positive or false-negative detections in case of 
partially saved trace file. The AHCI transaction can be marked as incomplete in case of 
saving a portion.

11.3 Traffic Summary
The Traffic Summary window summarizes the traffic in the current CATC Trace. The left 
side of the window displays a tree of protocol levels. The right side displays a summary 
of traffic for the displayed levels. 

Select Reports > Traffic Summary or click  to display the Traffic Summary window.

Buttons at the top of the Traffic Summary window change the display format and enable 
data to be exported to email, file, or the printer.
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Using the Traffic Summary Window to Search the 
CATC Trace
You can use the Traffic Summary window to move the CATC Trace to packets of interest: 

Step 1 Click one of the numbers in the right side of the Traffic Summary window. 

The CATC Trace jumps to the first instance of the selected protocol. 

Step 2 Click the up or down arrows . The CATC Trace jumps forward or 
backward through the display to the next instance of selected protocol 
level.

Traffic Summary Buttons
Buttons at the top of the Traffic Summary dialog box provide options for exporting the 
data or formatting its appearance:

Save. Saves Traffic Summary results into an HTML format.

Email. Attaches an HTML file of the results to a new email.

Print. Prints results.

Text. Displays results in HTML format.
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11.4 Bus Utilization
Select Report > Bus Utilization from the menu or press  to open the Bus Utilization 
window.

The Bus Utilization window displays information on bandwidth use for the transmit and 
receive channels.

Options. Opens a drop-down menu with the following options:

• Grid Lines: Displays/Hides grid lines

• Row Selection: Allows entire rows to be selected

• Tight Columns: Reformats column widths to match data

• Event Navigation: 

Skip Hidden Items

Show Hidden Items

Prompt each time
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Bus Utilization Pop-up Menu
You can reformat the display by right-clicking a graph and making a selection from the 
Bus Utilization pop-up menu.

Go to Packet #: Relocates the CATC Trace to the selected packet number.

Undo Zoom: If you have zoomed in, this command undoes the zoom.

Zoom to Trace View: Zooms in on graph to show traffic currently displayed in the 
CATC Trace screen.

Fit to Graph Area: Redisplays graph so that the entire CATC Trace fits inside graph area.

Y Scale Type:

• Linear: Converts display to linear format

• Logarithmic: Converts display to logarithmic format

Hide: Hides the selected graph

Remove: Allows you to remove any graph that you created via the New  command
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Properties: Opens a dialog box with options for changing the Title, Type, Appearance, 
and Color of the graphs.
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Bus Utilization Buttons
The Bus Utilization window buttons allow you to reformat the display and export data. 

Button Function

Save. Saves Bus Utilization data to a bitmap file (*.bmp).

Email. Opens an email and attaches a bitmap file of the Bus Utilization data.

Print. Prints the Bus Utilization data.

Full Screen. Maximizes the Bus Utilization window.

View Settings. Opens a sub-menu with the following choices:

• Orient Horizontally

• Tile Vertically

• Show Markers

• Show Plumbline

• Status >> 

Bar

Tool tips

None

• Grid Lines >> 

Both Axes

X Axis

Y Axis

No Grid

• Grid on Top

• Fonts & Colors

Horizontal zoom in

Horizontal zoom out
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Vertical zoom in

Vertical zoom out

Click and Drag zoom. Click and drag to zoom in on a part of the graph.

Select Range. Displays a dialog box for selecting a packet range.

Synchronize Graph Areas. If two or more graphs are displayed, this button 
synchronizes the graphs to one another. Once synchronized, the positioning slider of 
one graph moves the other graphs.

Graph Areas. Provides options for creating and displaying additional graphs of data 
lengths, packet lengths, and percentage of bus used. 
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11.5 Link Tracker
The Link Tracker window displays a detailed chronological view of events. Events are 
shown on a channel-by-channel basis in columns within the window. 

Each time slot in the vertical axis represents the minimum time that a DWORD requires 
to traverse the bus. 

Toolbar: Presents buttons for changing the format of the Link Tracker window.

Main Display Area: Displays traffic chronologically as it occurred in the recording. The 
window divides into columns: the first column shows time and traffic is shown on a 
channel-by-channel basis in the columns on the right.
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Using the Link Tracker Window
The Link Tracker window can be reformatted in several ways.

Zooming In and Out
Zooming out can give you a quick, high-level view of a CATC Trace. A fully zoomed out 
CATC Trace only shows columns and colored lines. Using the colors, you can see what 
types of traffic run through the CATC Trace. 

Further information can be obtained on any point of interest in the CATC Trace by 
positioning your mouse pointer over it. Tool tips provide detailed description of events. 

Note: When fully zoomed out, the smallest graphical unit is the DWORD, represented by 
a single line. Zooming out makes the CATC Trace appear smaller and increases the time 
scale in the first column.
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Collapsing Idle Time, Enabling Tool tips, and Resetting Column 
Widths
Click the View Options button  to open a menu with options for formatting the 
display. Three options are presented:

Collapsible Idle Time: Opens a dialog box for setting the Idle time value. Setting a value 
tells the Analyzer when to collapse Idle times and display them as grayed out strips within 
the Bus View window. 

Tooltip Display: Opens a menu with options for adding content to Tooltips. Tooltips 
display when you position the mouse pointer over an item in the Bus View window. The 
options are:

• Tooltips Display Values

• Tooltips Display Scrambled Values

• Tooltips Display 10-bit Codes

• Tooltips Display Symbols

Time Format: Seconds or Clock

Reset Column Widths: This option resets column widths to their defaults and enables 
columns to resize themselves automatically any time the application window is resized. 
Normally, columns automatically resize themselves if the application window is made 
larger or smaller. However, if you manually resize any columns in the Bus View window, 
column widths become static. Thereafter, if you resize the application window, the 
Bus View columns do not adjust automatically. Reset Column Widths re-enables the 
automatic resizing capability.

Reset Columns Order: Return to default column sequence.

Docking and Undocking the Window
You can undock the Link Tracker window by double-clicking the blue title bar along the 
left side of the window. Once undocked, the window can be dragged anywhere in the 
application. To redock, double-click again on the title bar.
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Setting Markers
Markers can be set on any event within the Link Tracker window. 

To set a marker, right-click an event, then select Set Marker from the pop-up menu. 

Once marked, you can navigate to events with the Go to Marker command in the Search 
menu. 

Markers set in the Link Tracker window display the packet number and DWORD number. 
In contrast, markers set in the CATC Trace window just show the packet number. 

Calculating Time between DWORDs
You can calculate time between DWORDs by clicking an event and then positioning your 
mouse pointer over a second event and reading the ensuing Tool tip.

Click the time value for the first event. Scroll down through the CATC Trace to the second 
event and position the mouse pointer above its time value. A Tool tip appears showing 
the time interval between the first and second events. 

Hiding Traffic
You can hide Idles and other data from the Link Tracker window by clicking the Hide 
buttons on the toolbar.
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Link Tracker Buttons
The Link Tracker window has a row of buttons for changing the format of the displayed 
data and for exporting data: The buttons have the following functions:

Full Screen. Expands the Link Tracker window to fill the entire screen.

View Options. Opens a menu with three options: 

• Collapsible Idle Time (Collapse Idle Bigger Than n nanoseconds. 
Note: Does not affect Collapse Idle Plus.)

• Tooltip Display (Values, Scrambled Values, 10-bit Codes, Symbols)

• Time Format (Seconds, Clock)

• Reset Columns Widths (return to default widths)

• Reset Columns Order (return to default column sequence)

See “Using the Link Tracker Window” on page 185 for further details.

Synchronize Trace View. Synchronizes the Trace View and Link Tracker windows 
so that a move in one window repositions the other.
Because of the differences in scale and logic between the Link Tracker and Trace 
view window, scrolling produces different effects depending on which window is 
being scrolled. 
Scrolling in the CATC Trace window causes the Link Tracker window to rapidly 
jump from event to event. Long periods of idle time are thus skipped. 
Scrolling in the Link Tracker window, in contrast, produces modest movements 
within the CATC Trace window. 
Scrolling in the Link Tracker window causes the CATC Trace window to pause until 
the beginning of a packet is displayed. At that point, the CATC Trace window 
repositions itself. While scrolling long Idle periods or through the contents of a 
packet, the CATC Trace window does not move.

 

Zoom In

Zoom Out

Continuous Time Scale. No collapsing.

Collapse Idle. Do not show some periods of Link being idle.

Collapse Idle Plus. Do not show periods of Link being idle.
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Show Values

Show Scrambled Values

Show 10b Codes

Show Symbols

Show Text

Show Binary values
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11.6 Data Flow Window
The Data Flow window shows marker, packet, direction, type, length, address, payload, 
handshake, and timestamp information.

To obtain the Data Flow window, select Report > Data Flow 

or click the  Data Flow toolbar icon. 

The toolbar allows you to:

• Expand the window to full screen or Collapse to a smaller window.
• Synchronize.
• Save.
• Select Data Flow columns to display and their widths: 

• Marker

• Packet

• Direction

• Type

• Length

• Address

• Payload

• Handshake

• Time Stamp
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11.7 Flow Control Tracking
The Flow Control View mode highlights portions of the packets that affect flow control and 
displays flow control values. Flow control values shown at the beginning of Link 
Transaction display the credit values that were available prior to TLP transmission. Flow 
control values shown at the end of the Link Transaction display the credit values that were 
available after TLP was transmitted. Hover the mouse over the field to display tool-tips. 
Refer to the following screen capture. 

If the trace includes Flow Control initialization, PETracer detects the amount of available 
credits based on the values advertised in InitFC packets. If the InitFC packets are not in 
the trace, the amount of available credits can be set using the FC Credit Setup dialog. 
Select View > FC Credits Setup... displays the FC Credit Setup dialog (see the following 
screen capture). 

For each virtual channel that is present in the trace you need to specify the amount of 
available credits before the beginning of the trace. You can also specify the values of 
credit fields for UpdateFC packets before the beginning of the trace. If the values of the 
UpdateFC credit fields are different than the values in the first UpdateFC packet, Flow 
Control tracking view will show that the first UpdateFC packet is releasing appropriate 
amount of credits. By default, PETracer sets these values to match the first UpdateFC 
packets in the trace.
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11.8 Using the CATC Trace Navigator
The CATC Trace Navigator is a tool for navigating within the CATC Trace. It allows you 
to view the location of errors and triggers in a CATC Trace and to narrow the range of 
traffic on display. It also allows you to quickly jump to any point in the CATC Trace.

Displaying the Navigator

Click  in the toolbar to display the Navigator. The Navigator appears on the right side 
of the Main window. It has a two-button toolbar and a vertical slider bar. It also has colored 
panes for navigating the CATC Trace in different ways. You set which panes are 
displayed through Navigator pop-up menus.
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Navigator Toolbar
The Navigator toolbar lets you quickly set Navigator features. The toolbar has two 
buttons.

Navigator Ranges: This button brings up a pop-up menu that lets you reset the 
Navigator range. The range determines what packets are viewable in the CATC Trace 
display.

Navigator Panes: This button has two purposes: To select which Navigator panes 
appear and to bring up the Navigator legend. The legend determines how information is 
shown in the panes.

Navigator Ranges
You set the viewing range by dragging the yellow range delimiters along the slider. 

To set the lowest packet viewable, drag the top delimiter up. As you do so, a tool tip 
appears to indicate the current range. Stop dragging when you reach the desired lowest 
packet. 

To set the highest packet viewable, drag the bottom delimiter down. Stop when the tool 
tip indicates you are at the desired highest packet.

To Determine Current Position
In addition to the two range delimiters, the slider has a blue current-position indicator 
(see above). The current-position indicator shows where you are in the CATC Trace 
display with respect to the possible viewing range. 
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For example, suppose you set viewing range to packet 0 through packet 500 (the top 
range delimiter is at packet 0, and the bottom range delimiter is at packet 500). If you then 
move the current-position indicator on the slider to midway between the top and bottom 
delimiters, then packet 250 appears in the middle of the CATC Trace display. 

To Reset Navigator Range
You can reset the Navigator range using the toolbar Navigator Range button. Press the 
button to bring up the Navigator Range drop-down menu. 

The menu has the following options:

• Set Range to Whole Trace: Allows you to reset the range to include the entire 
CATC Trace file contents. The top range delimiter is placed at the lowest packet 
number in the CATC Trace. The bottom range delimiter is placed at the highest 
packet number in the CATC Trace.

• Set Range Near Packet xxx: Allows you to collapse the range so that only the 
packets immediately above and below the xxx packet are displayed. The xxx packet 
is whatever packet is currently at the top in the CATC Trace display.

• Recently Used Ranges: Allows you to reset the range to any of a number of 
recently used (previously set) ranges. 
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Navigator Panes
You can display any combination of CATC Trace Navigator panes. 

From left to right, the panes are: Pre/Post Trigger, Errors, Traffic Type, Traffic Speed, and 
Link Width. Each pane represents the entire CATC Trace with respect to different types 
of information. The top of each pane represents the start of the CATC Trace file, and the 
bottom represents the end of the CATC Trace file.

• Pre/Post Trigger: To view the trigger event in the CATC Trace and the relative size 
of pre-trigger and post-trigger portions of the CATC Trace. The two portions are set 
apart as different colors. The trigger event occurs at the point the two colors meet.

• Errors: To view any errors in the CATC Trace. A thin red line represents each error 
in the pane.

• Traffic Type: To view the types of packets that occur in the CATC Trace. A different 
color represents each packet type in the pane. The relative size of colored portions 
in the pane corresponds to the amounts of the various packet types in the 
CATC Trace. As described below, you can use the Navigator legend to change the 
types of packets that take precedence in the display.

• Traffic Speed: To view the speed that occurs in the CATC Trace. 
• Link Width: To view the link width that occurs in the CATC Trace. 

To Show/Hide Navigator Panes
You can show/hide any of the panes using pop-up menus accessible through left-click the 
Navigator Panes button or by right-click anywhere in any CATC Trace Navigator pane.
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Navigator Slider
The Navigator slider appears at the left of Navigator panes. The slider has yellow upper 
and lower range delimiters and a blue current-position indicator.

The Navigator slider lets you to set the range of packets viewable in the CATC Trace 
display. In other words, it sets scrolling range of the display. You can scroll the display up 
to the lowest packet number in the viewing range. You can scroll the display down to the 
highest packet number in the viewing range.

CATC Trace Navigator Legend
The Navigator legend lets you control the display of content in Navigator panes.

You bring up the legend through the Navigator Panes drop-down menu. Press the toolbar 
Navigator Panes button to access the menu. Select the Legend option to bring up the 
Navigator Legend dialog box.

The Navigator Legend dialog box has areas corresponding to each of the panes. Each 
area has check boxes that allow you to hide/display information in the pane. You can set 
the priority of information displayed in the panes using the up and down triangles on the 
right.

Using the Legend to Show/Hide Navigator Panes
To use the legend to show/hide an entire pane, use the checkbox next to the name of 
each pane in the legend. 

In the case of the Pre/Post Trigger and Errors areas, the action of show/hide in the legend 
is identical to that provided by CATC Trace Navigator pop-up menus. 

In the case of the Traffic Types pane, there is no equivalent show/hide available through 
the pop-up menus.
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Using the Legend to Set the Priority of Information Display
You can use the legend to set the priority of information displayed in the Pre/Post Trigger 
Traffic Type panes. This is a two-step process. 

Step 1 For a particular item in a pane, click the column next to the checkbox 
for the item. That labels the item as currently active. 

Step 2 Next, use the up-down at the lower-right of the area to move the item 
higher or lower in priority.

In the case of the Traffic Type pane, priority determines display priority of each packet 
type. For portions of the CATC Trace that are dominated by a particular packet type, this 
setting no effect: only the color corresponding to that packet type is displayed in that 
portion of the pane. Suppose, however, that part of the CATC Trace includes equal or 
near equal numbers of several types of packets. In that case, you can use the legend to 
select which among those types is represented in that portion of the Traffic Types pane. 
This allows you to view only packets of interest in crowded portions of the CATC Trace 
display.
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11.9 LTSSM Flow Graph
The LTSSM Flow Graph shows link state transitions that the link goes through, as 
recorded in the CATC Trace file. 

To obtain the LTSSM Flow Graph, select View > LTSSM Flow Graph. 

You can display the following directions: 

• Upstream
• Downstream
• Both

You can Show Number of Transitions.
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11.10 Packet Header Bar
The Packet Header bar shows packet header information.

To obtain the Packet Header bar, select Report > Packet Header 

or click the  Packet Header toolbar icon. 

The toolbar allows you to Save, go to Previous or Next, display Hexadecimal or Binary, and show 
the Packet Data window.
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11.11 Packet Data Window
The Packet Data window shows packet information.

To obtain the Packet Data window, select Report > Packet Data 

or click the  toolbar icon. 

The toolbar allows you to Save; go to Previous or Next; display Hexadecimal, ASCII, Decimal, 
or Binary; use MSB Format or LSB Format; and use Big Endian or Little Endian.

Format and Columns allows you to enter the number of bytes, words, or dwords per line.

You can enter an Offset and scroll to it.

You can enter text and Search Previous or Search Next.
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11.12 Configuration Space View
The Configuration Space View displays information about the Configuration Space state 
as of the current packet of the currently selected device. The view shows the 
Configuration Space Header and the PCI-compatible or PCI Express 
Capability Structures.

To display the Configuration Space View for a device at a packet:

Step 1 Open a CATC Trace, such as the sample file cfg_pci_express.pex.

Step 2 Scroll to a packet with a Configuration header.

Step 3 Select Report > Configuration Space > <device> to display the 
Configuration Space View.

or

Click a CompeterID or DeviceID field. A pop-up menu opens.
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Select Show Configuration Space for xxxx from the menu, where xxxx is the 
device number. The Configuration Space View opens.

On the left, the view displays the Configuration Space for the selected CompleterID or 
DeviceID at the current packet. You can select Configuration Space Header or a 
Capability Structure. 

The right displays the decoded data of the selected Configuration Space Header or a 
Capability Structure, up to the current packet. (The decoding builds while navigating 
through the next packets.)

The Configuration Space View toolbar allows you to Save, go to First, go to Previous, 
go to Next, go to Last, go to Previous Access to Selected Configuration Space Register, 
go to Next Access to Selected Configuration Space Register, and display Hexadecimal or Binary.

Note: See Appendix A “Configuration Space Decoding” on page 233.

Configuration Space Editor
The Configuration Space Editor allows you to create a new Configuration space file or 
open an existing Configuration Space file. It is used in conjunction with Teledyne LeCroy 
Trainer products. Select Tools > Configuration Space Editor to display the Configuration 
Space Editor dialog (see figure on next page). 
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11.13 Using Unit Metrics
For every protocol unit at the Link or Split transaction level, PETracer™ calculates and 
displays a set of metrics. Metrics are measurements of key operating parameters. You 
can use metrics to evaluate performance of traffic in the CATC Trace stream. 

You can view metrics information in the CATC Trace display, the Traffic Summary 
window, and the Bus Utilization window. 

PETracer defines different metrics for Link and Split transactions.

Metrics Defined for Link Transactions
Number of Packets: The total number of packets that compose this Link transaction.

Payload: The number of data payload bytes this Link transaction transferred.

Response Time: The time it took to transmit this Link transaction on the PE link, from the 
beginning of the first packet in the transaction to the end of the last packet in the 
transaction.

Data Throughput: The payload divided by response time, expressed in megabytes per 
second.

Note:  Usually, the Number of Packets metric for a link transaction is two (in case of 
explicit acknowledge) or one (in case of implicit acknowledge). However if 
Naks/link level retries are involved, this metric might be higher. As a result, 
the Number of Packets metric is useful in highlighting unusual link 
transactions.

Metrics Defined for Split Transactions
The following types of metrics currently are defined for Split transactions:

Number of Link Transactions: The total number of Link transactions that compose this 
Split transaction.

Payload: The number of payload bytes this Split transaction transferred.

Response Time: The time it took to transmit this Split transaction on the PE link, from 
the beginning of the first packet in the Split transaction to the end of the last packet in the 
Split transaction;
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Data Throughput: The transaction payload divided by response time, expressed in 
megabytes per second.

Latency Time: The time measured from the end of the request transaction to the first 
completion transmitted in response to the request within this Split transaction.

Note:  The Number Of Link Transactions metric for a Split Transaction usually is two 
for a Configuration or IO request. It can be bigger then two for a Memory 
Read request.

Show Metrics in the CATC Trace Display
In the CATC Trace view display of Link Transaction or Split Transaction levels, all metrics 
information applicable to a specific protocol unit is displayed in a Metrics header. The 
header is located close to the end of the unit, in front of the Time cell. You can expand 
and collapse the header to show or hide the metrics information.

Collapsed Metrics Header Display
Following is a collapsed metrics display for a unit of Link Transaction. The collapsed 
header display shows only the metrics cell representing the Number of Packets.

Following is a collapsed metrics display for a unit of Split Transaction. The collapsed 
header display shows only the metrics cell representing Number of Link Transactions.

Metrics Tool Tip Display
In both CATC Trace level views, you can view the summary of all the unit metrics in the 
Metrics header tool tip. To view the tool tip, simply place the mouse cursor over the 
Metrics header. Following is the tool tip for a unit in the Link Transaction view.

Note:  The tool tip also presents information for time passed from the start of the 
recording till the beginning of this Link or Split Transaction.
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Expanded Metrics Header Display
When you expand the Metrics header, the display creates a separate cell for each 
applicable metric:

Following is the expanded Metric header for a unit in the Split Transaction view.

Following is the expanded Metric header for a unit in the Link Transaction view.

Note: Each of the metric cells pops up a tool tip window with the explanation of what the 
metric means.

Show Metrics in the Traffic Summary Window
Some of the Traffic Summary reports at the Link and Split Transaction levels are based 
on metrics collected for the corresponding protocol units in the CATC Trace.

Reports at Split Transaction Level
Split Transaction Performance: This report table groups the Split Transactions by 
Requester-Completer pair and displays Minimum/Average/Maximum data for Number Of 
Link Transactions and Response Time metrics.

Read Requests Performance: This report table includes only the Split Transactions that 
present Read Requests (Configuration, IO and Memory). It groups them by the 
combination of Requester-Completer pair, request type, and Traffic Class and displays 
Minimum/Average/Maximum data for Throughput, Response Time, and Latency metrics.
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Write Requests Performance: This report table includes only the Split Transactions that 
present Write Requests (Configuration and IO). It groups them by the combination of 
Requester-Completer pair, request type, and Traffic Class and displays 
Minimum/Average/Maximum data for Throughput, Response Time, and Latency metrics.

Reports at the Link Transaction Level
The following metric-based reports are displayed at the Link Transaction level:

Link Transaction Performance: This report table groups the Link Transactions by TLP 
Type and displays Minimum/Average/Maximum data for Number Of Packets, Response 
Time and Payload Bytes metrics.

Memory Writes: This report table includes only the Link Transactions that present 
Memory Write Requests. Memory Writes are the only (posted) requests that don't get 
promoted to the Split transaction level, therefore their performance should be viewed at 
the Link transaction level. The table groups Memory Writes by the combination of 
Requester ID and Traffic Class and displays Minimum/Average/Maximum data for 
Response Time, Payload and Throughput metrics.

Following features apply to all of the report tables described above for the Split 
Transaction and Link Transaction levels:

• Each report row for the defined tables contains the total number of units in this 
group for the CATC Trace (total number of units for Split Transaction performance, 
Read Requests performance, Memory Writes, and so on).

• In many cases, the Maximum and Minimum values in the report tables are 
navigable. By clicking table cells, you reposition the corresponding CATC Trace 
view to the Split or Link Transaction that has yielded this maximum or minimum 
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value. This can help you to find specific units in the CATC Trace, such as 
transactions that produced spikes in Response Time or Throughput.

Show Metrics in the Bus Utilization Window
The Bus Utilization window provides graphs for packet-level information in the 
CATC Trace. The window also provides graphs for information on Split and Link 
Transaction levels, plotted over time. The graphs for Split and Link Transaction levels are 
based on metrics collected for the transactions throughout the CATC Trace.

The seven graphs related to Split and Transaction levels are:

1. Pending Requests at Split Transaction level.

2. Response Time at Split Transaction level.

3. Latency Time at Split Transaction level.

4. Throughput Per Transaction at Split Transaction level.

5. Response Time and Latency Time at Split Transaction level (combined graph).

6. Response Time at Link Transaction level, for Memory Writes only.

7. Throughput at Link Transaction level, for Memory Writes only.

The following is an example of Bus Utilization window display of graph numbers 1, 4, 5, 
6 and 7:
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Unit-Based Averaging
The Analyzer builds metric graphs using unit-based averaging (as opposed to 
time-based averaging). For the total duration of a certain request (or Memory Write 
transaction), the graph value is assumed equal to the corresponding metric for this 
request (transaction). If there are overlapping operations for a certain time period, then 
the value is calculated as an average of metric values for all the overlapped requests 
(transactions).

It is important to remember that the Analyzer uses unit-based averaging rather than 
time-based averaging. Time-based averaging can be misleading in some situations. For 
example, consider the Throughput Per Transaction graph. Sometimes, while many 
outstanding requests are in progress, latency (and response time) grows for each of the 
transactions, resulting in a lower throughput per transaction over time (which is reflected 
in the graph). This happens even though aggregated throughput across all the 
transactions is constant.

Bus Utilization Window Features
For the seven Split- and Transaction-level graphs listed, all Bus Utilization window 
features are available, such as zooming in/out, changing scale type, scrolling, 
context-sensitive status, and graph synchronization. See Bus Utilization and Bus 
Utilization Buttons for more on these features.

Note: Clicking a certain place within a graph area repositions the CATC Trace display at 
the Link or Split transaction level to the transaction that was in progress at that time.

Split Transaction Level Graphs
Transactions at the Split level combine all the non-posted requests with corresponding 
completions. This includes Configuration and IO Read and Write requests, as well as 
Memory Read requests.

The following shows the graphs for the Split level:
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Note:  The Pending Requests graph is not directly defined by metrics, but it is useful 
when considering metrics. The Pending Requests graph presents the 
unit-averaged number of requests that were pending (in progress) at any 
moment of time. It allows you to correlate the number of requests posted to 
a completer with other performance metrics.

Link Transaction Level Graphs
Memory Writes are the only (posted) requests that do not get promoted to the Split 
transaction level. Therefore, Memory Write performance should be viewed at the Link 
Transaction level. That is the reason graphs at the Link level only present the Memory 
Write-related metrics and are titled Writes: Response Time: and Writes: Throughput.
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11.14 Real-Time Statistics Window
The Real-Time Statistics Window displays Link Utilization, performance measurements, 
and statistical values for a PCI Express link plotted in real time.

Click  to open the Real-Time Statistics window. 

Start PCI Express™ link activity.

To start the monitor, press  . 

To stop the monitor, press  . 

The remaining Real-Time Statistics buttons provide options for changing the format of the 
display.

Additional formatting options are available through the Real-Time Statistics pop-up menu 
and the Real-Time Statistics toolbar.
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Real-Time Statistics Buttons
Additional formatting options are available through the Real-Time Statistics toolbar.

Button Function

Save. Saves Real-Time Statistics data to bitmap file (*.bmp).

Email. Opens an email and attaches a bitmap file of the Real-Time Statistics data.

Print. Prints the Real-Time Statistics data.

Full Screen. Maximizes the Real-Time Statistics window.

View Settings. Opens a sub-menu with the following choices:

• Orient Horizontally

• Tile Vertically

• Show Markers

• Show Plumbline

• Status >> 

Bar

Tool tips

None

• Grid Lines >> 

Both Axes

X Axis

Y Axis

No Grid

• Grid on Top

• Fonts & Colors

Horizontal zoom in

Horizontal zoom out
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Vertical zoom in

Vertical zoom out

Click and Drag Zoom. Click and drag to zoom in on a part of the graph.

Synchronize Graph Areas. If two or more graphs are displayed, this button 
synchronizes the graphs to one another. Once synchronized, the positioning slider of 
one graph moves the other graphs.

Graph Areas. Allows you to hide or display the graphs and the counters. You can 
toggle Statistics Accumulation, Link Utilization, Data Payload Throughput, and 
Data Packet Count.

Start real-time statistics. Starts the real-time statistical monitor. 

Stop real-time statistics. Stops the real-time statistical monitor. 

Reset Graphs. Resets the graphs.
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Real-Time Statistical Monitor Pop-up Menu
Additional formatting options are available through the Real-Time Statistics pop-up 
menu. Right-click a graph in the Real-Time Statistical Monitor window to display a pop-up 
menu with options for changing the format of the display.

Undo Zoom: If you have zoomed in, this command undoes the zoom.

Fit to Graph Area: Redisplays graph so that the entire CATC Trace fits inside graph area.

Y Scale Type:

• Linear: Converts display to linear format.

• Logarithmic: Converts display to logarithmic format.

Hide: Hides the selected graph

Properties: Opens a dialog box with options for changing the Title, Appearance, and 
Color of the graph. 
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Real-Time Statistics Graph Areas
The Real-time Statistics window has three graph areas: 

• Link Utilization

• Data Payload Throughput

• Data Packet Count

Each graph area has Upstream and Downstream graphs for a device (if connected to a 
host machine), plus as many graphs as Exerciser devices connected to the host machine.

The Statistics Accumulation area shows the PETracer statistics tab, plus as many tabs 
as Exerciser devices connected:
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For each Exerciser device, the following information displayed:

• Number of data packets

• Payload size

• InitFC complete status: Yes/No

• Link State: Possible states are:

• DETECT_QUIET

• DETECT_ACTIVE

• POLLING_ACTIVE

• POLLING_CONFIG

• CONFIG_LINKWIDTH_START

• CONFIG_LINKWIDTH_ACCEPT

• CONFIG_LANENUM_WAIT

• CONFIG_LANENUM_ACCEPT

• CONFIG_COMPLETE

• CONFIG_IDLE

• L0

• L0S_IDLE

• L0S_FTS

• L1

• RECOVERY_RCVRLOCK

• RECOVERY_RCVRCFG

• RECOVERY_IDLE

• HOT_RESET

• DISABLED

11.15 Memory I/O Space Editor
The Memory I/O Space Editor allows you to create a new Memory I/O Space file or open 
an existing Memory I/O Space file. It is used in conjunction with Teledyne LeCroy Trainer 
products. Select Tools > Memory I/O Space Editor to display the Memory Space Editor 
dialog.
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11.16 TC to VC Mapping
Select Tools > TC to VC Mapping displays how Traffic Classes are mapped to Virtual Channels 
(to simplify navigation) and how the CATC Trace display was changed (for example, in Split 
Transactions)..
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11.17 Timing and Bus Usage Calculations
The Timing and Bus Usage Calculator allows you to calculate time between packets.

Select Reports > Timing Calculations to obtain the Timing Calculator dialog box.

Total Time: Total time from beginning of the first unit to beginning of the second unit.
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Bus Utilization
This portion of the Timing Calculator window gives values that are cumulative for all 
packets during the timing period. For example, throughput is combined throughput of all 
packets during the timing period.

Upstream is from endpoint devices to the root complex. Downstream is from the root 
complex to endpoint devices.

Link Utilization: Percentage of non-idle symbols in total number of symbols transferred.

Time Coverage: Percentage of non-idle symbol times in total number of symbol times. 
(Non-idle symbol time occurs when at least on one of the lanes there were non-idle 
symbols transferred.)

Bandwidth: Number of non-idle symbol bits transferred per second.

Data Throughput: Number of TLP payload bytes transferred per second.

Packets/second: Number of packets transferred per second.

Split Transaction Performance
This portion of the Timing Calculator window gives minimum, maximum, and average 
values for all Split transactions during the timing period. For example, minimum 
throughput is throughput of the Split transaction that passes the least amount of data. 
Maximum throughput is throughput of the Split transaction that passes the most amount 
of data. Average throughput is the average calculated for all Split transactions during the 
timing period.

Response Time: The time it took to transmit this Split transaction on the PE link, from 
the beginning of the first packet in the Split transaction to the end of the last packet in the 
Split transaction.

Latency: The time measured from the end of the request transaction to the first 
completion transmitted in response to the request within this Split transaction.

Throughput: The transaction payload divided by response time, expressed in 
megabytes per second.

Memory Writes Performance
This portion of the Timing Calculator window gives minimum, maximum, and average 
values for all Memory Write transactions during the timing period. For example, minimum 
throughput is throughput of the Memory Write transaction that passes the least amount 
of data. Maximum throughput is throughput of the Memory Write transaction that passes 
the most amount of data. Average throughput is the average calculated for all Memory 
Write transactions during the timing period.

Response Time: The time it took to transmit this Memory Write on the PE link, from the 
beginning of the first packet in the Memory Write to the end of the last packet in the 
Memory Write.

Throughput: The Memory Write payload divided by response time, expressed in 
megabytes per second.
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11.18 PCIe SSD Base Address Mapping
In order for NVMe, PQI, AHCI, ATA, SOP and SCSI decoding to work correctly, the 
PETracer software needs to know the Memory Base Address of the device. In cases 
when Base Address assignment is recorded in the trace, the software will determine all 
the values automatically. If the Base Address assignment is not present in the trace, you 
can specify the values manually using this dialog. You need to select the type of the 
device (NVMe, PQI, AHCI, ATA, SOP or SCSI) and set the value of the Base Address by 
selecting Tools > PCIe SSD Base Address Mapping. The PCIe SSD Configuration dialog 
displays (see figure on next page).

From software release 6.63 onwards, users are able to decode NVMe/PQI traces which 
are lacking configuration space and administration information, from release 6.70 this is 
applicable to AHCI traces, from release 7.00 this is applicable to ATA traces and from 
release 7.10 this is applicable to SOP and SCSI traces. 
Follow the steps below to perform the applicable storage decoding:

Step 1 Record the trace for NVMe, PQI, AHCI, ATA, SOP or SCSI device boot 
and decode it. This saves the configuration space and administration 
information in .xml format, which is used to decode traces that do not 
include configuration and administration commands.

Step 2 Record the trace of the same NVMe/PQI, ATA SOP or SCSI device 
without rebooting and the application will decode it. 

You can keep recording and decoding until rebooting. On reboot repeat steps 1 and 2 
above.

NVMe PCIe SSD Device Configuration
The PCIe SSD Configuration dialog is used to add missing information to decode the 
trace without the configuration space and queue administration information. See figure 
on page 225 for NVMe PCIe SSD Device Configuration. 

Prior to decoding, if all the required information is available in Configuration Space then 
the Source field in the PCIe SSD Configuration will be set to "Config Space"  (see figure 
on next page). The description for important fields and buttons are given below:

1. DEVICE ID: Represents the device ID in the bus/device/function address from the 
PCIe specification (ID Based routing).

2. MBAR: The MBAR field in this dialog is required and editable. Make sure that the 
information entered is correct. Click on any field and the description displays in the 
bottom read-only box. The 64-bit main address bar (i.e. BAR1:BAR0). Without this 
value decoding cannot be done. It should be in "0x" hex format.

3. PROTOCOL: The NVME protocol.
4. ASQS: Defines the size of the Admin Submission Queue in entries. Refer to the 

controller registers section of the NVMe specification. The minimum size of the 
Admin Submission Queue is two entries. The maximum size of the Admin Submis-
sion Queue is 4096 entries. This is a 0’s based value.

5. ACQS: Defines the size of the Admin Completion Queue in entries. Refer to the 
controller registers section of the NVMe specification. The minimum size of the 
Admin Completion Queue is two entries. The maximum size of the Admin Comple-
tion Queue is 4096 entries. This is a 0’s based value. 
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6. DSTRD: This register indicates the stride between doorbell registers. The stride is 
specified in bytes. This may be used to separate doorbells by a number of bytes in 
memory space. It may be useful in software emulation of an NVM Express control-
ler. For hardware implementations of NVM Express, the expected doorbell stride 
value is 4.

7. LBASIZE: Size for Logical Block Addressing.
8. MPS: This field indicates the host memory page in bytes.
9. IOCQES: I/O Completion Queue Entry Size. This field defines the I/O Completion 

Queue entry size that is used for the selected I/O Command Set. The required and 
maximum values for this field are specified in the Identify Controller data structure 
for each I/O Command Set. The value is in bytes and is specified as a power of two 
(2^n).

10. IOSQES: I/O Submission Queue Entry Size. This field defines the I/O Submission 
Queue entry size that is used for the selected I/O Command Set. The required and 
maximum values for this field are specified in the Identify Controller data structure 
for each I/O Command Set. The value is in bytes and is specified as a power of two 
(2^n).

11. MQES: Maximum Queue Entries Supported. Defines the maximum individual queue 
size that the controller supports. This is a 0’s based value. The minimum value is 1h, 
indicating two entries.

12. Source: Source of the data.
13. Queues: Under this node the user can add more missing nodes to decode the cur-

rent trace. Click the Add Queue or Delete Queue button to add or delete a queue 
node. Type based on the user selection. 

14. Namespaces node: A container for Namespaces configuration. Number of sup-
ported namespaces by a controller is defined in Identify Controller Data Structure, 
Number of Namespaces.

15. Namespace section: This entity is defined in NVMe specification and is used in sev-
eral processes defined in the specification (e.g. data protection – DIF and DIX fields, 
command submissions, error detections). The section contains a set of fields 
described in the NVMe specification and the user should be familiar with it before 
modifying any values.

16. Import Config Info: Click to Import configuration information.
17. Export Config Info: Click to Export configuration information.
18. Add Device: Click to add device (NVMe/PQI only).
19. Add Queue: Click to add queue (NVMe/PQI only).
20. Delete Queue: Click to delete queue (NVMe/PQI only).
21. Add Namespace: Click to add a new namespace if this information is not present in 

a trace file (NVMe/PQI only). 
22. Delete Namespace: Click to delete namespace (NVMe/PQI only).
23. Add Port: Click to add port (AHCI only).
24. Delete Port: Click to delete port (AHCI only).
25. SCSI Command Set: Select a Command Set from the drop-down list.
26. Re-Decode: Click to re-decode.
27. Reset: Click to reset.
28. OK: Click to accept the settings.
29. Cancel: Click to cancel the settings.
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Click the  button to decode the trace and select Tools > PCIe SSD Base Address 
Mapping (see figure on next page).

Note:  When opening a trace file created with 7.0X or older versions of PETracer, 
these new fields are not present and the application tries to export the 
configuration information to XML before decoding NVMe transaction level. In 
this case a message box will show claiming that a value for this field is 
required. 

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

19

20

21

22

23

24

25

26

27

28

29



Chapter 11: Reports and Tools Summit User Manual

222 Teledyne LeCroy

Note:  In case of problems when opening older traces try the following: a) Decode 
NVMe transaction level before exporting XML file. This will apply the default 
value for the new fields and export can be performed. b) Manually enter the 
values for the new fields. c) In case the trace contains submission entries 
which are not decoded, add a new Queue and set the corresponding 
address in the PCIe SSD Configuration dialog.

AHCI PCIe SSD Device Configuration
The PCIe SSD Configuration dialog is used to add missing information to decode the 
trace without the configuration space and queue administration information. See Figure 
10.36 for AHCI PCIe SSD Device Configuration. 

Prior to decoding if every thing is available in Configuration Space then Source equals 
Config Space. 
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The MBAR field in this dialog is required and editable. Make sure that the information 
entered is correct. Click on any field and the description displays in the bottom read-only 
box (see figure on page 231). Some important fields are described below:

• Device: There is only one device node, (support for multiple device trace 
decoding will be available in a later release). If there is no device node, then 
the user can add a device node by clicking the Add Device button.

• MBAR: The 64-bit main address bar (i.e. BAR1:BAR0). Without this 
value decoding cannot be done. It should be in "0x" hex format.

• Ports: Under this node the user can add more missing nodes to decode the 
current trace. Click the Add Port or Delete Port button to add or delete a port 
node. Enter CLB, CLBU and FB, FBU address fields. The address is 32 bit 
and should be in "0x" hex format. Please use the right value for size as it is an 
important attribute. Consult the AHCI specifications for the correct value. 

Clicking the Re-Decode button erases the current configuration from this dialog box and 
attempts to re-decode based on the information present in the open trace and/or saved 
on the disk with the last decode.

Click the Import Config Info button to import the configuration information as an .xml file, 
instead of adding it individually. Click the hyper-link XML Schema File Path to access 
the required format to generate the .xml file. This schema provides the detailed format for 
the imported file. All modern languages are equipped to generate an .xml file on a specific 
xml schema. The driver software accepts this schema and generates the ,xml file with all 
the required information.

Click the Export Config Info button to export the configuration information as an .xml file.

Click the Reset button to reset the values to the original values. Press the OK button to 
save all the values.

PQI PCIe SSD Device Configuration
The PCIe SSD Configuration dialog is used to add missing information to decode the 
trace without the configuration space and queue administration information. See figure 
on next page for PQI PCIe SSD Device Configuration. 

Prior to decoding if every thing is available in Configuration Space then Source equals 
Config Space (see figure on next page).
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All the fields in this dialog are required and editable. Make sure that the information 

entered is correct. Click on any field and the description displays in the bottom read-only 

box (see figure on page 231). Some important fields are described below:

• Device: There is only one device node, (support for multiple device trace 
decod-ing will be available in a later release). If there is no device node, then 
the user can add a device node by clicking the Add Device button.

• MBAR: The 64-bit main address bar (i.e. BAR1:BAR0). Without this value 
decoding cannot be done. It should be in "0x" hex format.

• Queues: Under this node the user can add more missing nodes to decode the 
current trace. Click the Add Queue or Delete Queue button to add or delete a 
queue node. Type based on the user selection. The following Node types are 
known.
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The address is 64-bit and should be in "0x" hex format. Please use the right value for 
each size as it is an important attribute. Consult the NVMe specifications for the correct 
value. Clicking the Re-Decode button erases the current configuration from this dialog 
box and attempts to re-decode based on the information present in the open trace and/or 
saved on the disk with the last decode.

Click  button to decode the trace and select Tools > PCIe SSD Base Address 
Mapping (see figure on previous page).

The two figures figure below show the BAR information for PQI and AHCI. If this 
information is present in the trace then it is not editable, otherwise it can be edited. 
Decoding is done only when configuration space and administration information is 
available.

Note:  Only one device should be marked with the appropriate BAR, multiple BARs 
do not work.

SOP and SCSI PCIe SSD Device Configuration
The PCIe SSD Configuration dialog is used to add missing information to decode the 
trace without the configuration space and queue administration information. See figure 
on next page for SOP and SCSI PCIe SSD Device Configuration. T he base is the same 
as PQI Device Configuration but you can additionally choose the SCSI Command Set.

Prior to decoding if every thing is available in Configuration Space then Source equals 
Config Space (see figure on next page).
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See“Example of XML File Format for SSD Decodes” on page 227 for a template of the 
XML files.
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Example of XML File Format for SSD Decodes
<DEVICES XML_FORMAT_VERSION="1.0"> 

<DEVICE ENABLE="0x1" VENDORID="0" CLASSCODE="67586" 
GUID="{9C9654A1-B693-4F30-912F-125059814C42}" DEVICEID="000:00:0"> 

<BARS> 

<MBAR ID="0" VALUE="0xF0000000"/> 

<BAR ID="2" VALUE="0x00000000"/> 

<BAR ID="3" VALUE="0x00000000"/> 

<BAR ID="4" VALUE="0x00000000"/> 

<BAR ID="5" VALUE="0x00000000"/> 

</BARS> 

<PROTOCOL ASQS="64" DSTRD="4" ACQS="16" LBASIZE="512" 
PROTOCOL="NVME" MPS="4096" ADDEDBY="DECODING"/> 

<Queues> 

<Queue SIZE="10" QID="2" TYPE="IOSQ" ADDRESS="0x11B210300" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="3" TYPE="IOSQ" ADDRESS="0x11B210340" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="5" TYPE="IOSQ" ADDRESS="0x11B210380" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="7" TYPE="IOSQ" ADDRESS="0x11B2103C0" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="9" TYPE="IOSQ" ADDRESS="0x11B210400" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="11" TYPE="IOSQ" ADDRESS="0x11B210E80" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="14" TYPE="IOSQ" ADDRESS="0x11B210E40" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="16" TYPE="IOSQ" ADDRESS="0x11B210E00" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="6" TYPE="IOSQ" ADDRESS="0x11B233040" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="8" TYPE="IOSQ" ADDRESS="0x11B233080" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="10" TYPE="IOSQ" ADDRESS="0x11B233B40" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="12" TYPE="IOSQ" ADDRESS="0x11B233B00" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="13" TYPE="IOSQ" ADDRESS="0x11B233AC0" 
ADDEDBY="DECODING"/> 
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<Queue SIZE="10" QID="15" TYPE="IOSQ" ADDRESS="0x11B233A80" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="17" TYPE="IOSQ" ADDRESS="0x11B233A40" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="1" TYPE="IOSQ" ADDRESS="0x11B25F080" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="4" TYPE="IOSQ" ADDRESS="0x11B28B040" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="3" TYPE="IOCQ" ADDRESS="0x11B2200C0" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="5" TYPE="IOCQ" ADDRESS="0x11B2200E0" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="7" TYPE="IOCQ" ADDRESS="0x11B2200F0" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="9" TYPE="IOCQ" ADDRESS="0x11B220100" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="11" TYPE="IOCQ" ADDRESS="0x11B2203A0" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="14" TYPE="IOCQ" ADDRESS="0x11B220390" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="16" TYPE="IOCQ" ADDRESS="0x11B220380" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="6" TYPE="IOCQ" ADDRESS="0x11B243010" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="8" TYPE="IOCQ" ADDRESS="0x11B243020" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="10" TYPE="IOCQ" ADDRESS="0x11B2432D0" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="12" TYPE="IOCQ" ADDRESS="0x11B2432C0" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="13" TYPE="IOCQ" ADDRESS="0x11B2432B0" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="15" TYPE="IOCQ" ADDRESS="0x11B2432A0" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="16" TYPE="IOCQ" ADDRESS="0x11B243290" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="1" TYPE="IOCQ" ADDRESS="0x11B26F020" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="2" TYPE="IOCQ" ADDRESS="0x11B26F030" 
ADDEDBY="DECODING"/> 

<Queue SIZE="10" QID="4" TYPE="IOCQ" ADDRESS="0x11B29B010" 
ADDEDBY="DECODING"/> 
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</Queues> 

</DEVICE> 

</DEVICES> 

11.19 Running Verification Scripts
You can run verification scripts to check errors, link transactions, split transactions, 
metrics, ordered sets,replays, DLLPs, and TLPs.

To obtain the Verification Script dialog box, select Tools > Run verification scripts

or click the  icon. 

The available verification scripts are in the Verification script section.

To run a script, select it, then click the Run Scripts button .
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The results appear in the bottom window. You can expand or collapse this window. You 
find a view related to the CATC Trace and place this window under or to the right of it. 
You can Save the results.

Click the Settings button to display the Settings window. 

You can choose the editor, display settings, and saving settings.
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Chapter 12:  Updates and Licensing

12.1 Updating the Analyzer
BusEngine™ and/or Firmware updates are now automatic processes that run anytime a 
new version of the PETracer™ software is installed that is incompatible with the currently 
installed BusEngine or Firmware. The update process generates onscreen instructions.

If, however, you need to manually perform BusEngine or Firmware updates, follow these 
steps:

Step 1 Select Setup > Update Device … from the menu to display the 
Update Analyzer dialog box for PETracer Summit™ and 
Summit T2-16™. 

Step 2 Select the appropriate file locations for the Firmware and/or BusEngine, 
using Browse, if necessary. 

Step 3 Check the appropriate options (if in doubt, check all options).

Step 4 Click Update to initiate the updating of the Analyzer.
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12.2 License Keys
A License Key is necessary to enable software maintenance. If you attempt to record with 
the Analyzer without an installed License Key, a message appears to indicate that a 
License Key is necessary in order to record traffic.

A License Key must be obtained from Teledyne LeCroy for each Analyzer.

After you obtain the License Key, follow these steps to install it:

Step 1 Select Help > Update License… from the menu bar. to display the 
Update License dialog box.

Step 2 Enter the path and filename for the License Key or use the Browse 
button to navigate to the directory that contains the License Key. 

Step 3 Select the .lic file, and then click Update Device.

You can also update your licensing information by selecting 
Setup > All Connected Devices …, then clicking Update License.

12.3 License Information
You can view Licensing information for your Analyzer by selecting 
Help > Display License Information... from the menu bar. The License Information 
window displays data about the maintenance expiration and purchased features. 
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Appendix A:  Configuration Space 
Decoding

The decoded capability structures in the Configuration Space Viewer and Editor are 
based on programmed definitions in the PETracer software and on Configuration Space 
Decode Scripts.

Configuration Space Decode Scripts are tools to define capability structures and instruct 
the Configuration Space Viewer or Editor how to decode them. These scripts are in the 
\CfgSpaceScripts sub-directory below the \Scripts directory in the application directory.

You can write Configuration Space Decode Scripts using the CATC Scripting Language 
(CSL). See the Teledyne LeCroy Analyzers File Based Decoding Manual for reference.

PCI Express Configuration Space Decode Scripts have the file extension .pecfgdec.

A.1 Mandatory Definitions
Configuration Space Decode Scripts must set the following reserved variables.

• CapabilityName: Name of the capability structure
• CapabilityID: ID of the capability structure
• ExtAddSpace: Set to 1 if Extended Configuration Space. 

                       Otherwise, set to 0 for PCI.

A.2 Mandatory Module Functions
Modules are collections of functions and data dedicated to decoding a specific capability 
structure. Each module has one primary Configuration Space Decode Script file 
(extension .pecfgdec) and optionally has include files (.inc).

A module function is an entry-point into a decoding module. To help display a 
capability structure, the application calls a module function.

The Configuration Space Editor and Viewer support only the DecodeRegister( offset ) 
and GetSize( ) functions.

DecodeRegister( offset )
The application calls this function while decoding a specific DWORD offset of the 
specified CapabilityID. The offset is the decoding entry point, where the decoding path 
starts. 

The Configuration Space Editor calls this function to determine how to decode the 
assigned configuration space. The offset parameter is the DWORD to decode. 
An offset of 0 indicates bytes 00h-03h, an offset of 1 indicates bytes 04h-07h, and so on.

Note: The Configuration Space Editor can only decode one DWORD at a time.

GetSize()
This function returns the size of the capability structure specified by CapabilityID.
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A.3 Configuration Register Types
The following reserved variables are defined global constants.

• CFGREG_UNDEFINED
• CFGREG_HWINIT
• CFGREG_RO
• CFGREG_RW
• CFGREG_RW1C
• CFGREG_ROS
• CFGREG_RWS
• CFGREG_RW1CS
• CFGREG_RSVDP
• CFGREG_RSVDZ
Note: These reserved variables match the Configuration Register Types of Table 7-2 in 
Section 7.4 of the PCI Express Base Specification, Rev. 2.1.

A.4 Primitives
Decoding uses the following primitives.

GetRegisterField( dword_offset, bit_offset, field_length )
This function returns a register field of length field_length, starting at bit position 
bit_offset in DWORD dword_offset.

• dword_offset: DWORD offset of the register field location
• bit_offset: Bit offset of the register field location
• field_length: Length of the register field

For example, GetRegisterField( 1, 9, 2 ); means: Go to DWORD 1, bit offset 9, and 
returns 2 bits.
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AddField( field_name, field_length, configuration_reg_type, tooltip, 
encoding_table = NULL )
This function adds a register field to the Capability View and returns a pointer to the field, 
for adding subfields.

• field_name: Name of the register field to display in the Capability View
• field_length: Length of the register field
• configuration_reg_type: Configuration register type of the register field. 

Note: If subfields are defined, their configuration register types override this setting 
for their specified bits.

• tooltip: Tooltip displayed for the register field in the Capability View
• encoding_table: Optional. Displays encodings as lists for select values.
• For example, user input becomes a combo box for the field in the Field View.

As examples: 
AddField( "PCI Express Extended Capability ID", 16, CFGREG_RO, "" );
means: Add the field "PCI Express Extended Capability ID" with length 16 and cfg 
register type CFGREG_RO.

capability_reg = AddField( "Capability Register", 32, CFGREG_RW, "" );
means: Added the field "Capability Register" with length 32 and cfg register type 
CFGREG_RW and stored a pointer to this field in variable capability_reg, which can be 
used to add subfields to this field.

AddSubField( parent_field, subfield_name,  subfield_length, 
configuration_reg_type, tooltip, encoding_table = NULL );
This function adds a subfield to a register field in the Capability View. Subfields are 
modifiable and visible in the Field View and appear in the tooltips of register fields.

• parent_field: Pointer to a register field in the Capability View
• subfield_name: Name of the subfield, displayed in the Field View
• subfield_length: Length of the subfield
• configuration_reg_type: Configuration register type of the subfield field. 

Note: This overrides the configuration_reg_type of the parent field.
• tooltip: Tooltip displayed for the subfield in the Capability View
• encoding_table: Optional. Displays encodings as lists for select values.
• For example, user input becomes a combo box for the field in the Field View

.
For example, 
AddSubField( capability_reg, "Mode Supported", 4, CFGREG_RO, "Indicates the 
Function modes," ), ModeEncodings );
means: Add the subfield "Mode Supported" to the parent field "capability_reg" with length 
4, type CFGREG_RO, a tooltip in the Capability View, and a combo box displaying "mode 
encodings" for input in the Field View.

A.5 Helper File
ConfigSpaceCommon.inc include file contains useful functions for script decoding.
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Appendix B:  China Restriction of 
Hazardous Substances Table

The following tables are supplied in compliance with China's Restriction of Hazardous 
Substances (China RoHS) requirements: 
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How to Contact Teledyne LeCroy
Type of Service Contact

Call for technical support… US and Canada: 1 (800) 909-7112

Worldwide: 1 (408) 653-1260

Fax your questions… Worldwide: 1 (408) 727-6622

Write a letter… Teledyne LeCroy

Protocol Solutions Group
Customer Support
3385 Scott Blvd.
Santa Clara, CA 95054-3115

USA

Send e-mail… psgsupport@teledynelecroy.com

Visit Teledyne LeCroy’s 
web site…

teledynelecroy.com/
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Index

Symbols
.lic files 232
.opt files 122
.peraw file extension 171
.pex files 67, 69
.rec files 67
+ Packet # button 117
+ sign 165

Numerics
100 ohm series resistor 22
10b errors 164
10-bit code format 160
25-pin Data Output Connector 19, 20
5-volt pin 22

A
About 14, 17
AC Connector 18, 20
Actions Properties dialog box 147
Activity 63
Add Counter command 151
Adding an Attachment 94
address 237
Advanced Hiding Options 55
All Connected Devices command 232
All Markers Window 102
Analyzer

license 232
setting up 27, 30, 31
update 231

analyzer
testing 65

Analyzer Network Chat Bar command 72
Any Event 154
Any TLP event 153
application 25
Attaching Markers 94
Auto De-Skew command 160
Auto-Configure Lane Polarity 131

auto-sense-link feature 6, 8
Available Events area 136

 133
averaging 208

B
Bandwidth 218
Base Spec 1.0 Rev Compatibility Mode 131
Beep When Trigger Occurs 128
Binary code format 160
Bit Tracer mode 8
Bit Tracer Recording 126
Bitmask 152
BitTracer

color-coding 161
compressing data view 171
data capture mode 157
data display 160
Data Display toolbar. 160
decoding 167
de-skewing 160
enabling 157
Errors window 164
expanding data view 171
exporting 171
link configuration 169
logical links 171
markers 163
recording mode 157
report windows 161
saving 171
search 168
Symbol window 165
timing 162
Timing window 164
trigger 158
views 159
zooming 171

blue current-position indicator 196
BNC Connectors 18, 21
boot sequence 13, 16
boot-code 13, 16
booting 13, 16
Both directions 198
Breakout Board 22
Buffer Size 125, 126
Bus Utilization 179, 218

buttons 182
features 208
metrics 207
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pop-up menu 180
BusEngine update 231

C
calculating time between DWORDs 187
CATC Technical Support 237
CATC Trace 4
CATC Trace View 82
cells 74

resizing 73
states 134

Change Counter Value command 150
changing

markers 81
channeling input signals 24
Channels 146
Chat session 72
Chat window 72
circuits 23
Clear Marker command 81
Clocks radio button 90
Collapse Idle 188
Collapse Idle Plus. 188
Collapsible Idle Time 186
collapsing 73
Color Format Hiding tab 117
Color pop-up menu 118
colors 117
Combining Specified Event Groups 111
Combo box 202
Comma Separated Value files 70
Comment field 79
comment string 79
CompeterID field 201
components 11
Configuration Space 201
Configuration Space dialog box 201
Configuration Space Header 202
Configuration Space View 201, 202
configuring

Recording Options 65
conflicts 138
Connect/Disconnect button 66
connecting 35, 38, 40

interposer data cable 43, 45
contact 237
Continue option 66
Continuous Time Scale 188
Control-b command 109
Control-f command 109
controls

Analyzer EML 12, 15
Count action 137
Count field 151
Counter 146
Counters 150
counters

setting 151
counting 150
CSV files 70
current-position indicator 196
custom circuits 23

D
Data Block window 74
data cells 73
Data Field 73
Data Flow command 190
Data Flow window 190
Data In/Out connector 22, 23
Data Output Connector 19, 20
Data Throughput 203, 204, 218
data.pex file 66, 67
decode levels 86
decoding 86
Decoding window 167
Default Gateway 14, 17
default options file 131
default.opt file 122
default.rec file 131
delimiters 196
descrambled format 160
Description String 146
descriptive label 131
Detail View and Spreadsheet View 85
DeviceID field 201
Direction field 111
Disable Descrambling 131
disparity errors 164
Display area 50
Display Configuration Name 116
Display License Information command 232
Display Options 115

command 115
dialog box 115
fFiles 67
loading 122
saving 122

Display Options button 115
DLLP Packet Properties dialog 149
Do not save hidden packets option 69
Down Arrow button 12, 15
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Downstream 130
DOWNSTREAM 1 connector 12, 15
DOWNSTREAM 2 connector 12, 15
Downstream direction 198
Downstream Symbol 125, 127
Drag an event here to create a new sequence 134
drive strength 24
DWORD 152
DWORDs

timing 187

E
Edit Comment command 71
Edit Marker 101
Edit Marker command 81
e-mail 237
Email CATC Support 237
Enable Tool tips 116
Error Properties dialog box 147
Error Summary dialog box 175
error types 147
errors

10b 164
disparity 164

Errors pane 195
Errors window 164
Escape key 66
Ethernet LAN port 8
Ethernet Port 18, 20
event

counting 150
Event Groups menu 111
Event Icon Preview 146
Event Navigation 179
Event Properties dialog box 146
Event Trigger recording type 126
events

searching 89
Events report window 165
Event-specific Settings 147
Exclude option 111
Expand Data command 73
Export command

BitTracer 171
Export to Compressed Archive command 171
exporting 70
Ext. In Connector 21
Ext. Out connector 21
External Interface Breakout Board 22
external signals 24

F
fax number 237
field

hiding 120
Field Colors tab 117
Field Formats tab 119
file formats 70
File Information window 174
File Menu 56
filter 155
Filter action 137
Filter In button 155
Filter Out button 155
Find command 109
Find dialog box 110
Find Next command 114
finding 110
Firmware update 231
First, Prev, Next, and Last buttons 202
Fit to Graph Area 180, 213
Flush option 66
Fonts 116
format

field 119
From packet # field 71
From Packet field 69
front panel 12, 15
Functionality of Markers 92
fuse 18, 20

G
Gen2 PCI Express 16-lane advanced verification 
system 3
Gen2 Summit 8
General tab 65, 115, 123
Generator file format 70
Global State 134
Global State Cell 136
Go To Marker command 90
Go to Marker command 187
Go To menu 109
Go to Packet # 180
Go to Packet command 89, 90
Go to Trigger command 89
Grid Lines 179
ground pins 22
Group and Colors column 118, 119
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H
hardware 3
header fields 75
Help Menu 61
Hexadecimal vs. Binary tabs 202
Hide 180, 213
Hide buttons 54, 187
Hide Downstream button 54
Hide SKIP and Update FC button 54
Hide Training button 54
Hide Upstream button 54
hiding 120

Idles 187
Hiding tab 120
Hierarchy Lines 116
host machine 11

I
Icon Label 146
Idle errors 147
Idle status 13, 16
information

priority 197
InitFC complete status 215
input signals 24
Install Software command 25
interface 25
internal rules 138
Interposer 42, 44
interposer

installing 43, 45
interposer data cable

connecting 43, 45
Intersection option 111
IP Address 14, 17
IP Mode 14, 17

K
K/D symbol format 160
Key

License 232
keyboard shortcuts 62
keystrokes 62

L
label 131
LAN port 8
lane swizzling 6, 8

Latency 218
Latency Time 204
Latency Time at Split Transaction level 207
layout 50
LCD Menus 12, 15
LeCroy PETracer command 25
LEDs

Analyzer EML 12, 15
Legend option 196
level hiding 120
Level Hiding tab 120
levels 86
LFSR value 160
license files 232
License Information window 232
License Key 232
licensing information 232
Linear 180, 213
Link Configuration dialog 169
Link level decode 86
Link section 65, 129
Link Settings 125
Link State 215
Link Tracker

buttons 188
toolbar 184

Link Tracker window 184
docking 186
markers 187
reformat 185

link training 66
Link Transaction

metrics 206
Link Transaction Level graphs 209
Link Transaction Performance 206
Link Utilization 218
Link Width 130
Link Width pane 195
Load button 122, 131
Load command 122, 131
loading 122, 131
Logarithmic 180, 213
logic analyzers 22
logical links

BitTracer 171
Logical view 167
long format 73
LTSSM Flow Graph 198
LTSSM Flow Graph command 198
LV TTL output and input signals 22
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M
Main Display Area 184
Main display area 133
Manual Trigger

recording type 126
Manual Trigger button 12, 15
Markers 91

Adding an Attachment 94
Attachment Types and Visualization 96
Embedded Attachments to a Marker 96
Recording an Audio File 95
Video Files supported 95

markers 79
BitTracer 163
deleting 81
editing 81
setting 79, 187
user-defined 163

Markers Overview 91
Markers window 163
Mask (hex) entry 153
Match (hex) entry 153
Memory Write event 154
Memory Writes 206
Memory Writes Performance 218
Menu bar 50
menus 56

pop-up 74
metrics 203

Bus Utilization 207
Link Transaction 206
Link Transactions 203
Split Transaction 205
Split Transactions 203
trace 204
Traffic Summary 205
unit-base averaging 208

Metrics Header 204
Metrics Tooltip 204
Microsoft® Windows®-based host machine 25
Misc 125, 128
Msb -> Lsb checkboxes 119

N
navigating 192
Navigator 192

displaying 192
legend 196
panes 193, 195

range 193, 194
ranges 193
slider 196
toolbar 193

Navigator Legend dialog box 196
Navigator Panes button 196
Navigator Range button 194
Network Browse list 72
New Event button 136
New Events button 146
Number of data packets 215
Number of Link Transactions 203
Number of Packets 203

O
Offset dword 152
opening

program 26
options files 131
Options Name 125, 128
Options Name box 131
Ordered Set Properties dialog box 150
Origin field 111
overview 3

P
Packet # 117
Packet Data command 200
Packet Data window 200
Packet Directionality Cell 78
Packet errors 147
Packet Header bar 199
Packet Header Cell 78
Packet Header command 199
Packet Heading Cell 77
Packet level decode 86
Packets report window 166
Packets/second 218
pane checkbox 196
Pattern Format section 168
Payload 203
payload pattern match 152
Payload Properties dialog box 149
Payload size 215
Payload tab 152
PCI Express 16-lane advanced verification system 
3
PCI Express Spec 2.0 8
PCI Express Spec 2.1 6
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PCI status 13, 16
Pending Requests at Split Transaction level 207
PETracer

setting up 27, 30, 31
PETracer EML

opening 26
PETracer Gen2 Summit 8
PETracer ML

opening 26
PETracer SN message 63
PETracer Summit 11, 16

components 35, 38, 40
PHY layer problems 6, 8
Pin Button 146
pin-outs 23
pins 24
Platform Status menu 13, 16
Playback Window 107
Playlist Functionality 105
Playlist Playback Control 107, 108
plus symbol 118, 119
polarity checkbox 169
pop-up menus 74
power on/off switch 18, 20
power socket 18, 20
Power Switch 12, 15
powering on 43, 45
Pre/Post Trigger pane 195
Preserve TC to VC mapping across the channels 
128
Print command 71
Printer button 71
printing 71
Probe Data Cable 42
product

overview 3
program

opening 26
Properties 181, 213
Properties button 146
Properties command 136
Properties dialog 146
Properties dialog box 136, 145
protocol unit 203
prototype rework area 23

R
range delimiters 196
Raw 10b Codes 75
raw-recording mode 6

Read Requests Performance 205
reading 73
Ready message 63
Real-Time Statistical Monitor window 213
Real-Time Statistics

buttons 211
pop-up menu 213
toolbar 211

Real-Time Statistics window 210
Real-time Statistics window 214
rear panel 18, 20
Reboot 14, 17
Reboot command 13, 16
Recently Used Ranges 194
Record button 66
Record LED 12, 15
Record Menu 57
recorded activity 64
recording 65, 123

stopping 66
Recording button 137
Recording Options

command 123
configuring 65
dialog box 123
files 67
loading 131
saving 131
settings 131

Recording Options command 65
recording progress 63
Recording Progress Bar 63
Recording Rules

buttons 135
examples 138
logic 138
toolbar 135

Recording Rules tab 133
recording status 63
Recording Type 124, 126
REF CLK IN 12
Remove 180
Report Menu 58
Report menu 173
reports 173
Reset Column Widths 186
resizing 73
Response Time 203, 218
Response Time and Latency Time at Split 
Transaction level 207
Response Time at Link Transaction level 207
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Response Time at Split Transaction level 207
Right click cell context menu 116
Root menu 13, 16
Row Selection 179
RS-232 25-pin Data Output Connector 19, 20
rules

internal 138
Run verification scripts command 229
Running Disparity 160

S
Save As command 69
Save As Default 122, 131
Save As Default. 132
Save button 122
Save External Interface Signals 128
Save packet range command 69
saving 69, 122, 131

BitTracer 171
scrambled format 160
Search 63

command 89
Search Bwd message 109
search direction 64
Search Direction command 109
Search For menu 110
Search Fwd message 109
Search Menu 59
Search On section 168
Search Order section 168
Search Pattern window 168
Search window

BitTracer 168
searching 89
Seconds radio button 90
Select button 12, 15
Send command 72
Sequence Cell 136
Sequence State 134
servicemarks ii
Set Display Options command 117
Set Marker command 79, 187
Set Marker with Text command 163
Set Range Near Packet xxx 194
Set Range to Whole Trace 194
setting markers 79
Settings button 230
Settings window 230
Setup Menu 57
short format 73

shortcuts 62
Show Configuration Space for xxxx 202
Show Header Fields command 76
Show Header Fields dialog box 75
Show Number of Transitions checkbox 198
Show Packet in Raw Trace 171
Show Raw 10b Codes command 75
Shutdown 14, 17
signal descriptions 23
Slot Interposer 42, 44
small triangle 73
Snapshot recording type 126
software 49

installation 25
update 231

SOP and SCSI PCIe SSD Device Configuration 
225
Specification view 167
Specify Action command 137
Split level decode 87
Split Transaction

metrics 205
Split Transaction Level graphs 208
Split Transaction Performance 205, 218
Spreadsheet View 82
StandardSettings.rec file 128
Start menu 25
Statistics Accumulation area 214
Status Bar 63
Status bar 50
Status LED 12, 15
Stop button 66
Stop option 66
Subnet Mask 14, 17
Summit 3, 8, 16
Summit Setup menu 13, 14, 16, 17
Summit T2-16 3, 6, 11, 13
Summit T2-16 front panel 12
summit.sys driver 25
support 237
Swap Recording Channels 131
Symbol window 165
Sync In Connector 18, 21
Sync Out Connector 18, 21
Synchronize Trace View 188
system components 11

T
Target Analyzer 125, 127
Technical Support 237
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telephone number 237
testing 65
text files 70
Throughput 218
Throughput at Link Transaction level 207
Throughput Per Transaction at Split Transaction 
level 207
Tight Columns 179
time between DWORDs 187
Time Coverage 218
Time Stamp 116
time value 187
time-based averaging 208
Timestamp at the beginning 116
Timing and Bus Usage Calculator 217
Timing Calculations command 217
Timing Calculator dialog box 217
Timing measurement

BitTracer 162
Timing window 164
Title bar 50
TLP Header Properties dialog box 148
TLP Prefix Properties dialog box 148
TLP type 152
To packet # field 71
To Packet field 69
Tool tip Display 186
Toolbar 50, 133

 50
Tools Menu 61
Tools menu 173
Tooltips 62
trace

cells 74
exporting 70
files 67
metrics 204
saving 69

Trace Filename & Path 125
Trace Filename and Path 128
Trace Viewer 26
traces

searching 89
trademarks ii
traffic 73

analyzing 173
Traffic Speed pane 195
Traffic Summary

buttons 178
metrics 205

Traffic Summary window 177

moving to packets 178
Traffic Type pane 195
triangle 73
Trigger action 137
Trigger LED 12, 15
Trigger marker 163
Trigger On section 127
Trigger Position 125, 127
triggers

count 150
TTL output and input signals 22

U
Undo Zoom 180, 213
Union option 111
unit 203
unit-based averaging 208
Up Arrow button 12, 15
Update Analyzer dialog 231
Update command 231
Update Device command 231, 232
Update License command 232
Update License dialog box 232
updates 231
Upload Size 125
Uploading 63
Uploading data message 63
Upstream 130
UPSTREAM 1 connector 12, 15
UPSTREAM 2 connector 12, 15
Upstream direction 198
Upstream Symbol 125, 127
USB drivers 25
USB Type B Host Computer Connector 18, 20
Use External Reference Clock 130
user-defined markers 163

V
Verification Script dialog box 229
VHDCI 21
View Data Block command 74, 75
View Menu 60
View Options 188
View Options button 186
View Settings 182
Viewer 26
Viewing Attachments of a Marker 97
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W
web site 237
Website, CATC 237
Window Menu 61
Wrap 116
Write Requests Performance 206
Writes Response Time 209
Writes Throughput 209

X
X marker 163
x16 Slot Interposer 42, 44

Y
Y marker 163
Y Scale Type 180, 213
yellow range delimiters 196

Z
zoom 185
Zoom Level 116
Zoom to Trace View 180
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